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Chapter

6

Working with Layouts
 
  

Your design is only as good as your ability to communicate it to others. Your drawings can contain a lot
of different information, and you need to be able to output a variety of aspects of the design.

 
Layouts and viewports help you to structure and focus your design and its supporting information for
the final step of communicating it to others through both paper and electronic media.

 
You also need to understand how Layouts and Viewports work before you can add annotations, such
as dimensions and text, to your drawings.

 
Objectives

  
After completing this chapter, you will be able to:

■ Identify the environments in which you can plot data and create a new layout.
■ Create and manipulate viewports.
■ In this exercise, you use what you learned about working with layouts to create and configure a

layout with three viewports.
 

Standard Object Snap and Status Bar Settings
 Before completing the exercises in this chapter, refer to the "Settings for the

Exercises" section in the Introduction in Volume 1.
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Lesson: Using Layouts
 

  
In this lesson, you learn how to create a layout, which is the environment you use to prepare your
drawing for plotting. You also learn how to switch between layouts and layout viewports.  
Plotting is a vital step in the process of communicating your design and the use of layouts is an
important part of preparing for plotting.   
The following illustration shows geometry that resides in model space and a plot preview from a
corresponding layout.

  

 
Objectives

  
After completing this lesson, you will be able to:

■ Describe the purpose and key properties of layouts.
■ Create a new layout.
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About Layouts
   

A layout is an environment used to output your drawing data. That data can include model space
geometry and geometry added to the layout to enhance a specific plotted sheet.   
The following image shows an empty layout in a drawing. You can see the paper size, the printable
area within the dashed lines, and the rectangular viewport for the selected layout.

  

 
Defining the Layout

  
In a layout, you select what paper size you want to plot on. That paper size is then displayed at a visual
full scale with a dashed rectangle indicating the area the selected plotter can plot within for that size
paper. You also select paper orientation.

 
With the paper in the layout displaying at full scale, you insert your border and title block on the sheet
at full scale. You can also create textual notes at full scale on the paper.

 
You display model space geometry on the paper in the layout by creating viewports. You can define
multiple viewports and set their scale and location.  
The following are some of the properties and settings that you can save in a layout:

 
■ Printer/plotter
■ Paper size
■ Plot area
■ Plot offset
■ Plot style table
■ Drawing orientation
■ Plot scale
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Example of Layouts

  
One advantage of using layouts is being able to plot using multiple scale factors on the same drawing
sheet. For example, you can display an overall view of a floor plan at one scale, and right next to it two
detail views, each at their own scales.

 
The following illustration shows a completed layout that includes the floor plan at a common scale; an
elevation at a smaller scale; and a detail of the stairwell blown up at a larger scale. 

 
 

 

Creating a New Layout
   

You can add layouts to the current drawing based on a layout in a template file, by copying an existing
layout in the drawing, or by adding a new one. To add a new layout, you use the Layout, New Layout,
or Create Layout Wizard commands. 
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Command Access
    

 

  
LAYOUT
   

 
    Command Line: Layout > New
    Status Bar: click to view Layout; right-click to Display Layout and Model Tabs

   

      Layout tab or Model tab shortcut menu: right-click to display options
   

  Note: Available only once Layout and Model tabs are displayed.     Menu Bar: Insert > Layout > New Layout
   
 

Procedure: Creating a New Layout
   

The following steps give an overview of creating a new layout in the drawing.
  

1.
  Right-click the Model tab or any layout tab.

 
2.

  Click New Layout.
 
3.

  Click the layout tab for the newly created layout.
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Procedure: Creating a New Layout with the Layout Wizard
   

The following steps give an overview of creating a new layout in the drawing using the Create Layout
Wizard.

  
1.

  On the command line, type LAYOUTWIZARD.
 
2.

  Step through the wizard screen to:
■ Name the layout
■ Select a configured plotter
■ Select a paper size and its units of measurement
■ Select a paper orientation
■ Pick a standard title block if desired
■ Define the number of viewports and their scales
■ Set the location for the viewports on the paper

 
3.

  Click Finish.
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Practice Exercise: Create a New Layout  
In this practice exercise, you create a new layout from
the Layout tab and from the Layout Wizard.   
1.

  To create a new layout from the Layout or
Model tab:
■ Right-click on the Layout or Model tab.
■ Click New Layout.
   

  Note: If the tabs are not visible, right-click
the Layout button on the status bar and click
Display Layout and Model Tabs.
   

 
■ Select the new Layout tab.
■ The settings are based on the prior layout

settings.

 
2.

  To create a new layout using the Layout
Wizard:
■ On the command line, type

LAYOUTWIZARD
■ Enter a name for the new layout. Enter

Floor Plan and click Next.
■ For the Printer, select DWG to PDF.pc3 and

click Next.
■ For the Paper Size, select ARCH D (36.00 x

24.00 Inches), Drawing units Inches, and
click Next.

■ Select a Landscape orientation and click
Next.

■ Select the Architectural Title Block.dwg and
click Next.

■ Select a Single Viewport setup with a
Viewport scale of 1/8" = 1'-0" and click
Next.

■ To set a location on the layout page for the
viewport, click Select location < and specify
a viewport window clicking points (1) and
(2) as indicated below.

   

 
■ Click Finish.
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Exercise: Create Layouts
   
In this exercise, you activate different layouts and
then create two additional layouts.  

  
The completed exercise

Completing the Exercise
To complete the exercise, follow the
steps in this book or in the onscreen
exercise. In the onscreen list of
chapters and exercises, click Chapter 6:
Working with Layouts. Click Exercise:
Create Layouts.

   
1.

  Open M_Create-Layouts.dwg.
   

 
 
2.

  To activate a layout:
■ Click the Layout1 tab.
■ Review the layout format and the

information displayed.
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Note: If the Layout tabs are not visible, right-
click on the Layout button in the status bar and
select Display Layout and Model Tabs.
   

 
 
3.

  To activate another layout, click the Layout2
tab. Notice the differences in the model space
geometry being displayed and the page size
and orientation.
   

 
 
4.

  To create a new layout:
■ Right-click the Layout tab.
■ Click New Layout.

 
5.

  To review the newly created layout, click the
new Layout3 tab. It includes a single viewport and the page
configuration is based on the default Option
settings in your installation of the software.
You may or may not see any of your model
space objects.

 
6.

  To insert a new layout, from the Menu Bar
click Insert > Layout > Create Layout Wizard. If
the Menu Bar is not visible, turn it on or enter
LAYOUTWIZARD on the command line.

 
7.

  To specify a layout name:
■ Enter Wizard Layout when prompted for

the layout name.
■ Click Next.
   

 
 
8.

  To choose a printer for the layout:
■ Select DWF6 ePlot.pc3 from the list of

available printers.
■ Click Next.
   

 
 
9.

  To set the paper size:
■ Select ISO A1 (841.00 x 594.00 MM) from

the list of available paper sizes.
■ Click Next.
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10. Click Next to keep the paper orientation as
Landscape.

 
11.

  To not include a title block:
■ Select None from the list of title blocks.
■ Click Next.
   

 
 
12.

  To specify a viewport scale:
■ On the Define Viewports page, under

Viewport Setup, verify that Single is
selected.

■ Under Viewport Scale, select 1:50 from the
list.

■ Click Next.
   

 

 
13.

  To set a location for the layout:
■ Click Select Location.
■ Click in the upper-left corner of the paper.
■ Click the bottom of the page just past the

halfway point as shown.
■ Click Finish.
   

 
 
14.

  Close all files without saving.
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Lesson: Using Viewports
 

  
This lesson describes how to create a new rectangular viewport, set the viewport scale factor, and
manipulate viewports.  
Viewports are a key component in the ability to plot model space geometry from a layout. Each
viewport acts as a display portal from the paper layout to the geometry in model space. By creating
multiple viewports in a single layout, you can display different aspects of the model geometry at
different scales on the same page.  

 
Objectives

  
After completing this lesson, you will be able to:

■ Create a rectangular viewport.
■ Modify the viewport scale factor.
■ Move, copy, resize, rotate, and delete viewports.
■ Rotate the view within a viewport.
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Creating Rectangular Viewports
   

You create a rectangular viewport similar to the way you create a rectangle. However, a rectangular
viewport created in a Layout is a kind of window that displays the geometry from the model space
view into the current layout page.

 
You scale the view of the geometry displayed in each viewport and typically plot the overall layout 1:1.
You can have more than one viewport on a single layout page showing different views of your drawing
at different scales.

 
Typically the viewport is not plotted. You can create the viewport on a unique layer so that you can
use the layer properties to prevent the viewport boundary from plotting.  
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Command Access
     

 

  
Single Viewport
   

 
    Command Line: VPORTS
    Ribbon: View tab > Viewports panel > New > Viewports dialog box > Single

   

  Viewports dialog box:
   

 
    Menu Bar: View > Viewports > 1 Viewport
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Procedure: Creating Rectangular Viewports
   

The following steps give an overview of creating rectangular viewports. Though making a rectangular
viewport is relatively simple, it is important to understand the overall setup.

  
1.

  If the layout tabs are not available, right-click the Layout button in the status bar and select Display
Layout and Model Tabs.
   

 
 
2.

  Activate the appropriate layout tab.
   

 
 
3.

  Confirm the paper size for the layout.
■ Right-click the layout tab and select the Page Setup Manager.
   

 
■ Confirm that the Plot Size paper is correct (1).
■ To change the paper size, select Modify (2).
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4.

  Insert a title block if one is not already inserted.
 
5.

  Activate the viewports command.
■ On the Viewports panel, click New (1).
■ In the Viewports dialog box, on the New Viewports tab, under Standard Viewports, click Single (2).
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6.

  Create the viewport.
■ Specify the first corner (1).
■ Specify the opposite corner (2).
   

 
 
7.

  Place the viewport on a layer that you will choose not to print.
■ With the command line blank, select the viewport.
■ From the Layer Control list, select the layer.
■ Press ESC to deselect the viewport.
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Guidelines for Creating Viewports
■ You should always create viewports on their own layer.
■ The viewports layer should be set to non-plotting.
■ There is no practical limit to the number of viewports on a single drawing sheet.
■ Each viewport can have its own plot scale factor.

 

Setting Viewport Scale Factor
   

Once you have created a layout viewport, you can set the display of the geometry within it to a specific
scale compared to the paper units. This ensures that when you plot the layout at a scale of 1:1, the
geometry in the viewport is at the desired scale on the paper.   
In the following illustration, if 1:30 is selected, the geometry in model space will appear 30 times
smaller on the paper. So if 1 unit on the paper is a millimeter, and the units in model space are
millimeters, then a line 30 millimeters long in model space will be 1 millimeter long on paper. If the
paper were in inches and 1 unit in model space represented a foot, then a line representing 30 feet in
model space would be 1 inch long on the paper.
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Viewport Scale Access
    

 

  
Viewport Scale
   

 
    Status Bar: Viewport Scale     

      

 

  Layout tab must be selected.

   

 

  The model or paper space button may be set to either mode:
■ Model space on: Viewport can be active (bold).
■ Paper space on: Viewport can be selected.

   

 

  Viewport scale is accessible.

   
 

Procedure: Setting and Locking Viewport Scale
   

The following steps give an overview of setting a viewport scale and then locking the viewport so that
it cannot be changed.

  
1.

  From the layout tab, select your viewport border.
   

 



Lesson: Using Viewports       ■       19

 
2.

  On the status bar, click the viewport scale list and select the scale to apply to the viewport.
   

 
 
3.

  Double-click inside your viewport to activate model space and use pan to position your objects in the
viewport.
   

 
 
4.

  Double-click outside the viewport to activate paper space. Select the viewport border again. On the
status bar, click Lock/Unlock Viewport. Now the viewport is locked at the scale you set.
   

 



20          ■         Chapter 6: Working with Layouts

 
5.

  With your viewport selected, the status line displays its current locked condition and scale.
   

 
  
 

Guidelines for Setting the Viewport Scale
■ To set the scale for a layout viewport, select the viewport boundary. On the status bar, select the

Viewport Scale list and pick the desired scale.
■ It is a good habit to lock the viewport once the scale is set. Select the viewport boundary and then

on the status bar, click Lock/Unlock Viewport.
■ You must unlock the viewport before changing the scale. However, you may still pan the model

data within the viewport.
■ The viewport can be selected in Paper space mode or activated in Model space mode to set the

Viewport Scale or Lock/Unlock the Viewport.
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Practice Exercise: Setting Viewport Scale Factor  
In this practice exercise, you draw some objects in
model space, then create a rectangular viewport in a
selected layout tab. From the layout, you Zoom the
viewport in both the model space and paper space
modes. Finally, you set the viewport to a specified
scale..   
1.

  Draw some geometry as shown below:
■ Begin a new blank drawing based on

acad.dwt.
■ Create the objects in the drawing window

without zooming the drawing area.
■
 

 
2.

  Select the layout tab. Notice that it already has a single viewport on
it. You are going to erase this and create your
own viewport.
   

 
 
3.

  To practice making a single viewport, first
delete the one that is already there.
■ With the Command line blank, click the

viewport.
■ On the Modify panel, click Erase.
   

 
 
4.

  To create a single viewport:
■ At the Command line, enter -vports and

press ENTER.
■ Specify the corner of the viewport (1).
■ Specify the opposite corner (2).
   

 
 
5.

  To zoom the geometry inside the viewport:
   

 
■ Double-click inside the viewport.
■ Notice that the viewport rectangle is bold,

indicating it is active.
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■ Use Zoom and Pan in real time to view your

drawing in the viewport.
  

6.
  To zoom the entire drawing layout:
■ Double-click outside the viewport.
■ Notice that the rectangular boundary is no

longer bold.
■ Use the Zoom and Pan real-time

commands to view your paper layout.
   

 
■ Zoom to view your entire drawing in the

Layout.

 
7.

  To set the viewport scale:
■ Select the viewport.
■ On the status bar, click Viewport Scale.
   

 
■ In the list, select 1:2
■ Press ESC to deselect the viewport.
   

 
 
8.

  To change the Viewport Scale and lock the
viewport:
■ Select the viewport.
■ On the status bar, click Viewport Scale.
■ In the list, select 1:4.
■ On the status bar, click Lock/Unlock

Viewport.
   

 
■ The icon should appear locked.
■ Press ESC to deselect the viewport and

view the results.
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Manipulating Viewports
   

You can manipulate viewports in many ways. If you no longer want the viewport and the data it
displays, you can use the Erase command to delete it. Since it only displays geometry from model
space, deleting the viewport does not delete the model space geometry. You can use the Move
command to change a viewport's position on the paper. You can also use the Copy command to
duplicate the viewport and its display settings to another location on the layout. To resize a viewport,
use the grips at its corners.

 
Another way of manipulating a viewport is to freeze the display of model space layers. By controlling
the display of model space layers per viewport in this way, you can display the same area of model
space in different ways in each viewport. To freeze or thaw the layer in the current viewport (1), the
layout viewport must be active. To make a layout viewport active, you double-click inside the viewport
boundary. You know when a viewport is active because the boundary is highlighted, as shown in
the following illustration (2), and the crosshairs change to an arrow cursor when you pass over the
viewport boundary. 

 
 

 
You can override layer properties in each viewport to have them appear differently in a viewport than
they do in model space. For example, you may want your layout to display the walls in a different
color than they are displayed in the model. Property overrides are accessed from the Layer Properties
Manager when opened with a layout tab current.  
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Erasing Viewports

  
If after creating a viewport you no longer want the viewport and the data it displays, you can use the
Erase command to delete it. Since it only displays a view of the geometry from model space, deleting
the viewport does not delete the geometry. You can erase, move, or copy a viewport, and you can
alter the way layers are displayed in a viewport, all without losing or changing the work you have done
to the original model.

 
Moving, Copying, and Resizing Viewports

  
You can use the Move command to change a viewport's position on the paper. You can also use the
Copy command to duplicate the viewport and its display settings to another location on the layout. To
resize a viewport, use the grips at its corners.

 
Altering Layers in Viewports

  
You can freeze the display of a layer in a selected viewport. By controlling the display of model space
layers per viewport, you can display the same area of model space in different ways in each viewport.
Use the freeze or thaw in current viewport option in the Layer Control list or the VP Freeze option of
a selected layer in the Layer Property Manager. You must do this when the layout viewport is active.
To make a layout viewport active, you double-click inside the viewport boundary. You know when a
viewport is active because the boundary is highlighted, as shown in the following illustration, and the
crosshairs change to an arrow cursor when you pass over the viewport boundary. 

 
 

 
You can also override layer properties to have them appear differently in a viewport than they do
in model space or other viewports. For example, you may want to display your walls at a different
color in a layout than they are displayed in the model. Property overrides are accessed from the Layer
Properties Manager when opened with a layout tab current. The four properties you can control are:
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■ VP Color
■ VP Linetype
■ VP Lineweight
■ VP Plot Style 

 

Procedure: Moving and Resizing a Viewport
   

The following steps give an overview of moving and resizing a viewport.
  

1.
  Start the Move command and pick your viewport border. Press ENTER to complete the selection
process.
   

 
 
2.

  Pick a base point and then drag the viewport to a new position and pick your second point.
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3.

  Select your viewport border. Click a corner grip to make it hot, then click and drag to increase or
decrease the size of the viewport.
   

 
  
 

Guidelines for Manipulating Viewports
■ Use grips to adjust the size of the viewport in a drawing layout.
■ Copy a viewport to display the same objects then adjust the layer settings.
■ Double-click inside a viewport to make it active.
■ Only one viewport can be active at a time.
■ Double-click outside the viewports to make the paper space layout active.
■ To make multiple copies of viewports you can also use the Array command.
■ Viewports can be rectangular or polygonal in shape.
■ You can Clip a viewport with a polygonal shape.
■ You can create a closed polyline or circle in a layout view and convert that object to a viewport.
■ In AutoCAD LT®, you can create only rectangular viewports.
■ Viewports created in the Model tab will display additional viewports of the drawing in the same

workspace. Each viewport can display a different view of the drawing. You can switch between the
viewports as you draw by clicking in the viewport first to make it active.
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Practice Exercise: Manipulating Viewports  
In this practice exercise, you create a simple drawing
with geometry on several layers to practice freezing a
layer in a selected viewport. 
 
 

   
1.

  To create the practice drawing:
■ Begin a new drawing.
■ In the Layer Properties Manager, add the

following layers with the following layer
properties:

❏ Layer name: Center
Color: Red
Linetype: Center

❏ Layer name: HiddenColor:
BlueLinetype: Hidden

❏ Layer name: ViewportsColor:
CyanLinetype: Continuous

■ Create a drawing similar to the one above,
drawing the center line on the Center layer
and the hidden lines on the Hidden layer.

 
2.

  Select the Layout1 tab.
   

 
 
3.

  To adjust the viewport size:
■ With the command line blank, select the

viewport.
■ Use the grips to adjust the size of the

viewport as shown below.
   

 
 
4.

  To adjust the view inside the viewport:
■ Double-click inside the viewport.
■ On the status bar, click the Viewport Scale

list and select a scale of 1:2 (you may
have to select a different scale to get your
drawing to fit in the viewport).

   

 
 
5.

  To move the viewport:
■ Double-click outside the viewport.
■ Begin the Move command.
■ Select the viewport boundary and press

ENTER.
■ Specify a basepoint and a second point to

move the viewport to the center left as
indicated below.
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6.

  To copy the viewport:
■ Begin the Copy command.
■ Select the viewport and press ENTER.
■ Make a single copy of the viewport to the

right, as indicated below.
■ Press ENTER to complete the copy

command.
   

 

 
7.

  To freeze layers in a selected viewport:
■ Double-click inside the viewport on the

right.
■ From the Layer Control list, select the icon

indicated below to Freeze the Center and
Hidden layers in the current viewport.

■ Double-click outside the viewport so that
neither viewport is selected.

   

 
 
8.

  To change the viewports to the layer named
Viewports:
■ With the Command line blank, select the

two viewports.
■ In the Layer Control list, select the

Viewports layer.
■ Press ESC to deselect the viewports.
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9.

  To keep the viewports from printing (Method
1):
■ Select the Layer Control list and Freeze the

Viewports layer.
■ The viewports are not visible in the layout

view and will not print.
   

  You can still double-click inside the viewport to
make it active; however to adjust the viewport
size, you have to Thaw the Viewports layer.  

10.
  To keep the viewports from printing (Method
2):
■ In the Layer Properties Manager, select the

Viewports layer.
■ Select the Plot icon to make the layer not

plotting.
    

 
■ Close the layers Properties Manager dialog

box.
 The Viewports layer will be visible in the
drawing layout, but will not plot.   
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Rotating Viewports
   

You rotate a viewport with the Rotate command or by using grips. You can also set the entire layout
view to rotate with the viewport by setting the VPROTATEASSOC system variable.    
The following image shows a viewport before and after it is rotated.

     

 

    

 
  Before rotation

  After rotation
   
 

Command Access
    

 

  
VPROTATEASSOC

    Command Line: VPROTATEASSOC
   
 

VPROTATEASSOC System Variable
   

The VPROTATEASSOC system variable controls whether the view within a viewport is rotated with the
viewport when the viewport is rotated. The VPROTATEASSOC system variable can be set to one of the
following values.

 
  
Option

  
Description

  0
  When a viewport is rotated, the view inside is not rotated.

  1
  When a viewport is rotated, the view inside is rotated to match the rotation of the
viewport.
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Process: Rotating a View within a Viewport
   

The following steps give an overview of how to rotate a view within a viewport.
  

1.
  At the Command prompt, enter
VPROTATEASSOC.

  

 
2.

  Set the value to 1.
  

 
3.

  On a layout tab, select the desired viewport.
  

 
4.

  Rotate the viewport to the desired angle.
  

 
5.

  Observe the entire view rotate within the
viewport.

  

  



32          ■         Chapter 6: Working with Layouts

 

Exercise: Create and Manipulate Viewports
   
In this exercise, you change the scale factor of a
viewport, move a viewport, freeze a layer in an active
viewport, and create a new viewport.  

  
The completed exercise

Completing the Exercise
To complete the exercise, follow the
steps in this book or in the onscreen
exercise. In the onscreen list of
chapters and exercises, click Chapter 6:
Working with Layouts. Click Exercise:
Create and Manipulate Viewports.

   
1.

  Open M_Create-and-Manipulate-
Viewports.dwg.

 
2.

  In the Layout1 tab, click to select the green
rectangular viewport.

 
3.

  To set the viewport scale:
■ On the status bar, click the Viewport Scale

list and select 1:30.
   

 
 
4.

  The floor plan should now appear smaller on
the layout and you should be able to see all of
the dimensions as shown.
   

 
 
5.

  Click the Layout2 tab.
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6.

  To move a viewport:
■ Start the Move command.
■ Select the green rectangular viewport that

displays the circular staircase. Press ENTER.
■ Move it to the upper-right corner of the

border, as shown.
   

 
 
7.

  To activate model space in the layout:
■ Position the cursor inside the green

rectangular viewport on the left side of the
sheet.

■ Double-click to activate the model space
environment through that viewport.

 When the viewport is active, the crosshairs
and UCS icon should appear as shown.
   

 

 
8.

  To freeze a layer in the current viewport:
■ Open the Layer Properties Manager.
■ Click the icon in the VP Freeze column for

the layer Internal Wall to freeze that layer
in the current viewport.

■ Click OK.
 Notice how the staircase is no longer displayed
in the viewport on the left but it is in the
viewport on the right.
   

 
 
9.

  To change the color of a layer in the current
viewport:
■ Open the Layer Properties Manager.
■ Click the icon in the VP Color column for

the layer Furniture.
■ Set the color to magenta.
■ Click OK.
   

 
 
10.

  To verify that the Furniture color only changed
in Layout2:
■ Click the Model tab. Confirm that the

furniture color remained brown.
■ Click the Layout1 tab. Notice that the

furniture color remained brown.
■ Click the Layout2 tab. Confirm that the

furniture color is still magenta in this
layout.

 
11.

  To activate the layout environment:
■ Position your cursor in the gray

background outside the paper.
■ Double-click to change the focus back to

the layout environment.
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12.

  To create a viewport:
■ Type -vports on the command line
■ Click and draw a rectangular viewport

in the open area of the paper layout as
shown.

   

 
 
13.

  To set the viewport scale:
■ Double-click inside the new viewport to

make it active.
■ On the status bar, click the Viewport Scale

list and click 1:30.
 
14.

  Pan the view in the viewport so you are
viewing the bay walls and couch as shown.
   

 
 
15.

  Double-click in the gray area outside the paper.
 
16.

  Grip edit the viewport from the upper-right
corner to crop the display as shown.
   

 

 
17.

  The green viewport borders are on the
Viewports layer. To set that layer so it does not
plot:
■ Open the Layer Properties Manager.
■ Click the printer icon in the Viewports layer

row.
 With this setting, the viewport borders are not
plotted when you output the drawing.
   

 
 
18.

  On the command line, enter VPROTATEASSOC.
Enter 1.

 
19.

  Select the viewport you created and then start
the Rotate command on the command line:
■ Select a corner of the viewport as the base

point for the rotation.
■ For the rotation angle, enter 90 and press

ENTER.
 Note that when the rotation is complete, the
view of the drawing rotates with the viewport.
If the VPROTATEASSOC variable is set to zero
the Rotate command only rotates the viewport
and not the view within it.

 
20.

  Close all files without saving.
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Challenge Exercise: Architectural
 

  
In this exercise, you use what you learned about working with layouts to configure a layout and a
viewport for your design.

 

 You have the option of completing this exercise using either imperial or metric units.
Select one version of the exercise to complete the steps.

  

  
The completed exercise

Completing the Exercise
To complete the exercise, follow the steps in this book or in the onscreen exercise.
In the onscreen list of chapters and exercises, click Chapter 6: Working with Layouts.
Click Challenge Exercise: Architectural Metric.

 
 

Metric Units
  

1.
  Open the drawing you saved from the previous challenge exercise, or open M_ARCH-Challenge-
CHP06.dwg.
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2.

  Configure Layout1 to plot with the following settings:
■ Orientation: Landscape
■ Scale:1:1
■ Printer/Plotter: DWF6 ePlot.pc3
■ Paper size: ISO A1 (841 x 594 mm) paper

 
3.

  Rename Layout1 to Plan View.
 
4.

  Add and configure the main viewport on the layout:
■ A view of the main floor plan at a scale of 1:60.
■ Lock the viewport when completed.
   

 
 
5.

  Save and close the drawing.
   
 

Imperial Units
  

1.
  Open the drawing you saved from the previous challenge exercise, or open I_ARCH-Challenge-
CHP06.dwg.

 
2.

  Configure Layout1 to plot with the following settings:
■ Orientation: Landscape
■ Scale: 1:1
■ Printer/Plotter: DWF6 ePlot.pc3
■ Paper size: ARCH expand D (36.00 x 24.00 Inches)

 
3.

  Rename Layout1 to Plan View.



Challenge Exercise: Architectural       ■       37

 
4.

  Add and configure the main viewport on the layout:
■ A view of the main floor plan at a scale of 3/16" = 1'.
■ Lock the viewport when complete.
   

 
 
5.

  Save and close the drawing.
  



38          ■         Chapter 6: Working with Layouts

Challenge Exercise: Mechanical
 

  
In this exercise, you use what you learned about working with layouts to create and configure a layout
with three viewports.  

  
The completed exercise

Completing the Exercise
To complete the exercise, follow the steps in this book or in the onscreen exercise.
In the onscreen list of chapters and exercises, click Chapter 6: Working with Layouts.
Click Challenge Exercise: Mechanical.

   
1.

  Open the drawing you saved from the previous challenge exercise, or open M_MECH-Challenge-
CHP06.dwg.
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2.

  Create a new layout configuration with the following settings:
■ DWF6 ePlot.pc3
■ ISO A3 (420 x 297)
■ Three viewports that do not show on the plot
■ A scale factor for the view at the top of 1:1
■ A scale factor for the view on the left of 1:2
■ A scale factor for the view of the assembly on the right of 1:4
   

 
 
3.

  Perform a cleanup:
■ Rename the layout Parts.
■ Delete Layout2.
■ Return to model space.

 
4.

  Save and close the drawing.
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Chapter Summary
 

 

 

There are several ways you can prepare your design data for outputting to paper or to an electronic
file. Layouts are an environment in which you select the paper size for printing on and then add
borders, title blocks, and any textual notes for annotating the drawing. You display model space
geometry on the paper in the layout by creating viewports, which can display various permutations
of the data at different scales to help you to focus on what you are trying to communicate about your
design.  
Having completed this chapter, you can:

■ Identify the environments in which you can plot data and create a new layout.
■ Create and manipulate viewports.
■ In this exercise, you use what you learned about working with layouts to create and configure a

layout with three viewports.
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Chapter

7

Annotating the Drawing
 
  

No drawing is complete without some kind of text to annotate the design. In this chapter, you learn to
create and edit text objects. You also learn how to edit and scale text so that it appears consistently in
your drawing and drawing layouts.

 
Objectives

  
After completing this chapter, you will be able to:

■ Use the Mtext command to create multiline text.
■ Create single line text.
■ Use different methods to edit text.
■ Create text styles to manage text.

 

Standard Object Snap and Status Bar Settings
 Before completing the exercises in this chapter, refer to the "Settings for the

Exercises" section in the Introduction in Volume 1.
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Lesson: Creating Multiline Text
 

  
This lesson describes how to create Multiline Text.  
It is common practice to place paragraph style notes on drawings. These notes generally refer to the
drawing as a whole rather than specific features, and often require more formatting options than
standard single-line text objects.   
The following illustration shows multiline a multiline text object being created.
 

 
Objectives

  
After completing this lesson, you will be able to:

■ Describe Multiline text.
■ Use the Multiline Text command to create and format paragraphs of text.
■ List the changes implemented to increase productivity when using Mtext.
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About Multiline Text
   

You use the Multiline Text command to create paragraphs of text for notes and other information in
your drawing or drawing Layout. 

 
 

   
Words and paragraphs remain intact and the width can be adjusted using grips.
 

 
Multiline Text Defined

  
Multiline Text is an assembly of words, symbols, and other textual information that can be written,
formatted, and edited using the AutoCAD® built-in editor. You can create several paragraphs of text as
a single multiline (mtext) object and format the text appearance which includes justification, italics,
underline, bold, and inserting symbols.
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The illustration below shows the editing options that are available within the multiline Text Editor
when you right-click. These options also appear in the ribbon when the Multiline Text command is
invoked or the text is selected for editing.
 

  
The options for the Text Editor appear within the AutoCAD drawing environment and are similar to
other word programs. 

 
 

 
 

Example of Multiline Text
  

This is an example of Multiline Text. 
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Example of Single Line Text

  
The text in single line text, which you will learn about in the next section, does not allow paragraph
formatting. 

 
 

 

Creating Multiline Text
   

You use the Multiline Text command to create paragraph style text. You can create text in your drawing
using formatting options found in most standard word processors, as well as functions that are specific
to the software.  
With the Multiline Text editor, you can:

 
■ Create paragraph styled text.
■ Create numbered and bulleted lists.
■ Insert specific drafting and engineering symbols.
■ Change the text justification.
■ Create columns of text.
■ Create Fields such as date, time and author.   
Once the Multiline Text area is specified, the ribbon displays the Text Editor tool panels.
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Command Access
    

 

  
Multiline Text
   

 
    Command Line: MTEXT, MT, T
    Ribbon: Annotate tab > Text panel > Multiline Text

   

 
    Ribbon: Home tab > Annotation panel > Multiline Text

   

 
    Menu Bar: Draw > Text > Multiline Text

   
 

Multiline Text Tab
   

When you use the Multiline Text command, the ribbon opens to the Multiline Text tab displaying the
Text Editor. Use the options on the panels to control the text appearance, format your paragraphs,
insert symbols, add fields, check spelling, and perform other functions specific to the annotation of
your drawing.

   

      

 

  Style controls text style and text height.

   

 

  Formatting controls whether the text is bold, italic, underlined, or overlined. You can also choose to
override the current text style font and color.

   

 

  Paragraph controls the justification, line spacing, numbering, and bullets of selected text.

   

 

  Insert allows you to insert symbols, columns, and fields (such as author and date).

     



Lesson: Creating Multiline Text         ■        47

 

Spell Check allows you to check spelling.

   

 

  Tools contains the find and replace, import text, and change case options.

   

 

  Options controls the display of text box rulers and changes the character set and editor settings.

   

 

  Close enables you to close the Multiline Text Editor.

   

Editing Multiline Text
 To edit existing multiline text, double-click the text. The Text Formatting toolbar

appears so you can edit the text in the same way you created it.

 
 

Procedure: Creating Multiline Text
   

The following steps give an overview of creating multiline text.
  

1.
  Start the Multiline Text command.

 
2.

  Click two points to define the text area.
   

 
 
3.

  Confirm the text style (1) and text height (2) settings on the Style panel.
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4.

  Begin creating text using the options as required for numbered or bulleted lists and symbols.
   

 
 
5.

  Use the ruler to adjust the width and height of the text area if necessary.
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6.

  Double-click outside the Text Editor to accept the text and exit.
   

 
  
 

Multiline Text Guidelines
■ Keep the text window size relative to the area where you want the text to appear in the drawing.

Use the grips to adjust the width and height.
■ You can override the font in the current style by setting specific font options on the Formatting

panel.
■ To ensure that multiline text sentences maintain the ability to wrap within the text box, press

ENTER only to begin a new line or paragraph.
■ To format selected text, select the text first, then select the Formatting option. Single-clicking

places the cursor in a new location, double-clicking selects the entire word and triple-clicking
selects the entire paragraph.

■ You can copy text from another location or program and paste it into the Text Editor. However it
may retain the text format associated with its source. Paste the text first into Notepad then copy
it again and past it into the Multiline Text Editor. This way it retains the text style you designate in
AutoCAD.

■ Multiline Text options may also be accessed by right-clicking in the Text Editor window.
■ If you Explode multiline text, it becomes single lines of text.
■ You can type MTEXT or simply T and press ENTER to begin the Multiline Text command.
■ It is good practice to always place text on its own layer.
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MText Columns and Grips
   

When you use Mtext objects in your drawings, you have the ability to format the text into columns.
You can also edit the text using grips in a similar manner to tables. 

 

Placing Mtext
   

When you place Mtext, the Text Editor tab activates on the ribbon. Additionally, you can specify that
you want the text to be formatted with columns using the Column option on the Insert panel.

     

 

    

 
  Column options on the ribbon

  Column Settings dialog box
      

The following column types are available.
 

  
Option

  
Description

  Dynamic Column
  Sets the dynamic columns mode to the current Mtext object. Dynamic columns are
text driven. Adjusting the columns affects the text flow and the text flow causes
columns to be added or removed. Automatic or manual height options are available.

  Static Column
  Sets the static columns mode to the current Mtext object. You can specify the total
width and height of the Mtext object and the number of columns. All of the columns
share the same height and are aligned at both sides.

  No Column
  Specifies no columns for the current Mtext object.

   

 You can also insert a manual column break from the ribbon. This option is disabled
when No Columns is selected.
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Editing Mtext with Grips
   

Grip editing mtext is the ability to adjust column width and height using grips.
 

      

 

  Location Grip
   

 

  Mtext Width and Mtext Height

   

 

  Column Width
   

 

  Mtext Height

   

 

  Mtext Width
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Exercise: Create Multiline Text
   
In this exercise, you use the Multiline Text command
to create multiline text in the drawing.  

  
The completed exercise

Completing the Exercise
To complete the exercise, follow the
steps in this book or in the onscreen
exercise. In the onscreen list of
chapters and exercises, click Chapter 7:
Annotating the Drawing. Click Exercise:
Create Multiline Text.

   
1.

  Open C_Create-Mtext.dwg.
 
2.

  Zoom into the upper-right corner of the title
block.

 
3.

  On the status bar, click Object Snap to turn it
off.

 
4.

  To place an address on the title block:
■ Start the Multiline Text command.
■ Click two points to define the multiline text

box as shown.
   

 
 
5.

  To set the text height and enter the address:
■ On the Style panel, in the text size list,

enter 6.
■ Enter the text as shown.
■ Press ENTER after the last line.
   

 
 
6.

  To change the text height and enter the phone
and fax numbers:
■ In the Text Height list, enter 3.
■ Press ENTER.
 Note: You can enter values or select values in
this list.
■ Enter the text for the telephone and fax

numbers as shown.
■ Click on the Close Text Editor on the Close

panel or double-click outside the Text
Editor.
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7.

  Zoom to the extents of the drawing.
 
8.

  Zoom a window around the view label text.
 
9.

  Repeat the Multiline Text command. Click
two points to define the multiline text box as
shown.
   

 
 
10.

  On the Style panel, select ViewLabel from the
text style list.
   

 
   

11. Enter the text as shown below.
   

 
 
12.

  Double-click outside the Text Editor to close it.
 
13.

  Zoom to the extents of the drawing.
 
14.

  Close all files without saving.
   
 

Edit Mtext to Display Columns
   
In this exercise, you adjust existing text from a single
column to a more orderly column layout.
  
1.

  Open I_Mtext-Columns and Grips.dwg .
 
2.

  Change to the Title Block layout.
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3.

  Select the Mtext object.
   

 
 
4.

  Open the Properties palette from the
command line. Under Text, for Columns, click
[...].
   

 

 
5.

  In the Column Settings dialog box:
■ Under Column Type, select Dynamic

Columns.
■ For Height, enter 6".
■ Under Width, for Column, enter 6".
■ For Gutter, enter 7/16".
■ Click OK.
   

  The Mtext object is displayed with four
columns.
   

 
 
6.

  On the Mtext object, click the Mtext Height
grip.
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7.

  Drag the cursor up and select a point above
the viewport as shown.
   

 
 
8.

  Move the same grip back down as shown. The
fifth column is removed.
   

 
 
9.

  Press ESC to clear grips.
 
10.

  Close all files. Do not save.
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Lesson: Creating Single Line Text
 

 

 

This lesson describes how to use the Text command to create single line text in your drawings. With
Single line text, each line of text or textual object that is created can be edited independently. This
distinguishes single line text from multiline text created with the Mtext command, because a single
Mtext object can contain multiple lines of text.  
Where Mtext is very robust and feature rich, single line text enables you to quickly create and locate
small text objects. The most common use for single line text is to place a number or letter inside a
circle.   
In the following illustration, single line text of varying heights, justification, and rotation angle is used
in a title block.

  

 
Objectives

  
After completing this lesson, you will be able to:

■ Describe Single Line text.
■ Use the Text command to create single line text. Make single line text associative.
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About Single Line Text
   

Single line text is used for information that is usually a single word, a letter or a short sentence or
phrase. The options available to single line text are different than those available with Multiline text
and there are fewer formatting options. An example of a typical use for single line text is to center a
letter or number in a circle. 

 
 

 
If you explode Multiline text, it would be converted to single lines of text. When you type using the
single line Text command, pressing ENTER begins a new line of text. 

 
 

 
Pressing ENTER twice will exit the Text command.  
When you select a single line of text with the Command line blank, only one grip is displayed. 

 
 

 
When you select Multiline text, four grips are displayed.  
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Single Line Text Defined

  
The Text command creates a single line of text. When you begin the command, you are prompted for
a single insertion point for the text location. 

 
 

 
Once you pick that point, you are prompted to specify a height and a rotation angle. Other options
include Justify and Style which can be initiated by pressing the DOWN ARROW on the keyboard or
right-clicking to access the shortcut menu.  

  
Below are some examples of the Justify options. 
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Creating Single Line Text
   

You use the Text command to create single line text objects. When you start the Text command, you
are first shown the current text style and height. You are then prompted to select a start point for the
text, followed by the text height and rotation angle.

 
While the term single line text is used when referring to the Text command, it does not mean that you
can only create a single line of text at a time. To create the next line of text, press ENTER and begin
typing the next line. If you press ENTER on a blank line, the command ends. Each line of text you create
in this way is a separate object. If you use the Text command to create four lines of text, it results in
four separate text objects, each representing a single line of text, and each capable of being edited
independently of the others.

 
You can create single line text objects that are associative. For example, you could link a single line text
object representing the drafter's name in a title block to the drawing file's Author property. Then, if a
different person took over the drawing and changed the drawing file's Author property to their name,
the text would update to the new person's name in the title block.   
The text in the following image was created using the Text command. Even though all lines of text were
created at the same time, you can select and edit them individually.
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Command Access
    

 

  
Single Line Text
   

 
    Command Line: TEXT, DTEXT, DT
    Ribbon: Annotate tab > Text panel > Single Line Text

   

 
    Menu Bar: Draw > Text > Single Line Text

  
 

Command Options
  

Once you begin the Single Line Text command, you choose justification or style options by pressing
the DOWN ARROW on the keyboard or right-clicking anywhere in the drawing to access the shortcut
menu. 
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Justify: Use this option to specify
a justification for the text. Once
you select Justify, a list of options
appears as shown on the right.
 
Style: Use this option to specify a
text style other than the current
text style.
 
Note: It is easier to select the
current text style from the Text
panel before you start the Text
command. Using this option
requires you to enter the text style
name on the command line.

 

   
The following image illustrates the various justification options.

  

 

Text Style Height Setting
 If the current text style uses a height of 0, when you create single line text you are

prompted for the text height. If the current text style has a height specified, you are
not prompted for the text height.

 
 

Procedure: Creating Single Line Text
   

The following steps give an overview of creating single line text.
  

1.
  Start the Text command.

 
2.

  To set the justification options, right-click anywhere in the drawing. Click Justify and enter a justification
option on the command line, or right-click and select the justification on the shortcut menu.

 
3.

  Specify a start point for the text.
 
4.

  Specify a height and rotation angle.
 
5.

  Begin entering the lines of text.
 
6.

  Each time you press ENTER, a new line of text and therefore a new text object is created. Press ENTER
on a blank line to complete the command.
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Single Line Text Guidelines
■ When you create single line text, each line is a separate text object.
■ Pressing ENTER begins another line of text that is aligned with the previous line of text.
■ Picking a point in the drawing window specifies a new location for the next line of text.
■ Pressing ENTER twice ends the single line text command.
■ Single line text is created in the current text style unless you specify another style when you start

the command. It is easiest to chose another text style from the list located in the Text panel before
you begin the single line text command.

■ When creating single line text, follow the Command line prompts.
■ You can specify the text height and rotation angle by picking points in the drawing window.
■ To edit single line text, double-click it.
■ To change the justification, style, or height of a single line text object, select it and right-click.

Select the Properties or Quick properties palette from the shortcut menu.
■ You can copy text from another location such as the Command line or Text Window (F2) and paste

it into the single line text typing area.
■ If you Explode multiline text, it will become single lines of text objects.
■ If you type T and press ENTER at the Command line you will begin the Multiline Text command. If

you enter text and press ENTER, you will begin the Single Line Text command.
■ It is good practice to always place text on its own layer.
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Exercise: Create Single Line Text
   
In this exercise, you create Single Line Text in the
drawing Layout and in model space. You will size
the text accordingly so that it appears at the proper
height.  

  
The completed exercise

Completing the Exercise
To complete the exercise, follow the
steps in this book or in the onscreen
exercise. In the onscreen list of
chapters and exercises, click Chapter 7:
Annotating the Drawing. Click Exercise:
Create Single Line Text.

   
1.

  Open C_Create-Single-Line-Text.dwg.
 
2.

  Zoom into the lower-right area of the title
block.
   

 
   

3. Use Single Line Text to place your name in the
Checked By area of the title block
■ Start the Single Line Text command.
■ Right-click anywhere in the drawing. Click

Justify. Click Right.
■ Click the point indicated by the arrow in

the following image to specify the right
justification of the text.

 Note: You may need to zoom in closer to
prevent Object Snap from selecting the
endpoint of that nearby line.
■ Press ENTER to use default text size.
■ Press ENTER to confirm the default rotation

angle of 0.
 Enter your name and press ENTER twice.
   

 
 
4.

  To check the Viewport Scale:
■ Zoom Extents to view the entire drawing.
■ With the Command line blank, select the

viewport (1).
■ Note the Viewport Scale of 1:100 (2).
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■ Press ESC to cancel the viewport selection.
 
5.

  Click the Model tab to switch to model space.
   

 
 
6.

  Start the Zoom Window command. Click two
points approximately as shown by the arrows
in the following image.
   

 
 
7.

  On the Layers panel, click Make Object's Layer
Current (1) and select the Corridor (2) text
object.
   

 

 
8.

  To check the status bar settings:
■ Make sure Polar Tracking, Object Snap,

Object Snap Tracking and Dynamic Input
are on.

■ Right-click Object Snap. Click Settings and
confirm that the Midpoint object snap
mode is checked.

   

 
 
9.

  Select the text style list from the Text panel and
click Standard.
   

 
 
10.

  To center text above a rectangular object:
■ Zoom in closer to the rectangle to the

lower left side of the word "Corridor"
■ Start the Single Line Text command.
■ Right-click anywhere in the drawing. Click

Justify.
■ Click Center.
■ Hover over the midpoint of the rectangle

as shown (do not select) and track slightly
above it. Click.

   

 
■ Specify a text height of 300.
 Note: Since the Viewport Scale in the Layout
is set to 1:100, setting your text height to 300
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in model space will result in a text height of 3
when viewed through the layout viewport.
■ Specify a rotation angle of (0).
■ Enter kitchen and press ENTER twice.
   

 
 
11.

  To place text in the middle of the rectangle:
■ Begin the Single Line Text command.
■ Right-click. Click Justify.
■ Select Middle from the next menu.
■ Track the midpoints of two adjacent lines

of the rectangle and select the point
where they intersect in the middle of the
rectangle. Click.

   

 
■ Press ENTER twice to accept the default

height of 300 and the default rotation
angle of 0.

■ Enter 210 and press ENTER twice.
   

 

 
12.

  Repeat the previous steps to label each room
with text as shown below:
   

 
 
13.

  To view the results:
■ Zoom to display the entire drawing in

model space.
■ Select the Layout tab to view the text in the

drawing layout.
 
14.

  Close all files without saving.
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Lesson: Editing Text
 

  
This lesson describes how to edit both multiline and single line text.  
Most drawings include at least some text objects. You need to be able to make edits to existing text
quickly and efficiently. It is often easier to make a copy of an existing text object and then edit the
copy than it would be to create the text from scratch.   
In the following illustration, text editing commands were used to modify the title block text and create
a numbered list in the notes.

  

 
Objectives

  
After completing this lesson, you will be able to:

■ Edit text using a variety of commands and methods.
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Editing Text
   

There are five tools that you can use to edit text. These are:
■ Multiline Text Editor ribbon
■ In-place text editor
■ Properties palette
■ Quick Properties
■ Grips

 
The quickest way to edit text is to double-click the text object. If you double-click a multiline text
object, the Multiline Text Editor is displayed in the ribbon along with the In-Place Text Editor. If you
double-click a single line text object, the In-Place Text Editor opens where you can edit the text in the
same way you created it.

 
You can use the Quick Properties or the Properties palette to edit the properties associated with text
as well as the content of the text object. You can also use grips to edit the text's position and width.
When you select text once, grips are displayed. You can grip edit text objects using the same methods
as grip editing geometry.   
In addition to the Multiline Text Editor, the in-place text editor offers real-time spell checking.

  

 



68          ■         Chapter 7: Annotating the Drawing

 

Command Access
    

 

  
Multiline Text Edit
   

 
     Double-click Multiline Text

    Command Line: MTEDIT, DDEDIT, ED
    Ribbon:  double-click Multiline Text  Multiline Text tab > Text Editor panels

   

      Menu Bar: Modify > Object > Text > Edit
   
 

Command Access
    

 

  
Single Line Text Edit

    Double-click Single Line Text
    Command Line: DDEDIT, ED
    Menu Browser: Modify > Object > Text > Edit    

Spell Check the Entire Drawing
 You can check for spelling errors in the entire drawing or selected text objects. Type

spell at the command line and use the options in the dialog box.
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Procedure: Editing Multiline Text
   

The following steps give an overview of editing multiline text.
  

1.
  Double-click the Multiline Text.

 
2.

  Use the in-place text editor to edit text content or select text to format using the options located on the
ribbon.
   

 
 
3.

  Use the Text Editor options found on the ribbon to format text selected from the in-place text editor to
insert symbols, line spacing, numbering, bullets, or change paragraph justification in the selected text.
   

 
 
4.

  Double-click outside the text editor window to end the editing operation.    
 

Editing MultilineText with the Quick Properties Palette
   

Another option for editing
text objects is to use the Quick
Properties palette. You can modify
most of the properties associated
with the text as well as the text
content.
 
In the example on the right, the
text justification option is being
changed to Middle center using the
Quick Properties palette.
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Procedure: Editing Single Line Text
   

The following steps give an overview of editing single line text.
  

1.
  Double-click the Single Line Text.

 
2.

  Use the in-place text editor to edit the content in each single line of text. You can right-click to check
and correct misspelled words.
   

 
 
3.

  Click outside the text editor window to end the editing operation.    
 

Editing Single Line Text with the Quick Properties Palette
   

You can use the Quick Properties
palette to modify most of the
properties associated with single
line text as well as the text content.
 
In the example on the right, the
text rotation option has been
changed to 30 degrees using the
Quick Properties palette.
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Exercise: Edit Text
   
In this exercise, you edit single line text and multiline
text to change the properties and create a numbered
list.  

  
The completed exercise

Completing the Exercise
To complete the exercise, follow the
steps in this book or in the onscreen
exercise. In the onscreen list of
chapters and exercises, click Chapter 7:
Annotating the Drawing. Click Exercise:
Edit Text.

   
1.

  Open M_Edit-Text.dwg.
 
2.

  Zoom into the title block area of the drawing.
 
3.

  Select the Arbor Press text to display the grip.
Note the location of the grip, indicating that
the text is left justified.
   

 
   

4. If the Quick Properties palette is not open,
select it from the status bar or right-click to
access it from the shortcut menu:
■ Under Text, enter %%uArbor Press in the

Contents field.
 Note: These are the ASCII characters for
underlining the text. If this were Multiline
Text you would be able to use the Formatting
options from the ribbon.
■ In the Justify list, select Middle.
■ In the Height field, enter 10.
   

 
 
5.

  Press ESC to clear the selection. Note the new
appearance of the text.
   

 
 
6.

  Zoom into the notes above the title block.
 
7.

  Double-click the notes text. The Text
Formatting toolbar is displayed with the In-
Place Text Editor. Click the beginning of each line and press DEL
to remove the numbers.
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8.

  Highlight all of the text beneath the word
Notes. On the ribbon, in the Paragraph panel,
click Numbering. Click Numbered.
   

  The text should now appear as shown.
   

 

 
9.

  Place the cursor at the beginning of line 3 and
press TAB.
   

  The line is automatically renumbered as a
subnote and the numbers are reordered.

 
10.

  Click Close Text Editor on the Close panel.
 
11.

  Zoom to the extents of the drawing.
 
12.

  Close all files without saving.
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Lesson: Using Text Styles
 

  
This lesson describes how you can use text styles to control text appearance.  
In a typical design environment, there can be several designers creating drawings. If each designer
were to choose their own text fonts for annotation, the resulting drawings would lack a uniform
appearance. Using text styles can help to create a consistent appearance across drawings by providing
predefined text formats.  

 
Objectives

  
After completing this lesson, you will be able to:

■ Explain the purpose of text styles.
■ Create and use text styles.
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Text Styles
   

Text styles provide an easy way for you to control the default appearance of text. Each text object
contains properties such as font, height, width factor and oblique angle. Using text styles, you can
predefine each of these properties, resulting in a uniform appearance of text objects that use the
same style.

 
Another benefit of using text styles is that you can update all text in the drawing that uses a certain
style simply by changing the style.   
The following image illustrates the effect of changing a text style when it is being referenced by text
objects. In the floor plan on the right, the text style uses a smaller font so that the text objects better
fit the space.

  

 
Text Styles Defined

  
A text style is a collection of common text properties used by one or more text objects in the drawing.
You generally create several text styles. For example, you could have a text style for dimensions,
another for view labels, and another for title blocks or general drawing annotation.  

 
Example of Text Styles

  
On a typical drawing, you might have one style defined for all of your general notes, text and
dimensions, another style for object labels, and another style for the title block information.

 
Text Style Key Points
■ A text style is a collection of predefined text properties such as font, height, width factor, and

oblique angle.
■ You create text styles to keep a uniform appearance of text objects in the drawing.
■ You can update all text in the drawing that uses a certain style simply by changing the style.
■ You generally create several text styles for objects such as dimensions, view labels, your title block

or general drawing annotation.
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Creating and Using Text Styles
   

You use the Style command to create and manage text styles. By default, all new drawings contain two
text styles, one named Standard and one named Annotative. Standard is the current text style for all
new drawings, unless you base a new drawing on a template that has another style set as the current
style.

 
Creating and Using Text Styles

  
Text styles are similar to layers in that they are used to organize objects in the drawing. You create a
Text Style and make it current so that the text you enter appears in that style. You can also change the
Text Style of selected text after it was placed in the drawing.   
To create text styles, you use the Text Style dialog box. To switch from the current text style to another,
you can select a text style from the list on the Text panel the same way you can make a Layer current
from the Layer Control list. Similarly, you can assign a text style to selected text from the text style list.

  

 
 

Command Access
    

 

  
Style
   

 
    Command Line: STYLE, ST
    Ribbon: Annotate tab > Text panel > Text Style

   

 
    Menu Bar: Format > Text Style
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Text Style Dialog Box
   

You use the Text Style dialog box to create and manage text styles.
  

      

 

  Use this area to view your current text Styles. You can also edit a selected style or rename it.

   

 

  Select a Font Name from the list of available fonts. Apply a Font Style such as Bold or Italic if required.

   

 

  Specify the size of your text in this section. If you choose to make your text Size Annotative, the Height
field changes to Paper Text Height. Enter the Paper Text Height you want to appear in all your layout
viewports for text created with this style regardless of the viewport scale.

   

 

  Select any Effects to apply to the text such as Width Factor and Oblique Angle. A Width Factor of 1 is
normal. Less than 1 would make the text narrow and greater than 1 would make the text wide.

   

Applying Height to the Text Style
 When you set the text height, it becomes the default value for text created with that

style. If this value is 0, you will be prompted to specify the text height each time you
create Single Line Text. When using the Multiline Text command, the text height can
be chosen or typed from the list in the Text panel.

 
 

Annotative Property
   

You can choose the Annotative Style (1) or assign the Annotative property (2) to a text style when
you want the text height to display and plot the same size in the drawing layout, regardless of the
viewport scale.
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You can Match the text orientation to the layout (3) so that the text objects display horizontal if the
view is, for instance, isometric.

 
When Annotative is selected, the Height property changes to Paper Text Height (4). Enter a value
other than zero to set the height for all the text that utilizes this style. The text in the viewports is
automatically scaled to the paper height size in the drawing layout.
 

 
 

Example of Text Oriented to Layout
   

In the following images, two views are shown on the layout. In the first view, the text appears in the
same orientation that it was created, which is normal to the plan view and layout. In the second image,
the view was changed to isometric, but the text remains oriented to the layout.

     

 

   

 
  Plan view

  Isometric view
   

Setting Height in the Text Style
 When you set a value for Height (Paper Text Height for annotative styles) in the text

style, it becomes the default value for all text created with that style. Then, when
you create a single line text object using the Text or Dtext commands, you are not
prompted for a paper height. Leave this option set to 0 if you want to be prompted
for the paper height when using the Text or Dtext commands.
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Procedure: Creating and Using Text Styles
   

The following steps give an overview of creating and using text styles.
  

1.
  Start the Style command.

 
2.

  Select New (1) and enter a New Text Style Name (2).Click OK.
   

 
 
3.

  Select the new style (1), assign a Font Name (2), a Height (3), Apply (4) and Set Current (5). Then Close
the dialog box.
   

 
 
4.

  Begin the Text command.
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5.

  To change from one text style to another, choose the Text style from the list.
   

 
 
6.

  To assign a Text Style to existing text objects:
■ With the Command Line blank, select the objects.
■ Select the text style from the list.
■ Press ESC to deselect the text objects.

   

Redefining Styles
 If you redefine a style to be annotative or nonannotative, the objects that used

that style are not automatically updated. You can use the Annoupdate command to
update the objects to the new style, or change them using the Properties palette.

 
Text Style Guidelines
■ The default text style for all new drawings is Standard unless the new drawing is based on a

template with a different default style.
■ All text is assigned to a text style. If you do not create any new text styles, all text is assigned to the

Standard text style.
■ The default font for the Standard style is Arial.
■ You cannot delete or rename the Standard text style.
■ If you copy and paste text from another drawing or insert a block into a drawing that has the

same Text Style name with different properties, the text properties of the host drawing will take
precedence.

■ Changes made to a text style affect all text objects using the style.
■ The software uses two types of fonts: Line fonts (*.shx) and True Type fonts (*.ttf).
■ Create only the number of text styles necessary to keep the text properties in a drawing consistent.
■ Delete text styles that are not being used in the drawing.
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Exercise: Use Text Styles
   
In this exercise, you modify the Standard text style to automatically update all text in the drawing. You then
create new text styles and assign text objects to the new styles.  

  
The completed exercise

Completing the Exercise
To complete the exercise, follow the
steps in this book or in the onscreen
exercise. In the onscreen list of
chapters and exercises, click Chapter 7:
Annotating the Drawing. Click Exercise:
Use Text Styles.

   
1.

  Open C_Text-Styles.dwg.
 
2.

  Using the Zoom command, zoom into various
areas of the drawing to see the text. Note the
appearance and font used.
   

 
 
3.

  To change the font of the Standard style:
■ On the Text panel, click Text Style.
■ In the Text Style dialog box, select Arial in

the Font Name list.
 

Tip: Enter A to scroll the list to the fonts
starting with the letter A.
■ For Height, enter 0.
■ Click Apply.
■ Click Close.
   

 
 
4.

  View the text in the drawing again. With a
simple change to the text style, all text using
the modified style is updated.
   

 
 
5.

  Zoom to display the entire drawing.
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6. To create new text styles to be used in the
drawing:
■ Start the Text Style command.
■ In the Text Style dialog box, click New.
■ In the New Text Style dialog box, enter

MT-5-Title.
■ Click OK.
■ From the Font Name list, select Technic.
■ For Height, enter 8.
■ Click Apply.
■ Click New.
■ In the New Text Style dialog box, enter

ViewLabel.
■ Click OK.
■ For Height, enter 5.
■ Click Apply.
■ Click Close.
 Note: As you create each new text style, it
becomes the current text style.

 
7.

  Select the view label Main Floor and the
number tag located near the bottom of the
view.
   

 
 
8.

  On the Text panel, select ViewLabel in the Text
Style list.
   

 
 
9.

  Press ESC to clear the selection. The new text
style is assigned to the view label text.

 
10.

  Adjust the view in the drawing to see the title
block text. Select the text as shown.
   

 
 
11.

  To change the style of the text:
■ On the Text panel, select MT-5-Title in the

Text Styles list.
■ Press ESC to clear the selection.
■ The new text style is applied to the

selected text.
   

 
 
12.

  Close all files without saving.
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Challenge Exercise: Architectural
 

  
In this exercise, you use what you learned about annotation to create a text style and add annotation
to your floor plan.

 

 You have the option of completing this exercise using either imperial or metric units.
Select one version of the exercise to complete the steps.

  

  
The completed exercise

Completing the Exercise
To complete the exercise, follow the steps in this book or in the onscreen exercise. In
the onscreen list of chapters and exercises, click Chapter 7: Annotating the Drawing.
Click Challenge Exercise: Architectural Metric.

 
 

Metric Units
  

1.
  Open the drawing you saved from the previous challenge exercise, or open M_ARCH-Challenge-
CHP07.dwg.

 
2.

  Make initial settings:
■ Return to Model Space.
■ Set the Annotation layer as current.
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3. Create a new text style with the following characteristics:
■ Style Name: Labels
■ Font Name: Arial
■ Height: 0
■ Width Factor: 0.9000

 
4.

  Add room labels and room ID numbers that are 300 mm tall as shown in the illustration:
■ 221 through 224 - SLEEPING QUARTERS
■ 201 - READY ROOM
■ 202 & 204 - LOCKER ROOM
■ 203 - EXERCISE ROOM
■ 205 - DINING ROOM
■ 206 - KITCHEN
■ 207 - MEN'S TOILET ROOM
■ 208 - WOMEN'S TOILET ROOM
   

   
5.

  Save and close the drawing.
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Imperial Units
  

1.
  Open the drawing you saved from the previous challenge exercise, or open I_ARCH-Challenge-
CHP07.dwg.

 
2.

  Make initial settings:
■ Return to Model Space.
■ Set the Annotation layer as current.

 
3.

  Create a new text style with the following characteristics:
■ Style Name: Labels
■ Font Name: Arial
■ Height: 0
■ Width Factor: 0.9000

 
4.

  Add room labels and room ID numbers that are 1' tall as shown in the illustration:
■ 221 through 224 - SLEEPING QUARTERS
■ 201 - READY ROOM
■ 202 & 204 - LOCKER ROOM
■ 203 - EXERCISE ROOM
■ 205 - DINING ROOM
■ 206 - KITCHEN
■ 207 - MEN'S TOILET ROOM
■ 208 - WOMEN'S TOILET ROOM
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5.

  Save and close the drawing.
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Challenge Exercise: Mechanical
 

 

 

In this exercise, you use what you learned about annotation to add annotation to the drawing views.
 

Note: The following illustration depicts only some of the views that require annotation.  

  
The completed exercise

Completing the Exercise
To complete the exercise, follow the steps in this book or in the onscreen exercise. In
the onscreen list of chapters and exercises, click Chapter 7: Annotating the Drawing.
Click Challenge Exercise: Mechanical.

   
1.

  Open the drawing you saved from the previous challenge exercise, or open M_MECH-Challenge-
CHP07.dwg.

 
2.

  Make initial settings:
■ Make the Annotation layer current.
■ Thaw the Section Line layer.

 
3.

  Create a new text style with the following characteristics:
■ Style Name: Labels
■ Font Name: Arial
■ Height: 0
■ Width Factor: 0.9000
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4.

  Annotate the drawing views by adding view labels that are 8.0 mm tall as shown in the following
illustrations. Note that the annotation indicated on the left side of the view reads Outfeed Side and
needs to be 4.0 mm in height.
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5.

  More views
   

    

    

 
 
6.

  Save and close all files.
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Chapter Summary
 

  
Using the annotation commands, you can create and edit the annotation that is typically required in
drawings. By using the annotative properties of your annotations, you can create annotations that get
reused in many viewports at any desired scale.  
Having completed this chapter, you can:

■ Use the Mtext command to create multiline text.
■ Create single line text.
■ Use different methods to edit text.
■ Create text styles to manage text.
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Chapter

8

Dimensioning
 
  

You use dimensions on drawings to convey size and specifications. Most drawings are not complete
until you have added dimensions.

 
When dimensioning a drawing, you need to consider the final output scale of the drawing, the
placement of dimensions, and how the dimensions should appear.

 
In this chapter, you learn how to create, edit, and manage dimensions in a typical design environment.

 
Objectives

  
After completing this chapter, you will be able to:

■ Create dimensions.
■ Use dimension styles to manage dimensions.
■ Create and edit multileader styles and multileaders.
■ Use different commands and methods to edit dimensions.

 

Standard Object Snap and Status Bar Settings
 Before completing the exercises in this chapter, refer to the "Settings for the

Exercises" section in the Introduction in Volume 1.
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Lesson: Creating Dimensions
 

  
This lesson describes how to use the various dimension commands to place dimensions on your
drawings.  
Dimensions are a vital element of annotation. They display measurements and illustrate how your
drawings meet specifications.  

 
Objectives

  
After completing this lesson, you will be able to:

■ Create different types of dimensions on linear objects.
■ Create different types of dimensions on curved objects.
■ Enhance dimensions for clarity of purpose.
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Creating Dimensions on Linear Objects
   

Placing dimensions on objects in the drawing is a straightforward process. Your dimensions will be
as accurate as your drawing, provided you use the object snaps correctly. Dimension commands are
located on the Annotate tab of the Ribbon. Pay attention to the Command line prompts as they guide
you to the required selections. 

 
 

   
The following illustration shows a variety of dimensions for linear objects.
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Procedure: Creating a Linear Dimension
   

Use the following command to create horizontal or vertical Linear dimensions:
 
 
 

 
Command Line: DIMLINEAR, DIMLIN

 
Ribbon: Annotate tab > Dimensions panel > Linear

 
 
 

  
The following steps give an overview of creating a Linear dimension:

  
1.

  Start the Dimlinear command.
 
2.

  Press ENTER to select the object or, using object snap, select the first extension line origin (1) and the
second extension line origin (2).
   

 
 
3.

  Click to position the dimension (3).
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Practice Exercise: Linear Dimensions  
In this practice exercise, you create the object below,
and apply linear dimensions as shown. 
 
 

   
1.

  To draw your object to dimension:
■ Begin with a blank drawing.
■ Draw a simple rectangle (any size).
■ Use the Grips to stretch one corner of the

rectangle.
■ Press ESC to deselect the object.
   

 
 
2.

  To create a Linear dimension by selecting two
points on the object:
■ Begin Linear dimension.
■ Using object snap, click to specify the first

extension line origin (1).
■ Click to specify the second extension line

origin (2).
■ Click to specify the dimension line location

as shown (3).
 

  

 
 
3.

  To create a Linear dimension by selecting the
object:
■ Begin Linear dimension.
■ Press ENTER to select the object.
■ Select the object where indicated (1).
■ Drag and place the dimension as shown (2).
■ Repeat the Linear dimension command.
■ Create dimensions (3) and (4).
   

  Note: When you dimension the angled line (4),
you have the option to create a horizontal or
vertical Linear dimension, depending on the
direction you drag the dimension.
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Procedure: Creating an Aligned Dimension
   

Use the following command to create a dimension that is aligned to an object or two points:
 
 
 

 
Command Line: DIMALIGNED

 
Ribbon: Annotate tab > Dimensions panel > Align

 
 
 

 
Note: Once you select a dimension type from the list, it becomes the predominant button in the
Dimensions panel.

 
The following steps give an overview of creating an aligned dimension:

  
1.

  Start the Dimaligned command.
 
2.

  Press ENTER to select the object or, using object snap, select the first extension line origin (1) and the
second extension line origin (2).
   

 
 
3.

  Click to position the dimension (3).
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Practice Exercise: Aligned Dimensions  
In this practice exercise, you create the object below
and apply aligned dimensions as shown. 
 
 

   
1.

  To draw your object to dimension:
■ Begin with a blank drawing.
■ Draw a simple rectangle (any size).
■ Use the Grips to stretch the corners of the

rectangle.
■ Press ESC to deselect the object.
   

 
 
2.

  To create an Aligned dimension by selecting
two points on the object:
■ Begin the Aligned dimension command.
■ Using object snap, click to specify the first

extension line origin (1).
■ Click to specify the second extension line

origin (2).
■ Click to specify the dimension line location

as shown (3).
   

 
 
3.

  To create an Aligned dimension by selecting
the object:
■ Begin the Aligned dimension command.
■ Press ENTER to select the object.
■ Select the object where indicated (1).
■ Drag and place the dimension as shown (2).
■ Repeat to create dimension (3).
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Procedure: Creating an Angular Dimension
   

Use the following command to create an angular dimension between two lines. The Angular
dimension command can also be used to measure the angle between two points on a circle, the angle
of an arc, or the angle between three points.

 
 
 

 
Command Line: DIMANGULAR, DIMANG

 
Ribbon: Annotate tab > Dimensions panel > Angular

 
 
 

 
Note: Once you select a dimension type from the list, it becomes the predominant button in the
Dimensions panel.

 
The following steps give an overview of creating an angular dimension:

  
1.

  Start the Dimangular command.
 
2.

  Select the first line segment (1).
 
3.

  Select the second line segment (2).
 
4.

  Click to position the dimension (3).
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Practice Exercise: Angular Dimensions  
In this practice exercise, you create the object below
and apply angular dimensions as shown. 
 
 

   
1.

  To draw your object to dimension:
■ Begin with a blank drawing.
■ Draw a simple rectangle (any size).
■ Use the Grips to stretch the corners of the

rectangle.
■ Press ESC to deselect the object.
   

 
 
2.

  To create an Angular dimension by selecting
two lines:
■ Begin the Angular dimension command.
■ Select the first line (1).
■ Select the second line (2).
■ Specify the dimension arc line location as

shown (3).
   

  Note: You can drag the arc dimension to inside
or outside the arc angle.

 
3.

  Repeat to dimension the remaining angles.
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Procedure: Creating Baseline Dimensions
   

Use the following command to create baseline dimensions. Create a Linear, Aligned or Angular
dimension first to use a the base dimension. By default, the baseline dimension is built off of the last
dimensioned line selected.

 
 
 

 
Command Line: DIMBASELINE, DIMBASE

 
Ribbon: Annotate tab > Dimensions panel > Baseline

 
 
 

 
The following steps give an overview of creating baseline dimensions:

  
1.

  To use the Baseline dimension, begin by creating the base dimension. Note that by default, the last linear, aligned or angular dimension created is used as the base
dimension, or you are prompted to select a base dimension.

 
2.

  For the baseline dimension, begin the Linear dimension and select the first extension line origin (1) and
the second second extension line origin (2). Note that the baseline will be built off of the first extension line origin.

 
3.

  Click to position the Linear dimension (3).
 
4.

  Start the Dimbaseline command. Select the next extension line (4).
 
5.

  Continue selecting points (5 and 6) for as many baseline dimensions as you require.
   

 
 
6.

  Press ENTER to end the Baseline command.
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Practice Exercise: Baseline Dimensions  
In this practice exercise, you create the object below
and apply baseline dimensions as shown. 
 
 

   
1.

  To create your base dimension using the Linear
dimension command:
■ Begin Linear dimension.
■ Specify the first extension line (1).
■ Specify the second extension line (2).
■ Specify the dimension location.
   

  Note: Baseline dimensions build off of the first
extension line origin.

 
2.

  To add the Baseline dimensions:
■ Continue with the Baseline command.
■ Specify a second extension line at (1), (2)

and (3).
■ Press ENTER twice to complete the

command.
   

  Note: If you choose to select a base dimension
that was already created, be sure to select it
towards the extension line that you want to be
the baseline. In this example, it would be the
left side of the Linear dimension you created.
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Procedure: Creating Continuous Dimensions
   

Use the following command to continue placing dimensions based on a Linear, Aligned or Angular
dimension. Select or create the base dimension. The continued dimensions are built from the last
dimension origin point.

 
 
 

 
Command Line: DIMCONTINUE, DIMCONT

 
Ribbon: Annotate tab > Dimensions panel > Continuous

 
 
 

 
The following steps give an overview of creating continuous dimensions:

  
1.

  To use the Continue dimension, begin by creating the base dimension. Note that by default, the last linear, aligned or angular dimension created is used as the base
dimension, or you are prompted to select a base dimension.

 
2.

  For the base dimension, begin the Linear dimension. Use object snaps to select the first extension line
origin (1) and the second extension line origin (2). Note that the continuous dimensions will be built off of the second extension line origin.

 
3.

  Click to position the Linear dimension (3).
 
4.

  Start the Dimcontinuous command. Select the next extension line (4).
 
5.

  Using object snap, continue selecting points (5 and 6) or objects for as many continuous dimensions as
you require.
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Practice Exercise: Continuous Dimensions  
In this practice exercise, you create the object below
and apply continuous dimensions as shown. 
 
 

   
1.

  To create your base dimension using the Linear
dimension command:
■ Begin Linear dimension.
■ Specify the first extension line (1).
■ Specify the second extension line (2).
■ Specify the dimension location.
   

  Note: Continuous dimensions build off of the
second extension line origin. Note: When you choose the dimension origin
points as indicated, the gap between the
dimension extension lines and the object is
visible.

 
2.

  To add the Continuous dimensions:
■ Begin the Continuous dimension

command.
■ Specify a second extension line at (1) and

(2).
■ Press ENTER twice to complete the

command.
   

  Note: If you choose to select a base dimension
that was already created, be sure to select
it towards the extension line you want the
Continuous dimension to follow. In this
example, it would be the side of the Linear
dimension you created.
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Dimensions for Linear Objects Guidelines
■ Always use Object Snaps to select the dimension origin points.
■ Depending on the geometry you are dimensioning you may select objects to dimension rather

than specifying the endpoints.
■ A Linear dimension will be horizontal or vertical depending on the direction you drag the

dimension line from the object.
■ An Angular dimension may be located inside or outside the angle depending on where you drag

the arc line location.
■ To ensure that Continuous and Baseline dimensions build correctly, create the base Linear, Aligned

or, Angular dimension choosing the first and second origin points accordingly. Baseline dimensions
are built from the first origin point. Continuous dimensions are built from the second origin point.

■ When you select the base dimension for your Continuous or Baseline dimensions, select the
dimension towards the side that you want the continued or baseline dimension to reference.

■ Adjust the location of the dimension using Grips when necessary.
■ If the origin point you selected is incorrect, zoom in closer to the object and use the grips to

relocate the origin point to the object.
 

 The Dimlinear and Dimaligned commands prompt you for two points or to select
an object. Press ENTER to select the object to dimension. This is often quicker than
selecting two points.
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Creating Dimensions on Curved Objects
   

Using commands to place dimensions on curved objects in the drawing is a straightforward process.
Pay attention to the command prompts as they guide you through the required selections. These
dimensions can be selected from the list on the Dimensions panel. 

 
 

    
The following illustration shows a variety of dimensions for curved objects.
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Procedure: Creating an Arc Length Dimension
   

Use the following command to dimension the length of an arc.
 
 
 

 
Command Line: DIMARC

 
Ribbon: Annotate tab > Dimensions panel > Arc Length

 
 
 

 
The following steps give an overview of creating an arc length dimension:

  
1.

  Start the Dimarc dimension command.
 
2.

  Select an arc (1).
   

 
 
3.

  Click to position the arc length dimension (2).
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Practice Exercise: Arc Length Dimensions  
In this practice exercise, you draw several arcs, then
use the Arc Length command to dimension the arcs. 
 
 

   
1.

  To create Arc Length dimensions on the arcs
you have drawn:
■ Begin the Arc Length command.
■ Select the arc (1).
■ Specify the arc length dimension location

(2).
   

 

 
2.

  Repeat the Arc Length command to dimension
the remaining arcs.
   

  Note: The arc length symbol can precede the
dimension text, be above the dimension text,
or be turned off. This symbol can be controlled
using the DIMSTYLE command. Select: Modify
> Symbols and Arrows > Arc Length Symbol.
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Procedure: Creating a Radius Dimension
   

Use the following command to dimension the radius of a circle or arc.
 
 
 

 
Command Line: DIMRADIUS, DIMRAD, DRA

 
Ribbon: Annotate tab > Dimensions panel > Radius

 
 
 

 
The following steps give an overview of creating a radius dimension:

  
1.

  Start the Dimradius command.
 
2.

  Select an arc or circle (1).
   

 
 
3.

  Click to position the dimension (2).
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Practice Exercise: Radius Dimensions  
In this practice exercise you use the Radius Dimension
command; first, create a drawing that resembles the
object shown below. 
 
 

 
Note: To ensure a manageably sized drawing,
begin with a blank drawing based on the acad.dwg
template.   
1.

  To create the object to dimension:
■ Draw a rectangle.
■ Begin the Fillet command and set the fillet

radius to .25 or .5.
■ Use the Polyline option of the Fillet

command to fillet all 4 corners of the
rectangle.

 Note: A rectangle is a polyline meaning all the
lines are connected and recognized as a single
object.
■ Begin the Offset command.
■ Specify an offset distance of .15.
■ Offset the polyline.

 
2.

  To dimension the outside fillet:
■ Begin the Radius command.
■ Select the arc (1).
■ Specify the dimension line location (2).
   

 
 
3.

  Repeat the command to dimension the inside
radius (3).
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Procedure: Creating a Jogged Radius Dimension
   

Use the following command to dimension a radius where you want to override the center origin point
of the dimension to another location. This will create a jogged radial dimension.

 
 
 

 
Command Line: DIMJOGGED

 
Ribbon: Annotate tab > Dimensions panel > Jogged

 
 
 

 
The following steps give an overview of creating a jogged radius dimension:

  
1.

  Start the Dimjogged command.
 
2.

  Select an arc or circle (1).
 
3.

  Specify a center location override (2).
 
4.

  Specify a dimension line location (3).
 
5.

  Specify the jog location (4).
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Practice Exercise: Jogged Radius Dimensions  
In this practice exercise you draw an arc and use the
Jogged radius dimension command. 
 
 

   
1.

  Draw an arc.
 
2.

  To create a jogged radius:
■ Enter DIMJOGGED and press ENTER.
■ Select the arc (1).
■ Specify the center point location override

(2).
■ Specify the dimension line location (3).
■ Specify the jog location.
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Procedure: Creating a Diameter Dimension
   

Use the following command to dimension the diameter of a circle or arc:
 
 
 

 
Command Line: DIMDIAMETER, DIMDIA

 
Ribbon: Annotate tab > Dimensions panel > Baseline

 
 
 

 
The following steps give an overview of creating a diameter dimension:

  
1.

  Start the Dimdiameter command.
 
2.

  Select an arc or circle (1).
   

 
 
3.

  Click to position the dimension (2).
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Practice Exercise: Diameter Dimensions  
In this practice exercise you draw several circles and
use the Diameter dimension command. 
 
 

   
1.

  To dimension the diameter of a circle:
■ Begin the Diameter dimension command.
■ Select the circle (1).
■ Specify the dimension line location (2).
   

 

 
2.

  Repeat the Diameter command to dimension
the remaining circles.
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Procedure: Creating Center Marks
   

Use the following command to create a center mark.
 
 
 

 
Command Line: DIMCENTER

 
Ribbon: Annotate tab > extended Dimensions panel > Center Mark

 
 
 

 
Note: You can type DIMCEN to change the value (size) of the Center Marks.

 
The following steps give an overview of creating center marks:

  
1.

  Start the DIMCENTER command.
 
2.

  Select an arc or circle (1).
   

  Note: The Center Mark size and appearance is set in the Dimension Style or you can change the size by
typing DIMCEN.
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Practice Exercise: Create Center Marks  
In this practice exercise you draw several circles and
arcs and place a Center Mark in each one. 
 
 

    
1.

  Draw several circles and arcs.
 
2.

  To place center marks in the circles and arcs:
■ Begin the Center Mark dimension

command.
■ Select a circle or arc.
■ Repeat and continue to place a center

mark within each object.
   

  Note: The Center Mark appearance and size
is controlled using the DIMSTYLE command
(select: Modify > Symbols and Arrows > Center
marks).
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Enhancing Dimensions
   

Placing dimensions on objects in the drawing is a straightforward process, however you may need
to use some additional tools to produce drawings to your desired standard. Pay attention to the
command prompts; they guide you through the required selections.   
The following illustration shows a variety of dimensions that have been enhanced for adherence to a
drafting standard.

  

 
 

Procedure: Placing a String of Quick Dimensions
   

Use the following command for placement of a semi-automated string of quick dimensions:
 
 
 

 
Command Line: QDIM

 
Ribbon: Annotate tab > Dimensions panel > Quick Dimension

 
 
 

 
The following steps give an overview of the Quick Dimension command. This command only works for
model space dimensioning.

  
1.

  Start the Qdim command.
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2. Select the geometry to dimension using standard selection methods.
   

 
 
3.

  By default, a series of continuous dimensions is previewed. Right-click anywhere in the drawing to
change the dimension types or options. Available options are: Continuous, Staggered, Baseline,
Ordinate, Radius, Diameter, Datumpoint, Edit, and Settings.
   

 
 
4.

  Click to position the dimensions.
   

  The dimensions are created.
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Warning!
 

 QDIM is not available in AutoCAD LT®.

  
 

Procedure: Ordinate Dimensions
   

Use the following command to create Ordinate dimensions.
 
 
 

 
Command Line: DIMORDINATE, DIMORD

 
Ribbon: Annotate tab > Dimensions panel > Ordinate

 
 
 

 
The following steps give an overview of creating Ordinate Dimensions. To dimension using Ordinate
Dimensions, you must first change the Origin point.
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1.

  Enter UCS and press ENTER. Specify the origin point on the object for the Ordinate dimensions to
reference. Accept your selection by pressing ENTER.
   

 
 
2.

  Start the Dimordinate command.
 
3.

  Use object snap to specify the feature location (2), then specify the leader endpoint (3).
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4.

  Repeat Dimordinate and continue to select the next feature location and leader endpoint. Then return
the UCS origin back to World. Note you can use the Ordinate option with the Quick Dimension command.
   

 
   
 

Procedure: Breaking Dimensions
   

Use the following command to break dimension or extension lines where they overlap other lines:
 
 
 

 
Command Line: DIMBREAK

 
Ribbon: Annotate tab > Dimensions panel > Break

 
 
 

 
The following steps give an overview for breaking dimensions:

  
1.

  Start the Dimbreak
command.
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2.

  Select the dimension to break
(1). Note: Use the Multiple
option to break multiple
dimensions.

    

 
 
3.

  Select objects to break the
dimension (2) and press
ENTER. Note: Simply press ENTER
to break the dimension
automatically wherever it
intersects with other objects
or dimensions.

    

   

 
   
 

Procedure: Creating Jogged Linear Dimensions
   

Use the following to command to add a jog line to a dimension line.
 

Command Line: DIMJOGLINE
 

Ribbon: Annotate tab > Dimensions panel > Jog Line
 
 
 

 
The following steps give an overview for adding a Jog Line to a dimension:
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1.

  Create a linear dimension
between two points and
enter the text override value
to represent the stated value.

    

 
 
2.

  Start the Dimjogline
command and select a linear
dimension.

    

 
 
3.

  Click a point on the
dimension to place the jog
line symbol.

    

 
   

Removing a Linear Jog from a Dimension
 To remove the jog symbol from a jogged linear dimension, use the Remove option of

the Dimjogline command.

 
 

Procedure: Spacing Dimensions
   

Use the following command to adjust the space between parallel linear dimensions.
 
 
 

 
Command Line: DIMSPACE

 
Ribbon: Annotate tab > Dimensions panel > Adjust Space
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The following steps give an overview for spacing dimensions uniformly after they have been placed in
the drawing:

  
1.

  Start the Dimspace command
and select the base
dimension.

    

 
 
2.

  Select the dimensions to
be spaced from the base
dimension, and press ENTER.

    

 
 
3.

  Enter a value for spacing the
dimensions, or press ENTER
to use the automatic method.

    

 
   

Dimensions Are Associative
 When you create dimensions, they are associative to the geometry or points you

select. If the geometry changes size, the dimension updates accordingly.
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Procedure: Adding Tolerances
   

Use the following command to add a dimension Tolerance to your drawing:
 
 
 

 
Command Line: TOLERANCE, TOL

 
Ribbon: Annotate tab > Dimensions panel > Tolerance

 
 
 

 
The following steps give an overview of adding a dimension Tolerance:

  
1.

  Start the Tolerance command.
 
2.

  From the Geometric Tolerance dialog box, select the desired Symbol, Tolerance and Datum. Click OK.
   

 
 
3.

  Click to place the Tolerance in the drawing.
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Procedure: Inspecting Dimensions
   

Use the following command to add an inspection label to a selected dimension:
 
 
 

 
Command Line: DIMINSPECT

 
Ribbon: Annotate tab > Dimensions panel > Inspect

 
 
 

 
The following steps give an overview of creating an inspection label.
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1.

  Start the Diminspect command.
 
2.

  From the Inspection Dimension dialog box, select a Shape and a Label and/or Inspection rate.
   

 
 
3.

  Select the dimension(s) and click OK.
   

 
  



128          ■         Chapter 8: Dimensioning

 

Exercise: Create Dimensions
   
In this exercise, you create several types of
dimensions using the appropriate dimension
commands.  

  
The completed exercise

Completing the Exercise
To complete the exercise, follow the
steps in this book or in the onscreen
exercise. In the onscreen list of
chapters and exercises, click Chapter
8: Dimensioning. Click Exercise: Create
Dimensions.

   
1.

  Open M_Create-Dimensions.dwg.
 
2.

  To create a linear dimension:
■ On the Dimensions panel, click Linear.
■ Click the points indicated in the following

image and position the dimension as
shown.

  

 

 
 
3.

  Repeat the Linear Dimension command and
place dimensions as shown. Note: You correct the spacing in the next step.
   

 
 
4.

  To correct the dimension spacing.
■ On the Dimensions panel, click Dimspace.
■ Select the inner most dimension for the

base.
■ Click the remaining three dimensions from

bottom to top.
■ Press ENTER. Press ENTER again to accept

Auto spacing.
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  The dimensions are equally spaced.
   

 
 
5.

  To create an aligned dimension:
■ On the Dimensions panel, click Aligned.
■ Select point (1) as shown.
■ Select point (2).
■ Position the dimension as shown.
   

 

 
6.

  To create a radial dimension:
■ On the Dimensions panel, click Radius.
■ Select the arc indicated and position the

dimension as shown.
   

 
 
7.

  To create a jogged dimension:
■ On the Dimensions panel, click Jogged.
■ Select the arc at point (1).
■ Specify the center location override at

point (2).
■ Specify the dimension line location at point

(3).
■ Specify the jog location at point (4).
   

 
 
8.

  To create a diameter dimension:
■ On the Dimensions panel, click Diameter.
■ Select the circle indicated (1) and position

the dimension as shown (2).
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9.

  To create an angular dimension:
■ On the Dimensions panel, click Angular.
■ Select the line at point (1).
■ Select the line at point (2).
■ Position the dimension as shown.
   

 
 
10.

  To create a linear dimension:
■ On the Dimensions panel, click Linear.
■ Select point (1).
■ Select point (2).
■ Position the dimension as shown.
   

 

 
11.

  To create continuous dimensions on the left
side:
■ On the Dimensions panel, click Continue.
■ The last dimension created is automatically

used as the continue dimension.
■ Select point (1), point (2), and point (3) in

order.
■ Press ENTER to finish continuous

dimensioning.
■ Press ENTER to exit dimensioning.
   

 
 
12.

  To create a linear dimension:
■ On the Dimensions panel, click Linear.
■ Select point (1).
■ Select point (2).
■ Position the dimension as shown.
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13.

  To create baseline dimensions:
■ On the Dimension toolbar, click Baseline.
■ The last dimension created is automatically

used as the base dimension.
■ Select point (1), point (2), point (3), and

point (4) in order.
■ Press ENTER to complete the baseline

command.
■ Press ENTER to complete the dimension

command.
   

 

 
14.

  To clean up the overlapping extension lines:
■ On the Dimensions panel, click Dimbreak.
■ Right-click. Click Multiple.
■ Select the left end extension line 1 and 2 as

shown.
■ Right-click. Click Break.
 The selected extension lines break whenever
they cross another extension line.
   

 
 
15.

  Zoom to the drawing extents.
 
16.

  Close all files without saving.
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Lesson: Using Dimension Styles
 

  
This lesson explains dimension styles, how to create and formatdimension styles,and how you can use
them to manage dimensions.  
You use dimension styles to manage dimensions in much the same way you use text styles to maintain
uniformity in your drawing annotations. Dimension styles organize your dimensions.   
In the following illustration, two dimensions are placed, each using a different dimension style. Note
the difference in the arrowheads and the display of units.

  

 
Objectives

  
After completing this lesson, you will be able to:

■ Describe dimension styles and how they are used.
■ Create and modify dimension styles to control the appearance of dimensions.
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About Dimension Styles
   

Dimension styles control dimension appearance. Each dimension object contains a number of features,
such as extension lines, arrows or symbols, text, and tolerances. Dimension styles control whether
these features appear, and if they do, what they look like. For example, the dimension style might
specify what type of arrowhead to use or what color the dimension lines or text should be.   
The following image illustrates some of the dimension features you can control with dimension styles.

  

 
Definition of Dimension Styles

  
A dimension style is a group of dimension settings or variables that control how dimensions appear.
You name this group of variables and then assign it to specific dimensions, which simplifies the
determination of how dimensions look in the drawing. You can use more than one dimension style in a
drawing.

 
Annotative Property

  
You assign the Annotative property to a Dimension Style when you want dimension features in
objects created with that style to be displayed with the same plotted size in multiple viewports with
differentviewport scales. To make a dimensionstyle annotative, you select the Annotative optionon the
Fit tab in the New Dimension Style or the Modify Dimension Style dialog boxes.     
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Dimension Style Facts
■ Every drawing must contain at least one dimension style, but you can create multiple dimension

styles.
■ Every new imperial unit drawing contains a dimension style called Standard and another called

Annotative. Standard is set as the current dimension style.
■ Every new metric unit drawing contains a dimension style called ISO-25 and another called

Annotative. ISO-25 is set as the current dimension style.
 

Example of Dimension Styles
  

The dimension style controls the type and size of the arrow, the placement and size of the dimension
text, the offset of the extension line from the part, and many other variables as shown in the following
image.  

 

Creating and Modifying Dimension Styles
   

You use the Dimension Style command to create and manage dimension styles. Each drawing can
have multiple dimension styles, but only one dimension style can be current at a time.

 
As you create dimensions in the drawing, they are assigned the current dimension style and inherit
its properties. Use the dimension style list on the Dimensions panel to quickly switch the current
dimension style. 
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Command Access
    

 

  
Dimension Style
   

 
    Command Line: DIMSTYLE
    Ribbon: Annotate tab > Dimensions panel > Dimension Style

   

 
    Menu Bar: Format > Dimension Style

   
 

Dimension Style Manager
   

The Dimension Style Manager displays all dimension styles available in the drawing. Use the options
in the Dimension Style Manager to create a New dimension style, Modify an existing style, Override a
style, Compare styles or set a style Current.
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Create New Dimension Style Dialog Box
   

In the Dimension Style Manager, select New (1) to access the Create a New Dimension Style Dialog
box. Enter a new style name (2) based on an existing dimension style that you choose from the list (3).
A new dimension style is typically used for all dimensions (4), or you can create a substyle that applies
to a specific dimension type (5). Check Annotative (6) to make the dimensions appear in a consistent
size when you have multiple viewports in the drawing layout.

 
Note: Select Modify from the Dimension Style Manager to access the same dimension style options
that could be assigned to any new dimension style.
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New Dimension Style Dialog Box - Lines Tab
   

Use the Lines tab to adjust properties for the dimension and extension lines. The preview window
will display the effect of your changes. These dimension line settings are based on common drafting
standards and typically are not changed.
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New Dimension Style Dialog Box - Symbols and Arrows Tab
   

Use the Symbols and Arrows tab to adjust the arrowheads, center mark features, dimension break
size, the location of the arc length symbol, the radius jog angle, and linear jog dimension height.
Typically the most common feature to change in this tab is the arrowheads for the first and second
extension lines, such as changing them from closed filled to oblique.
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New Dimension Style Dialog Box - Text Tab
   

Use the Text tab to adjust text appearance, text placement, and text alignment options. The most
typical changes made in this tab are to specify a text style, to specify the text alignment such as align
with dimension line, and to change text placement for vertical and horizontal dimensions.
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New Dimension Style Dialog Box - Fit Tab
   

Use the Fit tab to specify an overall scale for the dimension features. If the Annotative dimension style
was selected, this area will be grayed out. Other options you can change are the Fit option for text and
arrows, text placement for dimension, and fine tuning features such as whether to draw dimension
lines between extension lines or not.
 

 
Scale for Dimension Features

  
When not using Annotative, you control dimension feature scale by clicking the Use Overall Scale Of
option and entering a value. The value entered here is stored as the DIMSCALE system variable. You
could also change this value by entering DIMSCALE on the command line.

 
A simple way to remember how to set DIMSCALE is that it should always be equal to the plot
scale factor of your drawing. When the drawing is scaled to fit on a sheet of paper, the dimensions
must undergo the same scaling. Setting DIMSCALE equal to your plot scale factor ensures that the
dimension features start out at the correct size before they are scaled with the rest of the drawing
prior to being plotted or placed on a layout.

 
For example, for metric units, if your final plot scale is 1:40, set DIMSCALE to 40. For imperial units,
if your final plot scale is 1/4"=1', set DIMSCALE to 48 (12 / .25 = 48). DIMSCALE will multiply the
dimension values by the overall scale, but does not change those values.
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New Dimension Style Dialog Box - Primary Units Tab
   

Use the Primary Units tab to set options for the primary units displayed on the dimensions. You can set
the unit format for linear and angular dimensions, adjust the precision settings, use zero suppression
for the beginning and end of dimensions, and adjust the measurement scale factor for dimensioning
geometry that was not drawn at full scale. The primary units are always displayed and they reflect the
current drawing units setting.
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New Dimension Style Dialog Box - Alternate Units Tab
   

Alternate units are used when you need to show two measurement units, metric and imperial.
 

Use the Alternate Units tab to display and format alternate units on your dimensions. Select the
Display Alternate Units option to turn on alternate units. The remaining options are only available
after you select this option. You can adjust the unit format, precision, zero suppression, and
placement. The multiplier for alternate units is preset to convert from millimeters to inches in a metric
unit drawing or inches to millimeters in an imperial unit drawing.

 
By default, the Display alternate units option is turned off in the Standard and ISO-25 dimension
styles.
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New Dimension Style Dialog Box - Tolerances Tab
   

Use the Tolerances tab to add tolerances to your dimensions. By adding tolerances to your dimensions,
you are setting a valid range in which the as-built measurement of the feature must be maintained in
order to ensure functionality.

 
You can select a method, set the tolerance precision, choose upper and lower values, scale the
tolerance text height, set the vertical position, and control zero suppression. If you are including
alternate units in your dimensions, set the alternate unit tolerance precision value and zero
suppression options here.

  

 
 

Procedure: Creating and Modifying Dimension Styles
   

The following steps give an overview of creating and modifying dimension styles.
  

1.
  Start the Dimension Style command.

 
2.

  In the Dimension Style Manager, click New or Modify.
 
3.

  For a new dimension style, enter a name and click Continue. If you are modifying an existing dimension
style, proceed to the next step.

 
4.

  Select the appropriate tabs in the Modify Dimension Style dialog box, depending on the features you
need to adjust. Select dimension style options as required. Click OK.

 
5.

  In the Dimension Style Manager, click Close.
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Key Points
■ Dimension styles control the appearance of dimension features.
■ Dimension style options are based on general drafting standards.
■ Only one dimension style can be current at a time.
■ If you modify a dimension style, all dimensions using that style in the drawing update

automatically.
■ To set a dimension style current or to rename or delete a dimension style, select the name in the

Dimension Style Manager and right-click to access these options.
■ You cannot delete a dimension style if it is current or if it is being referenced in the drawing.
■ The quickest way to make a new dimension style current is to select it from the list in the

Dimensions panel.
■ A blank drawing based on the ACAD drawing template will contain a Standard style and an

Annotative style.
■ The Annotative dimension style will display dimensions that are equal in size regardless of the

viewport scale in the drawing Layout.
■ For non-annotative dimensions, you must set the dimension scale equal to your plot scale.
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Exercise: Modify a Dimension Style
   
In this exercise, you modify the existing dimension style to allow the dimensions to appear correctly on the
sheet. You also change the dimension style to display architectural ticks instead of arrows, and alternate units.  

  
The completed exercise

Completing the Exercise
To complete the exercise, follow the
steps in this book or in the onscreen
exercise. In the onscreen list of
chapters and exercises, click Chapter 8:
Dimensioning. Click Exercise: Modify a
Dimension Style.

   
1.

  Open M_Dimension-Styles.dwg. Note: The red lines around the floor plan
indicate objects that are actually dimensions,
but the annotative scale is not currently set
for the dimension text or other features to be
visible.
   

 
 
2.

  Click the Paper button on the status bar to
change the display to Model space.
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3.

  To modify the current dimension style's
arrowhead:
■ Select the Annotate tab on the ribbon. On

the Dimensions panel, click Dimension
Style. The current dimension style is
ISO-25.

■ In the Dimension Style Manager, click
Modify.

■ In the Modify Dimension Style dialog
box, Symbols and Arrows tab, under
Arrowheads, select Architectural Tick from
the First list.

 Note: the Second arrowhead will automatically
default to the same selection.
   

 
 
4.

  To modify the current dimension style's text
style setting:
■ Click the Text tab.
■ In the Text style list, select TECH.
 Note: The text height for the dimensions is set
to 2.5.
   

 
 
5.

  To modify the dimension style to be
annotative:
■ Click the Fit tab.
■ Under Scale for Dimension Features, click

Annotative.
■ Click OK.
   

 
 
6.

  In the Dimension Style Manager, click Close.
Note that no changes in the drawing are
visible.

 
7.

  To set the model space annotation scale:
■ On the status bar, Annotation Scale list,

click 1:50.
   

 
 
8.

  To update the dimensions with the new
annotation scale:
■ On the Dimensions panel, click Dimension

Update.
■ Enter ALL.
■ Press ENTER to complete the selection.
■ Press ENTER.
 Notice the effect that changing the annotation
scale has on the dimensions in the drawing.

 
9.

  To change the dimension style to display
alternate units:
■ On the Dimensions panel, click Dimension

Style.
■ In the Dimension Style Manager, click

Modify.
■ In the Modify Dimension Style dialog box,

Alternate Units tab, click Display Alternate
Units.

■ In the Unit Format list, select Architectural
Stacked.
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10.

  Under Placement, select Below Primary Value.
Click OK.
   

 
 
11.

  In the Dimension Style Manager, click Close to
exit the dialog box.

 
12.

  To update the layout annotative scale:
■ Click the layout tab to return to the

drawing layout.
■ Click to select the viewport border.
   

 
■ On the status bar, Annotation Scale list,

click 1:50.
 Note: You may need to click another scale then
click 1:50 to get the viewport scale to reset.
■ On the status bar, VP Scale, click to lock the

viewport.
   

  The dimensions now appear at the correct
size in relation to the size of the sheet and the
viewport. Note: The dimension update may take several
seconds to appear.
   

 
 
13.

  Zoom to the drawing extents.
 
14.

  Close all files without saving.
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Lesson: Using Multileaders
 

  
This lesson describes multileaders, multileader styles, and the options available for placing
multileaders in the drawing.  
You use multileader objects for leader-based annotation. Leaders are important because they
enable you to connect features on the geometry to notes, balloon callouts, or other objects. Using
multileaders as leader objects provides greater flexibility and control than standard leader objects.   
The following illustration shows multileader objects used for balloon callouts.

  

 
Objectives

  
After completing this lesson, you will be able to:

■ Describe multileaders.
■ Describe multileader styles.
■ Create and edit multileaders.
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About Multileaders
   

Using multileaders, you can create associative leader-based annotation objects that behave
intelligently as a single object. Similar to associative dimensions, multileaders are treated as single
objects with specific object properties.

 
In the addition to this associativity, multileaders have additional options for placing, editing, and
managing leader-based annotation objects.  

 
Definition of a Multileader

  
A leader is an annotation that includes an arrow, a leader line, a landing, and some form of text
or other object. A multileader is a style-based associative leader object that combines several
different common elements such as lines and text into a single associative object. When you select a
multileader object, grips are displayed at several points on the object. You can edit any of these points;
you select the grip and move it to a different location.

 
If you double-click a multileader, the Properties palette is displayed showing properties specific to the
multileader object. The initial property settings originate from the current multileader style, but can be
overridden just like properties on other objects.  
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  Selected multileader object

   

 

  Multileader grips

   

 

  Multileader object type identified in the Properties palette

   

 

  Properties specific to multileader objects

   

 

  Properties specific to multileader objects
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Example of Multileaders
   

In the following illustration, two multileader objects are used to identify six different areas on the
drawing. Because the objects are style based and associative, if you need to make changes, you can do
so easily.

  

  
If standard leader objects were used in the drawing above, a change, such as print scale, would require
that you redraw all of the leaders and change the text height for each text note.

 

About Multileader Styles
   

Multileader objects are style-based, which means that the properties for the individual elements
originate from the current multileader style.
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In the following illustration, a typical multileader object is shown. While there are several properties
associated with a multileader, they can be organized into three main categories.

  

      

 

  The Leader Format properties enable you to specify arrowhead type and size, as well as the leader
type, straight or spline.

   

 

  The Leader Structure properties enable you to specify constraints on the leader line such as segment
angles, landing settings, and the overall leader scale or annotative property.

   

 

  The Content properties enable you to specify the type of content that will be attached to the leader.

   
 

Command Access
    

 

  
Multileader Style
   

 
    Command Line: MLEADERSTYLE
    Ribbon: Annotate tab > Leaders panel > Multileader Style Manager

   

 
    Menu Bar: Format > Multileader Style

   
 

Multileader Style Manager
   

You use the Multileader Style Manager to manage and edit multileader styles. The dialog box and
options work almost identically to the Dimension Style Manager. You use this dialog box to create,
edit, delete, and set current multileader styles.
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Modify Multileader Style
   

You use the Modify Multileader Style dialog box to edit the properties associated with the multileader
style. Style properties are organized on three tabs with each tab containing specific types of
properties. As soon as you exit the Multileader Style Manager, changes you made to an existing style
are reflected automatically on any multileaders that are using the style.
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Multileader Content Types
   

You can specify three different content types for multileader objects. On the Content tab of the Modify
Multileader Style dialog box, you can select from the following:

    

 

   

 

   

 
  Block

  Mtext
  None

  Several default blocks are
available such as circle,
slot, and triangle. The
default block options
contain attributes. You
can also specify your own
block. You are prompted
for values when you create
the multileader.

  This is the default
multileader type and
consists of mtext objects.

  This multileader object contains a leader only.

  

 

Using Multileaders
   

Using multileaders involves several tasks. These include creating and managing multileader styles,
placing multileaders, adding leaders, and aligning and collecting multileaders.

 
With the exception of creating and managing multileader styles, which should generally be done first,
there is no prescribed order for creating and editing multileaders or for using any of the multileader
tools.  
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Multileaders Ribbon Panel
   

You use the Multileaders panel to access tools specific to creating and editing multileaders. The
panel contains the standard buttons for accessing commands as well as a multileader style list that
you use to set the active multileader style. You can also use the list to change the style of a selected
multileader object.

  

    
The following commands are found on the Leader panel in the Annotate tab.

 
  
Icon

  
Command

  
Description

    

 

  Multileader
  Creates a single multileader object.

    

 

  Add Leader
  Adds leader lines to existing multileader objects.

    

 

  Remove
Leader

  Removes leader lines from existing multileader objects.

    

 

  Align
Multileaders

  Aligns multileaders horizontally or vertically in the drawing.

    

 

  Collect
Multileaders

  Collects multiple multileaders and combines them into a single multileader
object with multiple content elements.
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Process: Using Multileaders
   

The following steps describe the overall process for using multileaders.
  

1.
  Determine the multileader
style you want to use: Depending on your needs,
you may need to create a
new style or edit an existing
one. The product provides
two default styles. You can
use them as is, modify them,
or create new ones.

    

 
 
2.

  Use the Mleader command
to create multileaders.

   

 
 
3.

  Use the Add Leader or
Remove Leader tools to
modify existing multileaders.

   

 
 
4.

  Use the Align Multileaders
and Collect Multileader
tools to further modify the
appearance of multileaders
on the drawing.
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Guidelines
■ Use Annotative scaling or the Annotativestylefor your multileader. This makes the multileaders in

drawings that have multiple views the same size.
■ You do not need a style for small or individual changes to a multileader. You can use the Properties

palette to change individual properties for selected multileader objects.
■ After you have placed a multileader, you can adjust its location using grips.

 

Using Dimension Break
 You can use the Dimbreak command to break multileader objects at intersections of

objects or dimensions in the drawing.



158          ■         Chapter 8: Dimensioning

 

Exercise: Use Multileaders
   
In this exercise, you create a multileader style to add callouts to an exploded view drawing. You then add
multileaders to the drawing using different options associated with multileaders.  

  
The completed exercise

Completing the Exercise
To complete the exercise, follow the
steps in this book or in the onscreen
exercise. In the onscreen list of
chapters and exercises, click Chapter
8: Dimensioning. Click Exercise: Use
Multileaders.

   
1.

  Open c_Front-Pump-Assembly.dwg.
      

2.
  To create a new multileader style:
■ On the Leaders panel, click the Multileader

Style Manager dialog box launcher.
■ In the Multileader Style Manager dialog

box, click New.
■ In the Create New Multileader Style

dialog box, New Style Name, enter
Balloon_Callout. Click Continue.
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3.

  To assign the Content type:
■ Click the Content tab.
■ In Multileader Type, select Block from the

list.
■ Under Block Options, select Circle from the

list. Click OK.
   

 
 
4.

  In the Multileader Style Manager, verify that
Balloon_Callout is the current multileader
style. Click Close.
   

 
 
5.

  Check the Object Snap Settings to ensure that
Endpoint, Midpoint, and Intersection snap
modes are selected.

 
6.

  To place a Multileader:
■ On the Leaders panel, click Multileader.
■ Using Object Snap, select the Midpoint of

the top line of the keyway (1).
■ Move the cursor above the pulley and click

a location (2).
■ Notice the command line. An attribute has

been assigned to this block.
Enter 1 (3).
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7.

  Using the same steps, place a multileader for
the pulley and seal as shown. Enter 2 for the
pulley and 3 for the seal.
   

 
 
8.

  To align multileaders:
■ On the Leaders panel, click Align.
■ Use a crossing window to select all three

multileaders. Press ENTER.
■ Right-click to access the shortcut menu.

Click Options. Click Distribute.
■ Select a point on the highest multileader

(1).
■ Move the cursor horizontally with Polar

Tracking, indicating that the motion is
straight (2). Try not to select an object snap
because this may override the horizontal
direction.

   

 
■ Click to align the multileaders.
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9.

  Place a multileader on the bearing as shown.
Enter 5.
   

 
 
10.

  To add a multileader to an existing multileader:
■ On the Leaders panel, click Add Leader.
■ Select the number 5 multileader.
■ For the second leader arrowhead location,

select the bearing at the other end of the
shaft. Press ENTER.

   

 

 
11.

  Add multileaders 4, 8, and 9 to the front pump
housing.
   

 
 
12.

  To collect multileaders:
■ On the Leaders panel, click Collect.
■ Individually select multileaders 4, 8, and 9

in order. Press ENTER.
■ Verify in the Command line that Horizontal

is the current option. If not, right-click and
select it from the shortcut menu.

■ Click to place the collected multileaders.
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13.

  To add a multileader specifying content first:
■ On the ribbon, Leaders panel, click

Multileader.
■ Right-click. Click Options.
■ Select Content type.
■ Click a location below the number 5

callout. Enter 6.
■ Locate the arrowhead of the multileader to

the shaft.
   

 
 
14.

  To add a multileader specifying the landing
first:
■ On the Leaders panel, click Multileader.

Enter L. Press ENTER.
 Note: You can right-click in the Command line
or enter the capitalized letter of the command
options.
■ Click a point to the left of the rear housing

to locate the callout.
■ Click the rear housing to locate the

arrowhead. Enter 7.
   

 
 
15.

  Using the options of your choice, add a
multileader to the last part in the exploded
view. Enter 3.
   

 
 
16.

  Close all files without saving.
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Lesson: Editing Dimensions
 

 

 

This lesson describes how to edit dimensions, but mainly how to edit dimension text. There are
a variety of ways to edit dimensions depending on what kind of editing you need to do. You can
reposition dimensions using grips. You can edit dimension features that override the dimension style,
you change dimensions from one style to another, and you can edit the dimension text.  
Inevitably, once you place dimensions in the drawing, you will need to edit them either by
repositioning or adding additional information to the dimension.   
In the following illustration, a string of continuous dimensions is being moved to a new position using
grips.

  

 
Objectives

  
After completing this lesson, you will be able to:

■ Edit dimensions using grips and the Dimedit and Dimtedit commands.
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Editing Dimensions
   

You can use the Dimedit command to edit or override the dimension text measurement. You can
use the Dimtedit command to edit the position of the dimension text. You can also right-click a
selected dimension to access the Quick Properties or the Properties palette where you can edit any
of the dimension style features for the selected dimension. Any global changes that you make to the
dimension style do not affect the changes that you have made to the individual dimensions unless you
change the selected dimension from one dimension style to another. 

 
 

 
In addition to editing the dimension style features from the Properties palette, you can also edit
dimension text. 

 
 

 
Note: The arrows (<>) keep the original text measurement that is associated to the object
dimensioned. 

 

Command Access
    

 

  
Dimension Edit - Edit Text

    Command Line: DDEDIT
    Pointing Device: Double-click a text object.       

Dimension Edit - Justify Text
    Command Line: DIMTEDIT
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Dimension Edit - Justify Text
Ribbon: Annotate tab > extended Dimensions panel > Text Angle (1), Left Justify (2), Center Justify
(3), Right Justify (4)
   

 
        

Dimension Edit - Oblique Angle
    Command Line: DIMEDIT

Home, New, and Rotate are also DIMEDIT options when entered at the command line.Note: Home,
New, and Rotate are also DIMEDIT options when entered at the command line.

    Ribbon: Annotate tab > extended Dimensions panel > Oblique
   

 
   

 The quickest way to edit the dimension text measurement is with the DDEDIT
command. When you type over the text it will override the associative feature of
the dimension text measurement. If you type <> before of after the associative
dimension text, the associative measurement continues to be displayed.

 
 

Procedure: Adding Text to a Dimension with DDEDIT
   

The following steps give an overview of how to add text to a dimension using the Dimedit command.
  

1.
  On the command line, enter ddedit to start the DDEDIT command.

 
2.

  Select the dimension text to Edit.
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3.

  The In-Place Text Editor appears. The highlighted number represents the true dimension value
associated with the part being dimensioned. Click after the associative dimension (1) and type any
additional notations (2).
   

 
 
4.

  Click outside the Text Editor to Exit.
   

 
   
 

Procedure: Justifying Dimension Text with DIMTEDIT
   

The following steps give an overview of how to justify text on a dimension using the Dimtedit
command.

  
1.

  Click Annotate tab > Dimension panel > Dimensions drop-down > Left Justify(1).
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2.

  Select a dimension (2).
   

 
 
3.

  The text is justified (3).
   

 
   
 

Procedure: Creating an Oblique Dimension Angle with DIMEDIT
   

The following steps give an overview of how to give a dimension an oblique angle with theDimedit
command.

  
1.

  On the ribbon, click Annotate tab > Dimensions panel > Dimensions drop-down > Oblique (1).
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2.

  Select a dimension (2). Press ENTER.
   

 
 
3.

  Enter an oblique angle (i.e. 80).
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Exercise: Edit Dimensions
   
In this exercise, you edit dimensions by adjusting
their placement, adding text to the default dimension
value, and creating a new dimension substyle for
diameter dimensions.  

  
The completed exercise

Completing the Exercise
To complete the exercise, follow the
steps in this book or in the onscreen
exercise. In the onscreen list of
chapters and exercises, click Chapter
8: Dimensioning. Click Exercise: Edit
Dimensions.

   
1.

  Open M_Edit-Dimensions.dwg.

 
2.

  To use grip editing to move a string of
dimensions:
■ Select the string of continuous dimensions

in the left view of the drawing.
■ Press SHIFT+select on the five grips

indicated (1), (2), (3), (4), and (5). They turn
red.

■ Click one of the selected grips (6) and drag
the dimensions to the left.

■ Press ESC to clear the selection.
   

 
 
3.

  To move dimension text to a new location with
the right justify Dimtedit command:
■ On the command line, enter dimtedit.

Press ENTER.
■ Select the 29mm linear dimension

indicated (1).
■ Right-click anywhere in the drawing. For

justification, select Right.
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■ Repeat the previous step on the 35 mm

linear dimension.
■ The dimensions should appear as shown.
   

 
 
4.

  To relocate dimension text with grips:
■ Select the jogged radial dimension.
■ Select the grip (1) and drag it to a new

location as shown (2).
■ Press ESC to clear the selection.
   

 
 
5.

  To flip the arrow of a dimension:
■ Select the radial dimension on the upper

left corner of the part.
■ Right-click anywhere in the drawing. Click

Flip Arrow.
   

 
■ The arrow should now be on the inside of

the radius.

 
6.

  Locate and view the diameter dimension in the
lower left corner of the part.
   

 
 
7.

  To create a diameter dimension substyle:
■ On the Annotate tab, click Dimensions

panel > Dimension, Dimension Style.
   

 
■ In the Dimension Style Manager, click New.
■ In the Create New Dimension Style dialog

box, select Diameter Dimensions from the
Use For list.

   

 
■ Click Continue.
 This creates a dimension substyle of ISO-25 in
which modifications only apply to the diameter
dimensions.



Lesson: Editing Dimensions       ■       171

 
8.

  To set the text alignment for the substyle:
■ In the New Dimension Style dialog box,

Text tab, under Text Alignment, select ISO
Standard.

   

 
■ Click OK.
 The new dimension substyle appears under the
ISO-25 dimension style.

 
9.

  Click Close to exit the Dimension Style
Manager. The dimension value is now
horizontal as a result of the new dimension
substyle.
   

 
 
10.

  Close all files. Do not save.
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Challenge Exercise: Architectural
 

  
In this exercise, you use what you learned about dimensioning to create a dimension style and add
dimensions to your floor plan.

 

 You have the option of completing this exercise using either imperial or metric units.
Select one version of the exercise to complete the steps.

  

  
The completed exercise

Completing the Exercise
To complete the exercise, follow the steps in this book or in the onscreen exercise.
In the onscreen list of chapters and exercises, click Chapter 8: Dimensioning. Click
Challenge Exercise: Architectural Metric.

 
 

Metric Units
  

1.
  Open the drawing you saved from the previous challenge exercise, or open M_ARCH-Challenge-
CHP08.dwg.

 
2.

  Set layer Dimension current.
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3.

  Create a new dimension style called Architecture with the following settings:
■ Arrowheads = Architectural tick
■ Arrow size = 3
■ Text Style = Labels
■ Text height = 3
■ Text Alignment = Horizontal
■ Overall Dimension Scale = 60
■ Primary Unit Precision = 0

 
4.

  Add dimensions to the floor plan on the appropriate layer to show the lengths of the walls and their
position relative to each other as shown. Create additional dimensions as desired to meet your specific
requirements.
   

 
 
5.

  Save and close the drawing.
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Imperial Units
  

1.
  Open the drawing you saved from the previous challenge exercise, or open I_ARCH-Challenge-
CHP08.dwg.

 
2.

  Set layer Dimension current.
 
3.

  Create a new dimension style called Architecture with the following settings:
■ Arrowheads = Architectural tick
■ Text Style = Labels
■ Text height = 1/8 (.125)
■ Text Alignment = Horizontal
■ Overall dimension scale = 38.4
■ Unit format = Architectural
■ Primary Unit Precision = 0'-0"

 
4.

  Add dimensions to the floor plan on the appropriate layer to show the lengths of the walls and their
position relative to each other as shown. Create additional dimensions as desired to meet your specific
requirements.
   

 
 
5.

  Save and close the drawing.
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Challenge Exercise: Mechanical
 

  
In this exercise, you use what you learned about dimensioning to add dimensions to the drawing.  

  
The completed exercise

Completing the Exercise
To complete the exercise, follow the steps in this book or in the onscreen exercise.
In the onscreen list of chapters and exercises, click Chapter 8: Dimensioning. Click
Challenge Exercise: Mechanical.

   
1.

  Open the drawing you saved from the previous challenge exercise, or open M_MECH-Challenge-
CHP08.dwg.

 
2.

  Make the Dimension layer current.
 
3.

  Create a new dimension style called Mech-2 with the following settings:
■ Arrow size = 2
■ Center Marks = None
■ Text Style = Labels
■ Text height = 2
■ Overall dimension scale = 2
■ Primary Unit Precision = 0.0
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4.

  To create two dimension substyles for Diameter and Radial dimensions, set the Text Alignment for
these substyles to ISO Standard.
   

 
 
5.

  Place dimensions on the part views as shown in the following images.
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6.

  More views.
   

    

    

 
 
7.

  Save and close all files.
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Chapter Summary
 

 

 

Dimensions are vital annotations used on most drawings to convey important design size and position
specifications. You can create a variety of dimension types. You control dimension placement and
appearance using dimension styles. Once placed, you can edit dimensions by using grips to move
the dimensions or text to new locations or by double-clicking the dimensions and modifying their
properties in the Properties palette. You can also use the Dimedit, Dimtedit, and Ddedit commands to
modify dimensions and dimension text.  
Having completed this chapter, you can:

■ Create dimensions.
■ Use dimension styles to manage dimensions.
■ Create and edit multileader styles and multileaders.
■ Use different commands and methods to edit dimensions.
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Chapter

9

Hatching Objects
 
  

You can use hatch patterns and gradient fills on the drawing to bring focus or call attention to certain
areas. Once you have created hatch patterns and fills, you can edit them using similar methods.

 
Objectives

  
After completing this chapter, you will be able to:

■ Create hatch and gradient fill patterns on objects in the drawing.
■ Edit hatch and gradient fills that have been placed in the drawing.
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Lesson: Hatching Objects
 

  
This lesson describes how to hatch and fill objects in your drawing using the Hatch and Gradient
commands. In the following illustration, the roof has a roof tile hatch pattern and the walls a brick
pattern. The background is composed of two gradient fills.  
Hatching is used across all design disciplines to enhance drawing views, to clarify design features, and
to show areas that were modified in drawings when you communicate with your clients. For example,
you can add hatching when you draft roof or floor tiles or create section views of manufactured parts.
You can also use hatching in construction, steelwork, or road design.  

 

 
Warning!
 

 Gradient Fills cannot be created with AutoCAD LT®.

  
Objectives

  
After completing this lesson, you will be able to:

■ Describe the characteristics of hatch and fill patterns.
■ Describe the characteristics of associative hatch patterns.
■ Create hatch patterns and fills.
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Introduction to Hatch Patterns and Gradient Fills
   

You may want to add patterns that represent materials, special regions, or textures to your drawing to
help communicate your ideas. Applying hatch patterns to areas of your drawing can quickly augment
their appearance and help to convey design intent. You can use the provided solids, gradients, and
predefined hatch patterns or define your own.  

 
Definition of Hatch and Fill Boundaries

  
Hatch patterns are graphical elements that are often used to represent materials, special regions, or
textures in a drawing. In addition to using a pattern to define an area, you can use gradient or solid fill.   
In the following image, the Hatch command was used to create hatch patterns and gradients on
several areas of the elevation. The highlighted edges around the bricks illustrate the boundaries that
were used to create the pattern. A boundary for a hatch or fill is any combination of selected objects,
such as lines, polylines, circles, and arcs, that create an enclosed area.
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Hatch Boundaries
   

When you click an area within a drawing to hatch, the boundaries in the drawing are automatically
evaluated to determine how to place the hatch based on the specifications you set in the Hatch and
Gradient dialog box.

 
When a hatch boundary cannot be determined, it may be because the specified internal point is not
within a fully enclosed area. Red circles are displayed around unconnected endpoints of the boundary
to identify any gaps in the hatch boundary.
 

  
The red circles remain displayed even after you exit the Hatch command. They are removed when
you select another internal point for the hatch or when you use the Redraw, Regen, or Regenall
commands.

 
Example of Hatch and Fill Patterns

  
Using hatch patterns and fills is like coloring in an area, but with more sophistication. For instance, you
might select blue to color an ocean. This color alone represents water, but with hatch and fill, you can
go beyond color and add patterns and textures, such as waves or ripples.

 
The following illustration shows that in addition to a brick color on the building front, a hatch has also
been applied to better represent how brick would appear in real life.  
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Key Points for Hatch and Gradient Fill

  
Consider the following when using hatch and gradient fills:

 
■ Hatch patterns are graphic elements that are often used to represent materials, special regions, or

textures in a drawing.
■ You can use the provided solids, gradients, and predefined hatch patterns, or define your own.
■ Boundaries define which area of your drawing can be hatched or filled.
■ A boundary for a hatch or fill is any combination of selected objects, such as lines, polylines, circles,

and arcs, that create an enclosed area.

 

Associative Hatch Patterns
   

By default, hatch patterns are associated with the space they fill, which means that when the hatched
object is edited, the hatch adjusts to the new shape. This feature eliminates the rework of recreating
the hatch every time you edit a hatched object or area within your drawing.

 
Removing Associativity

  
You can elect not to associate a hatch with the object or area. To do this, clear the Associative option
under Options in the Hatch and Gradient dialog box.  

 
Nonassociative Hatch Patterns

  
Hatches made using the Gap Tolerance feature are nonassociative. This means that after you modify
the unclosed area containing the hatch, you will need to rehatch it.

 
When you use the Gap Tolerance feature, all subsequent hatches are also nonassociative. To make
hatches associative again, select Associative in the Hatch and Gradient dialog box under Options.



184          ■         Chapter 9: Hatching Objects

 
Example of an Associative Hatch Pattern

  
Suppose you need to alter the opening in a brick fireplace. If your hatch is associative, the brick
pattern adjusts to the new space. If your hatch is not associative, it does not adjust and you need to
delete it and rehatch the area.

 
Associative Hatch Key Points

  
Consider the following points when using hatches:

 
■ By default, hatch patterns are associated with the space they fill, which means that when the

hatched object is edited, the hatch adjusts to the new shape.
■ Hatches made using the Gap Tolerance feature are nonassociative. This means that after you

modify the unclosed area containing the hatch, you will need to rehatch it.
■ When you use the Gap Tolerance feature, all subsequent hatches are also nonassociative. To make

hatches associative again, select Associative in the Hatch and Gradient dialog box under Options.

 

Creating Hatched Objects
   

With the Hatch command, you can fill selected areas of your drawing with patterns, colors, or
gradients. You fill these areas by defining boundaries based on points or objects in the drawing.

 
When you start the Hatch command, the Hatch and Gradient dialog box is displayed. Using this dialog
box, you select the type and pattern for the hatch, adjust the angle, scale, and hatch origin, and then
define the boundaries that will contain your hatch.

 
After adjusting the hatch properties and defining the hatch boundaries, you can use the Preview
button to preview the hatch pattern before you create it.

 
Note: Gradient fills are not supported by AutoCAD LT, so the Hatch and Gradient dialog box is just
called the Hatch dialog box in AutoCAD LT.   
In the following image, hatch and gradient objects are used to create a quarter-section view of the
part. The hatch patterns indicate the area sectioned while the gradient patterns are used to add color
to the drawing view.
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Command Access
    

 

  
Hatch
   

 
    Command Line: HATCH, H
    Ribbon: Home tab > Draw panel > Hatch

   

 
   
 

Hatch and Gradient Dialog Box: Hatch Tab
   

Click the arrow at the bottom-right of the Hatch and Gradient dialog boxes to access the advanced
hatching options.
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Type and Pattern
   

You use the Type and Pattern area of the Hatch and Gradient dialog box to select the hatch pattern.
You can select patterns from the Pattern list or click the browse button or Swatch area to open the
Hatch Pattern Palette dialog box. Using this dialog box, you can select patterns based on a visual
swatch.

  

 
 

Hatch Pattern Palette Dialog Box
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Angle and Scale
   

You use the Angle and Scale area to adjust the angle and scale of the pattern. When you enter an
angle, it is relative to the default angle of the hatch. For example, the ANSI 31 hatch pattern has a
default angle of 45 degrees built into the hatch definition. If you enter 45 degrees in the angle field, it
is added to the default angle and the pattern lines are drawn vertically at 90 degrees.

  

 
 

Hatch Origin
   

Some hatching situations may require that you adjust the hatch origin for better placement of the
hatch pattern. Using the Hatch Origin options, you can create a more realistic pattern by controlling
where the pattern begins.
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Command Access
    

 

  
Gradient
   

 
    Command Line: GRADIENT
    Ribbon: Home tab > extended Draw panel > Gradient

   

 
   
 

Hatch and Gradient Dialog Box: Gradient Tab
   

In the Hatch and Gradient dialog box, click the Gradient tab to create gradients in your drawing. You
can choose between a one color gradient with adjustments to mimic shading or tint and a two color
option in which you specify two colors for the gradient.

 
Select the gradient pattern from nine predefined choices.

 
In the Orientation area, you can choose to have the gradient centered within the boundary and adjust
the angle of the gradient.
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Hatch and Gradient - Boundaries and Advanced Options

  
The following interface options and descriptions apply to both hatches and gradients. 

 
Boundaries

   
Every hatch or gradient you create is based on a boundary you define. Use the options in this area
of the dialog box to create boundaries by selecting points inside a boundary or objects that define a
boundary.
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Options
   

When the Associative option is selected, the resulting hatch is associative with the boundary. When
you are creating hatch patterns in multiple boundaries at once, you can use the Create Separate
Hatches option to create a separate hatch for each boundary defined. Using this option, you can
change any of the resulting hatch patterns independently of the others.

 
Use the Draw Order list to adjust the draw order of the hatch pattern. The draw order determines the
pattern or gradient's position behind or in front of other objects. Use this option to create multiple
pattern fills that include both a hatch and a solid fill or a hatch and a gradient.

  

 
 

Inherit Properties
   

When you edit drawings that already contain hatch patterns, use this option to retrieve the properties
of an existing hatch pattern. Using this feature, you can easily match the properties of other hatch
patterns or gradients.

  

 
 

Islands
   

Select Island Detection to detect boundaries that are inside the boundary you define. Choose
between Normal, Outer, or Ignore. This is extremely useful when hatching areas that contain text. The
text is treated as a boundary and, unless you choose the Ignore option, the pattern or gradient does
not overrun the text.
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Boundary Retention
   

If you select the Retain Boundaries option, a new object is created representing the defined boundary.
You can choose between a Region or Polyline object.

  

 
 

Boundary Set
   

Use this option to determine how the drawing is analyzed for boundaries. On large drawings, this can
speed up boundary analysis by limiting the objects that are considered.

  

 
 

Gap Tolerance
   

If the boundary has gaps, you can set the gap tolerance to allow any gap that is equal to or smaller
than the tolerance to be ignored.

 
Note: If a gap exists in the boundary, the hatch pattern will not be associative.

  

 
 

Inherit Options
   

If you use the Inherit Properties option to create the hatch, you can use the Inherit options to control
the location of the hatch origin.
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Procedure: Creating a Hatch Pattern
   

The following steps give an overview of creating a hatch or gradient in the drawing.
  

1.
  On the ribbon, click Home tab > Draw panel > Hatch.

 
2.

  Select the hatch pattern type and define its properties.
   

 
 
3.

  Click Add: Pick Points or Add: Select Objects and select points internal to a boundary or objects that
define a boundary.
   

 
 
4.

  Adjust other options as required in the Hatch and Gradient dialog box.
 
5.

  Click Preview to preview the hatch.
 
6.

  When the hatch is previewed, click anywhere in the drawing to return to the Hatch and Gradient dialog
box or right-click to accept the hatch pattern as it is previewed.

   

Layers for Hatch and Gradient
 It is good practice to create all of your hatches on one layer and all gradients on another.
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Hatch Guidelines

  
Consider the following guidelines when creating hatched objects:

 
■ All hatch and gradient patterns must fill a boundary. A boundary is an enclosed area that can

consist of lines, polylines, circles, and arcs.
■ The easiest way to specify a boundary is to zoom into the area you want to hatch and select a point

inside that area using the Add: Pick points Boundaries option.
■ You can delete the boundary without deleting the hatch or gradient fill.
■ Do not use a densely hatched pattern to create the effect of a solid fill. Instead use the Solid hatch

pattern provided by the software. The Solid hatch pattern is located at the top of the Pattern list.
■ Click the Expand button in the lower-right corner of the Hatch and Gradient dialog box to access

advanced options.
■ Most of the time you will want the Associative Option checked when creating a hatched object.
■ If you are placing the hatch or gradient fill within more than one boundary area, it will be treated

as a single hatch unless you choose Create separate Hatches located in the advanced options.
■ Scaling a hatch pattern is similar to scaling Text and Dimensions. It should be scaled proportionate

to the display scale of the object it is filling. For instance if the object will be displayed to plot at a
scale of & #188;” = 1”, then the hatch scale should be 48 (4 x 12).

■ Select the Annotative Option when there will be multiple views of the object at multiple scales in
the drawing layout. This will keep the hatch scale consistent in all the viewports.

■ If you enter an angle for the hatch, it is added to the angle already defined in the pattern.
■ Use the Hatch Origin options to fine tune hatch placement.
■ Use draw order to create multiple pattern fills containing both hatch patterns and gradients or

solid colors.
■ Create separate layers for hatch patterns in your drawing.
■ An exploded hatch pattern will result in thousands of separate objects and increase the size of your

drawing.
■ You can set the hatch pattern scale factor to a desired default scale that will appear in the dialog

box by typing HPSCALE at the command line and entering a new value.
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Practice Exercise: Create Hatched Objects  
In this practice exercise you create a drawing similar
to the one below and use the Hatch and Gradient
commands. 
 
 

   
1.

  Begin a blank drawing and create the
objects to hatch and gradient fill. Make two
overlapping rectangles and place a circle in
one of them.

 
2.

  To create a solid hatch pattern in a selected
object:
■ On the Home tab, click Draw panel >

Hatch.
■ In the Hatch and Gradient dialog box,

select ANSI31 from the Pattern list.
■ Select 0 from the Angle list.
■ Select 1.000 from the Scale list.
■ Under Boundaries, click Add: Select

Objects.
■ Click the overlapping rectangle as

indicated.
   

 
■ Right-click the selected object. Click

Preview.
■ Right-click to accept the hatch.
   

 
 
3.

  To create a gradient fill using two colors:
■ On the Home tab, click Draw panel >

Hatch.
■ In the Hatch and Gradient dialog box, click

the Gradient tab.
■ Under Color, click Two color.
■ Choose any of the gradient patterns.
■ Under Boundaries, click Add: Pick points.
■ Click inside the part of the other

overlapping rectangle as indicated below.
 The boundary is detected and highlighted.
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■ Right-click the selected object. Click

Preview.
■ Click inside the drawing window to return

to the dialog box.
■ Select another gradient pattern.
■ Click Preview.
■ Right-click to accept the gradient.
   

 
 
4.

  To create a Solid fill hatch pattern:
■ On the Home tab, click Draw panel >

Hatch.
■ In the Hatch and Gradient dialog box,

Pattern list, select Solid.
■ From the Swatch list, select Select Color.
■ In the Select Color dialog box, click the

Color Books tab.
■ Select a color from one of the Color book

guides. Click OK to return to the Hatch and
Gradient dialog box.

   

 
■ Under Boundaries, click Add: Pick points.
■ Click inside the circle. Notice the boundary

is highlighted.
■ Right-click to Preview.
■ Press ENTER to accept the hatch.
   

 
 
5.

  To modify an associative hatched object:
■ With the command line blank, select the

hatched objects.
   

 
■ Select the grips to adjust the shape of the

objects.
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■ Press ESC to deselect the objects.
   

  The hatch and gradient fills adjusted to the
modified shapes of the objects because the
Associative option in the Hatch and Gradient
dialog box was selected.
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Exercise: Create Hatches
   
In this exercise, you use the Hatch command to create
hatch patterns on the elevation drawing. You use the
Create Separate Hatch option to see how it affects a
multiple boundary pattern.  

  
The completed exercise

Completing the Exercise
To complete the exercise, follow the
steps in this book or in the onscreen
exercise. In the onscreen list of
chapters and exercises, click Chapter 9:
Hatching Objects. Click Exercise: Create
Hatches.

   
1.

  Open M_Hatch-Objects.dwg.
 
2.

  Zoom into the left area of the elevation as
shown.
   

 

 
3.

  Use the Hatch command to place separate
hatches on the front of the building:
■ On the Home tab, click Draw panel > Hatch.
■ In the Hatch and Gradient dialog box, select

AR-B816C from the Pattern list.
■ In the Scale field, enter 1.
■ Place a check mark in the box next to the

Create Separate Hatches option.
■ Click Add: Pick Points.
■ Click two points (1) and (2) define the

boundary as shown.
   

 
 
4.

  To complete the hatch:
■ Press ENTER.
■ In the Hatch and Gradient dialog box, click

Preview to preview the hatch.
■ If the hatch pattern appears correct, press

ENTER to accept the hatch.
 
5.

  Pan to the right side of the elevation.
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6.

  To place a single hatch on the three areas on
the right side of the elevation:
■ On the Home tab, click Draw panel > Hatch.
■ Clear the Create Separate Hatches option.
■ Click Add: Pick Points.
■ Click three points (1), (2), and (3) to define

the boundaries as shown.
   

 
 
7.

  To complete the hatch:
■ Press ENTER to return to the Hatch and

Gradient dialog box.
■ Click Specified Origin.
■ Click the Click to Set New Origin button.
■ Select the endpoint as shown.
■ In the Hatch and Gradient dialog box, click

OK.
   

 
 
8.

  Select the previously created hatch. Notice all
boundaries are treated as a single hatch object.
   

 
 
9.

  Zoom to display the entire drawing.

 
10.

  On the View tab, click Navigate panel > Extents
drop-down > Window. Window zoom into
the area shown in the following image. Make
certain only part of the roof area is visible.
   

 
 
11.

  On the command line, enter Regen.
 
12.

  To expand the Hatch dialog box:
■ On the Home tab, click Draw panel > Hatch.
■ Expand the Hatch and Gradient dialog box.
   

 
 
13.

  To specify the island detection type, under
Islands, click Outer.
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14.

  To apply a hatch pattern to the roof even
though the entire area is not displayed:
■ In the Pattern list, select AR-B88.
■ Click Add: Pick Points.
■ Select a point on the roof.
■ Press ENTER.
■ Click Preview.
■ Press ENTER to accept the hatch pattern.
   

 

 
15.

  Zoom to display your entire drawing.
   

 
 
16.

  Close all files. Do not save.
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Exercise: Create Fills and Gradients
   
In this exercise, you create solid fills and gradients.
You use draw order to place the gradients and fills
behind existing patterns, and you use the Inherit
Properties options to copy gradient and fill patterns.
 

 
Warning!
 

 Gradient fills are not supported by
AutoCAD LT. If you attempt this exercise
in AutoCAD LT, you will need to use
solid fills instead of gradient fills.
The Hatch and Gradient dialog box
is named the Hatch dialog box in
AutoCAD LT.

   

  
The completed exercise

Completing the Exercise
To complete the exercise, follow the
steps in this book or in the onscreen
exercise. In the onscreen list of
chapters and exercises, click Chapter
9: Hatching Objects. Click Exercise:
Create Fills and Gradients.

   
1.

  Open M_Create-Fills-Gradients.dwg.
 
2.

  Apply a gradient to the elevation roof:
■ On the Home tab, click Draw panel >

Gradient.
■ Click Inherit Properties.
■ Select the gradient pattern in the top

block.
   

 
 
3.

  Select a point on the roof as shown.
   

 
 
4.

  Right-click anywhere in the drawing. Click
Preview. Notice how the gradient pattern hides
the roof hatch pattern.

 
5.

  To move the gradient fill behind the roof
hatch:
■ Press ESC to return to the Hatch and

Gradient dialog box.
■ Under Options, select Send to Back in the

Draw Order list.
■ Under Islands, make certain Outer is

selected.
■ Under Options, select Send to Back from

the Draw Order list.
■ Click Preview. The gradient should appear

behind the roof hatch pattern.
■ Right-click anywhere in the drawing to

accept the gradient fill.
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6.

  To add a gradient fill to the fascia and columns
area of the elevation:
■ On the Home tab, click Draw panel >

Gradient.
■ Click Inherit Properties. Select the second

swatch.
   

 
 
7.

  Press ESC to return to the Hatch and Gradient
dialog box. The fill is detected as a solid color, and the
Hatch tab of the dialog box is displayed again.
   

 

 
8.

  Under Options, select Send to Back in the
Draw Order list:
■ Click Add: Pick Points.
■ Select points inside the fascia area,

columns, and outer areas of the upper
floor windows.

 Note: The following image reflects the
selections only on the right side of the
drawing.
■ Press ENTER.
■ Click Preview.
   

 
 
9.

  If the fills look correct, right-click anywhere in
the drawing to accept the hatch.

 
10.

  Repeat the Gradient command. Use the Inherit
Properties option to assign the gradient on
the lower swatch to the bricks on the front
elevation.
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  Once applied, the elevation should appear as
shown.
   

 
 
11.

  To add a solid hatch to the foundation area or
the elevation:
■ On the Home tab, click Draw panel >

Hatch.
■ In the Pattern list, make sure SOLID is

selected.
■ In the Swatch list, choose Select Color.
■ In the Select Color dialog box, Index Color

tab, under Color, enter 254.
■ Click OK.

 
12.

  Click Add: Pick Points. Select the foundation
area of the elevation.
■ Preview the hatch.
■ Right-click anywhere in the drawing to

accept the hatch.
 Note: Make sure you select the foundation
area on both sides of the door.
   

 
 
13.

  On the Layers panel, freeze the Hatch_Swatch
layer.

 
14.

  On the Layers panel, thaw the Background-
Frame layer.

 
15.

  Zoom to display the entire drawing. Note: To save time, lines were drawn to
use as a boundary for the background and
foreground fills.

 
16.

  Add a gradient fill to the upper background
representing the sky:
■ On the Home tab, click Draw panel >

Gradient.
■ Under Color, click One Color.
■ Click the Color button and select Blue on

the Index Color tab of the Select Color
dialog box.

■ Click OK.
■ Adjust the Shade - Tint slider as shown.

Click the middle right gradient swatch.
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17.

  Click Add: Pick Points. Select the upper area
above the elevation.
■ Right-click anywhere in the drawing. Click

Preview.
■ Right-click anywhere in the drawing to

accept the gradient fill.
 
18.

  Repeat the Gradient command, this time
using a green color on the lower area of the
elevation. Tip: Use the True Color tab of the Select Color
dialog box, and enter 109, 184, 71 for Color.

 
19.

  Close all files. Do not save.
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Lesson: Editing Hatch Objects
 

  
This lesson describes how to edit hatch and gradient patterns with the Hatchedit command.  
Most projects are subject to design changes, so the ability to easily modify an existing hatch is
important to remaining productive. The change can be as simple as changing the scale of a hatch
object or as complex as altering the boundary or adding or removing islands.  

 

 
Warning!
 

 The name of the Hatch and Gradient dialog box in AutoCAD LT is the Hatch dialog box.

  
Objectives

  
After completing this lesson, you will be able to:

■ Describe which edits maintain associative properties and which destroy the associativity.
■ Use the Hatchedit command to edit hatches and fills.
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Maintaining Associative Properties when Editing Hatches
   

Understanding when a hatch might lose its associativity, and thus not fill a newly edited object or area,
is critical in learning how to effectively edit hatched objects and maintain a high productivity rate.
Failure to understand this may result in unnecessary rework.

 
Hatch Associativity Guidelines

  
Consider the following guidelines for associative and nonassociative hatches:

 
■ If a hatch's associativity is lost, it cannot be restored. You have to delete and recreate the hatch

pattern.
■ If you do not close a hatch boundary, the hatch properties change from associative to

nonassociative.
 

Gaps in Hatch Boundaries Remove Hatch Associativity
  

When you are editing an object or area containing a hatch and you create a gap in the boundary, the
hatch pattern loses its associativity. If this occurs, a message on the Command line indicating the hatch
boundary associativity has been removed is displayed, and the hatch pattern does not fill the object or
area, as shown in the following illustration.  

 

Editing Hatches
   

The options and functionality in the Hatch Edit dialog box are identical to those found in the Hatch
and Gradient dialog box. When you edit a hatch pattern or fill, you can use the same options you used
when you created the hatch or fill.

 
When you start the Hatchedit command, you are prompted to select a hatch pattern. After you select
the hatch pattern, the Hatch Edit dialog box is displayed and shows the properties of the selected
hatch pattern or fill. You can adjust any of the properties used to create the hatch pattern and apply
those changes immediately.
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You can also edit a nonassociative hatch using grips. 

 

Command Access
    

 

  
Edit Hatch
   

 
    Command Line: HATCHEDIT
    Ribbon: Home tab > Modify panel > Edit Hatch

   

  Note: You can also double-click a hatch pattern in the drawing to access the Hatch Edit dialog box.
   
 

Hatch Edit Dialog Box
   

Except for a slight wording difference in the Options area (Separate Hatches versus Create Separate
Hatches), the Hatch Edit and Hatch and Gradient dialog boxes are identical.
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Hatch Boundary Grips
   

The following grips are available for a nonassociative hatch.
  

      

 

  Select a Vertex: Moves or removes the selected point.

   

 

  Select an Edge: Add a new point to the line segment or convert the line segment to an arc.

   

 

  Select an Edge: Add a new point to the arc segment, stretch the arc, or convert the arc segment to a
line.
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  Location Grip: Move the entire hatch object to a new location using the selected grip point as the base
point.

   

 

  Island Location: Move the island to a new location.

   

 

  Island Stretch: Stretch the specified edge.

     
When you hover over a grip, the tooltip that displays shows the editing options for the grip. You can
cycle through the options by selecting a grip and pressing CTRL. The following grips are available for a
nonassociative hatch.
 

 
 

Procedure: Editing Hatch Patterns and Fills
   

The following steps give an overview of editing hatch patterns and fills.
  

1.
  Double-click a hatch pattern or gradient fill.

 
2.

  Make the appropriate changes to the pattern in the Hatch Edit dialog box and click Preview.
 
3.

  Right-click anywhere in the drawing to accept the changes or left-click anywhere in the drawing to
return to the dialog box.

  
 

Hatch Editing Guidelines
  

Consider the following guidelines when editing hatches:
 

■ The Hatch Edit and Hatch and Gradient dialog boxes are almost identical.
■ You edit hatches with the same options you used to create them.
■ Double-click a hatch pattern or gradient fill to start the Hatchedit command. This saves you the

step of having to start the command, then select the hatch pattern.
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Exercise: Edit Hatch Patterns and Fills
   
In this exercise, you edit existing hatch patterns and fills. You erase geometry and view how the hatch pattern
and fills update accordingly. You remove boundaries that are no longer needed and create new boundaries.
 

 
Warning!
 

 Gradient fills are not supported by AutoCAD LT.

   

  
The completed exercise

Completing the Exercise
To complete the exercise, follow the
steps in this book or in the onscreen
exercise. In the onscreen list of
chapters and exercises, click Chapter
9: Hatching Objects. Click Exercise: Edit
Hatch Patterns and Fills.

   
1.

  Open M_Edit-Hatches-Fills.dwg.
 
2.

  Zoom to display the elevation as shown.
 
3.

  Erase two of the dormers from the roof:

■ Start the Erase command.
■ Enter w and press ENTER to create a

window selection.
■ Create a window selection around the two

center windows as shown.
■ Press ENTER.
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4.

  Verify that the roof pattern and gradient are
updated automatically.
   

 
 
5.

  Double-click the fill applied to the front
fascia of the elevation to start the Hatchedit
command.
   

 
 
6.

  To remove the boundaries associated with the
erased dormers:
■ In the Hatch Edit dialog box, click Remove

Boundaries.
■ Select the highlighted boundaries

to remove them. As you select the
boundaries, they disappear.

■ Continue selecting the boundaries until
they are all removed.

   

 

 
7.

  Press ENTER to return to the Hatch Edit dialog
box. Click OK.

 
8.

  Change the pattern and scale of the roof hatch:
■ Double-click the roof hatch to start

Hatchedit.
■ Under Type and Pattern, select the Pattern

list.
■ Click AR-RSHKE.
■ Under Angle and Scale, enter 1.5 in the

Scale list.
■ Click OK.

 
9.

  Zoom in to the left side of the elevation.
 
10.

  Move a window:
■ Start the Move command.
■ Enter w and press ENTER to use a window

selection.
■ Click two points to define the selection

window as shown.
■ Press ENTER.
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11.

  Make sure either PolarSnap or ortho is turned
on and do the following:
■ Click anywhere on your drawing for the

base point.
■ Drag your cursor to the left at 180 degrees.
■ Click to move the window to the left any

amount as shown.
   

 
 
12.

  Because the move generated a gap in the
boundary, the hatch boundary associativity
is removed. To correct this, remove the old
boundary and create a new boundary for both
the hatch and the fill:
■ Double-click the fill area to begin the

Hatchedit command.
■ In the Hatch Edit dialog box, click Remove

Boundaries.
■ Select the boundary as shown.
   

 
   

13. To add the new boundary:
■ Right-click anywhere in the drawing.
■ Click Add Boundaries.
■ Select a point as shown.
■ Press ENTER.
   

 
 
14.

  In the Hatch Edit dialog box, click OK.
 
15.

  Double-click the hatch pattern and repeat the
previous process to remove and add a new
boundary. When complete, the area should
appear as shown. Note: The preceding steps do not reassociate
the hatch and fill with the geometry. Once
associativity is removed from the hatch
pattern, you would need to recreate the hatch
pattern to achieve associativity. This lesson
focuses on editing hatch patterns, but in some
cases it could be quicker to delete the hatch
and recreate it.
   

 
 
16.

  Zoom to display the entire drawing.
 
17.

  Close all files. Do not save.
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Challenge Exercise: Architectural
 

  
In this exercise, you use what you learned about hatching objects to add hatching and fills to your
project.

 

 You have the option of completing this exercise using either imperial or metric units.
Select one version of the exercise to complete the steps.

 

 
Warning!
 

 If completing this exercise in AutoCAD LT, in step 2, use a solid fill with a grey color
(color 9).

   

  
The completed exercise

Completing the Exercise
To complete the exercise, follow the steps in this book or in the onscreen exercise. In
the onscreen list of chapters and exercises, click Chapter 9: Hatching Objects. Click
Challenge Exercise: Architectural Metric.

 
 

Metric Units
  

1.
  Open the drawing you saved from the previous challenge exercise, or open M_ARCH-Challenge-
CHP09.dwg.

 
2.

  Set up the layers and add a gradient fill.
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■ Thaw the existing layer, Site - Concrete, and make it the current layer.
■ Freeze the Dimension layer.
■ Add a gradient hatch to the geometry as shown.
   

 
 
3.

  Add additional hatching to the drawing as desired. For example, you could hatch the area between the
wall lines or hatch different rooms.

 
4.

  Save and close the file.
   
 

Imperial Units
  

1.
  Open the drawing you saved from the previous challenge exercise, or open I_ARCH-Challenge-
CHP09.dwg.

 
2.

  Set up the layers and add a gradient fill.
■ Thaw the existing layer, Site - Concrete, and make it the current layer.
■ Freeze the Dimension layer and add a gradient hatch to the geometry on as shown.
   

 
 
3.

  Add additional hatching to the drawing as desired. For example, you could hatch the area between the
wall lines or hatch different rooms.

 
4.

  Save and close the file.
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Challenge Exercise: Mechanical
 

  
In this exercise, you use what you learned about hatching objects to add hatch patterns and fills to the
drawing.

 

 
Warning!
 

 If completing this exercise in AutoCAD LT, in step 5, use a solid fill instead of a gradient
fill.

   

  
The completed exercise

Completing the Exercise
To complete the exercise, follow the steps in this book or in the onscreen exercise. In
the onscreen list of chapters and exercises, click Chapter 9: Hatching Objects. Click
Challenge Exercise: Mechanical.

   
1.

  Open the drawing you saved from the previous challenge exercise, or open M_MECH-Challenge-
CHP09.dwg.

 
2.

  Make the Hatch layer current.
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3.

  Apply an ANSI32 hatch pattern to the view as shown. Adjust the scale and angle accordingly.
   

 
 
4.

  Apply the same hatch pattern to the assembly section view as shown.
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5.

  Apply gradient and solid fills to the assembly views as shown. Use your own choice of colors. Tip: Use the Draw Order option to prevent the patterns from covering the lines.
   

 
 
6.

  Save and close all files.
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Chapter Summary
 

  
You use hatch patterns to create sections and other types of views. As you have seen in this chapter,
hatch patterns and gradient fills can be used to enhance the entire drawing.  
Having completed this chapter, you can:

■ Create hatch and gradient fill patterns on objects in the drawing.
■ Edit hatch and gradient fills that have been placed in the drawing.
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Chapter

10

Working with Reusable Content
 
  

When you create a drawing file, you are creating and interacting with a special database file through a
graphical interface. In some cases, you need to define a number of individual objects as a single object
for greater ease of use. That single object is referred to as a block.

 
Once you have grouped objects together into a block, you can reuse that data in other locations in
the same drawing or in other drawings. Leveraging existing data in your drawings helps you to work
more efficiently and keeps your design data consistent. In addition to blocks, there are other types of
information that you can reformat and reuse in your drawing files.

 
Use DesignCenter to drag specific content, or even an entire drawing, from one drawing file into
another. You can also use tool palettes to organize and share data such as blocks, hatches, and even
commands.

 
In this chapter, you are introduced to these methods for leveraging existing drawing information.

 
Objectives

  
After completing this chapter, you will be able to:

■ Create a block definition and insert a block definition or file into a drawing to place block
references.

■ Use DesignCenter to reuse the data in a drawing.
■ Access tool palettes and use their tools.

 

Standard Object Snap and Status Bar Settings
 Before completing the exercises in this chapter, refer to the "Settings for the

Exercises" section in the Introduction in Volume 1.
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Lesson: Using Blocks
 

  
This lesson describes how to create a block definition and insert a block definition or file into a
drawing. For example, in the following illustration,the single block object on the left was created from
all of the geometry on the right. The block object keeps all of the geometry tied together. The chair
on the right is made of individual lines, arcs, and polylines while theobjectson the leftare a block
definition; you can insert them into a drawing as a single object.  
Using groups of objects to create block definitions that act as a single object can help you work more
efficiently. Multiple objects that are defined as a block increase the reusability of that geometry when
you or others use the block in other drawings or locations. Creating blocks to use in other drawings
vastly improves overall efficiency and helps you to maintain consistency in your designs.  

 
Objectives

  
After completing this lesson, you will be able to:

■ Describe blocks and how they are used to group objects together.
■ Describe the properties that affect block behavior in the drawing.
■ Use the Block command to create a block definition.
■ Use the Insert command to insert a block reference in a drawing.
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About Blocks
   

Blocks provide an efficient way to group a set of objects together and reuse them throughout all of
your drawings and projects. You can create your own blocks or use some of the thousands available
from others via the Internet.   
The following illustration shows an example of typical blocks you might use to create an office or home
layout drawing.    

  
Architectural symbols
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The following illustration shows an example of typical blocks you might use to create a mechanical or
electrical drawing.    

  
Mechanical symbols

 
Blocks Defined

  
Blocks are often referred to as symbols. These symbols are made up from a collection of objects
grouped together into a block definition. A block definition can be made from a single object in your
drawing or from multiple objects. You only need to draw a symbol once; then, whenever you need
that symbol in any drawing, you simply insert it.
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One symbol found in most drawings is a title block and border.

  

  
"D" sized title block and border

 
Tracing Analogy

  
In the days of manual drafting, draftsmanused cardboard or plastic templatesto trace common items
onto their drawing. Some of the most simplewere circles and ellipse templates, but mechanical
engineers also used templates for arrowheads,bolts, andhydraulic cylinders. Architects traced common
fixtures such as sinks, bath tubs, or lavatories. By tracing these templates, draftsmen were able to
produce common objects consistentlythroughout their drawings.
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Example: Blocks used for Architectural Drafting

  
In architectural drafting, blocks are used for common objects, including doors, windows, case goods,
plumbing fixtures, and furniture. The following drawing shows a simple floor plan that is made from
many blocks. 

 
 

 

How Blocks Behave
   

Blocks behave exactly as you want them to, provided you follow the rules for creating them. When
you insert a block, the color, linetype, and lineweight of objects in the block retain their original
settings regardless of the current settings in the drawings. However, you can create blocks with
objects that inherit the current color, linetype, and lineweight settings.   
In this image, both blocks were inserted with the Visual layer current. Each block was created on a
different layer with different properties. On the left, the original block geometry is created on layer 0.
On the right, the original block geometry is created on a layer other than 0 and has different linetype
and color properties.
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Definition of Block Behavior

  
When a Block is inserted into a drawing, there are three possible ways the block can behave in regards
to its Properties (Color, Layer, Linetype, and Lineweight): (1) It can retain its original properties; (2) It
can inherit its properties from the current Layer on which it is inserted; (3) It can inherit its properties
from the current Property settings:
■ Retain Original Properties (1): Objects in the block do not inherit color, linetype, and lineweight

properties. The properties of the object in the block do not change regardless of the current
settings. For this choice, it is recommended that you set the color, linetype, and lineweight
properties individually for each object before you create the block definition. Do not use BYBLOCK
or BYLAYER for the properties of these objects.

■ Inherit Properties from current Layer (2): Objects in the block inherit color, linetype, and lineweight
properties from the color, linetype, and lineweight assigned to the current layer. For this choice,
before you create objects to be included in the block definition, set the current layer to 0 and set
the current color, linetype, and lineweight to BYLAYER when you create the geometry for your
block.

■ Inherit Properties from current Property Settings (3): Objects in the block inherit color, linetype,
and lineweight from the current color, linetype, and lineweight. This is like setting an override by
not assigning the property from the current layer. For this choice, before you create objects to be
included in the block definition, set the current color, linetype, and lineweight to BYBLOCK.  

In summary, a block takes on the properties of the current layer when inserted, provided it has either
been created on layer 0 or with the properties of its objects set to BYLAYER. A block retains its original
properties from the layer it was created on when the properties of the objects contained in the block
have been set to BYLAYER.
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Example of Block Behavior

  
Assume that you want to create a sink block and you want the sinkto take on the properties of the
current layer when inserted. First, you shouldmake layer 0 current and set the color, layer, linetype,
and lineweight properties to BYLAYER. Then create your geometry andmake a block out of it. When
you insert your sink block, it inherits the color, linetype, and lineweight from the current layer.

 

Creating Blocks
   

The Block command creates a single object out of multiple objects so they appear and behave like a
single piece of geometry. The definition for the block is stored in the drawing database and referred
to as a block definition. A visible block definition in a drawing is called a block reference. A block
definition can exist in the drawing file database and not have a block reference in the drawing.

 
You define the block through the options in the Block Definition dialog box. You define items such
as the name of the block, what objects will be in the block definition, the base point for the block,
what units the geometry is drawn in, if it has to be scaled uniformly, whether it can be exploded, and
a general description.

 
The base point you specify for the block defines the point you will use to position the block when
inserting it in a drawing. This point also becomes the grip point for the block. The following illustration
demonstrates the importance of selecting a proper base point. When creating a bi-fold door block and
specifying the base point, you should snap to an object endpoint (1) so that when you insert the bi-
fold door block in your drawing you can accurately place it at the end of the closet wall (2).  

 
 

Command Access
    

 

  
Block
   

 
    Command Line: BLOCK, B
    Ribbon: Insert tab > Block panel > Create
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Block Definition Dialog Box
   

For each block you create, you specify the name and the insertion base point; you also select the
objects to include in your block definition. You can also choose among various other settings as
needed.

  

      

 

  Specify the name of the block.

   

 

  Define the base point. Click Pick Point to snap to a location on your objects and return the X, Y, and Z
values; or enter the absolute X, Y, and Z values.

   

 

  Click Select Objects and select the geometry to include in this block. Under Objects, select the option
to define what happens to the selected geometry after you click OK to create the block. The objects are
either left as individual objects (retained), converted to a block reference, or deleted.

   

 

  Select your Annotative behavior and whether to scale the block uniformly and allow it to be exploded
based on your requirements.

   

 

  Select the units the geometry was drawn with.

   

 

  Enter a description for the block.

   

 

  Check this box to open the block editor after clicking OK.
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Procedure: Creating a Block
   

The following steps give an overview of creating a block with the Block command.
  

1.
  On the ribbon, click Insert tab > Block panel > Create (1).
   

 
 
2.

  In the Block Definition dialog box, enter a name for the block (2) and click Pick Point (3).
   

 
 
3.

  Use an object snap to select a location on your object for the pick point.
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4.

  Under Objects, click Select Objects (4).
   

 
 
5.

  Select the geometry to include in this block.
   

 
 
6.

  Under Objects, select the option to define what happens to the selected geometry (5). Then click OK.
   

  Note: Other options to enhance your block definitions include choosing whether the block is
annotative or not, setting the block units, and giving the block a description.
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Guidelines for Creating Blocks
■ Name the blocks in a logical order, for example Door32, Door36, Window28, etc.
■ Use the Purge command to purge unreferenced blocks that you will not be using in your drawing.
■ Use the WBLOCK command to write the blocks in your drawing to individual drawing files. Type

W to access the Write Block dialog box. Choose the block from your drawing and the Destination
folder. Keep a folder for all of your block symbols to use in other drawings.

■ You can nest blocks, meaning you can create a block that has other blocks within it. There is no
limit to how many blocks can be nested in another block.

■ If a block definition exists in a drawing and it is referencing a layer, you will not be able to delete
the layer unless the block is purged.

■ You cannot purge a reference if there is an instance of the block in the drawing.
■ To make changes to a block, Explode it and re-create the block. If you re-create a block with the

same name as a previously defined block, it will change all of the blocks in the drawing with that
name.

■ If you create a block and do not specify a Base point, the default base point will be 0,0,0.
■ To Rename a block, use the Rename command. Select the old block name from the list and

Rename it.
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Practice Exercise: Create Blocks  
In this practice exercise, you draw a simple object,
create a block out of it, and name the block. 
 
 

   
1.

  Begin a blank drawing and create some simple
geometry.

 
2.

  To create a block:
■ On the Insert tab, click Block panel >

Create.
■ In the Block Definition dialog box, for the

block name, enter widget (1).
■ For the block base point, click Pick Point

(2).
■ Using object snap, select a point on the

object (3).
■ Click Select Objects (4) and select the

geometry you have created. Press ENTER to
return to the dialog box.

■ Click the Convert to Block option (5).
■ Select OK to exit the dialog box.
   

 

 
3.

  To check that the geometry was converted to a
block:
■ With the command line blank, select the

object.
■ The object should be highlighted with one

grip visible at the base point you selected
for the block.

   

 
 
4.

  Save this drawing to practice the Insert
command in the next section.
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Inserting Blocks
   

You use the Insert command to select a block definition or a file so you can place a block reference in
your drawing. After selecting the block definition or file, you specify the insertion point, scale factor,
and rotation angle for that block in the Insert dialog box or in the drawing window.

 
When you use Insert and select a file, a block definition of that entire file is added to the drawing
database. So in a sense, the Insert command creates a block from a file on the fly.  

 
 

Command Access
    

 

  
Insert
   

 
    Command Line: INSERT, I
    Ribbon: Insert tab > Block panel > Insert
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Insert Dialog Box
   

For each block you insert, you provide the block name, insertion point, scale, and rotation when you
place the block in your drawing.

  

      

 

  Specify the name of a block to insert or the name of a file to insert as a block.

   

 

  Opens the select file dialog box allowing you to select a drawing file to insert as a block into your current
drawing.

   

 

  Preview of the selected block when a preview image is available.

   

 

  Specify the insertion point of the block in your drawing. Decide whether the insertion point should be
defined in the dialog box or on screen in the drawing area. If on screen, then select the Specify On-
Screen option. If not, clear this option and enter the X, Y, and Z values. You will most often specify this
point on screen.

   

 

  Specify the scale factor for the block. Decide whether the scale factor should be defined in the dialog
box or on screen in the drawing area. If on screen, then select the Specify On-Screen option. If not, clear
the option and enter the X, Y, and Z scaling factors.

   

 

  Specify the rotation angle of the block. Decide whether the rotation angle should be defined in the
dialog box or on screen in the drawing area. If on screen, then select the Specify On-Screen option. If
not, clear the option and enter a rotation angle. You can also change this on screen while placing the
block.
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Procedure: Inserting a Block
   

The following steps give an overview of inserting a block into a drawing.
  

1.
  On the ribbon, click Insert tab > Block panel > Insert.

 
2.

  In the Insert dialog box, select the block name from the list of blocks or click Browse and select a file.
   

 
 
3.

  Select the Specify On-Screen option (1), set your scale factor (2), and your rotation angle (3). The
default rotation direction is CCW.
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4.

  Click OK.
   

  Drag the block to the desired location and click to place it. You can use object snaps for an exact
placement if desired.

 
5.

    

  Your block is placed in the drawing based on the parameters you specified.
  
 

Guidelines for Inserting Blocks
■ When creating a Title block, you typically want the insertion point to be at 0,0. Otherwise, select

the insertion point in the drawing.
■ You can specify the X,Y scale and rotation angle at the command line when you insert the block if

you uncheck Specify On-screen for Scale and Rotation.
■ You can specify different X and Y scales. The block will be scaled proportionately.
■ Browse to select a drawing file or a wblock that is located outside of the drawing.
■ Once a drawing file is inserted into the current drawing, everything that the drawing geometry

references will come with it such as blocks, layers, linetypes, text styles, and dimension styles.
■ Use the Purge command to purge your drawing of unreferenced information that you will not need

in your drawing. This will result in a more efficient drawing size.
■ Once a block is inserted into a drawing you can move, copy, rotate, scale, mirror, or handle it like

any other geometry.
■ When you Explode a block, the geometry returns to its original properties.
■ When you Explode a block that has another block nested in it, you can then Explode the nested

block.  
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Practice Exercise: Inserting Blocks  
In this practice exercise, you create and insert a block.
You also draw a simple object then create a block out
of it, called a widget. After you create the widget, you
insert it into your drawing. 
 
 

   
1.

  Begin a blank drawing and create some simple
geometry.

 
2.

  To create a block:
■ On the Insert tab, click Block panel >

Create.
■ In the Block Definition dialog box, for the

block Name, enter widget (1).
■ For the block base point, click Pick Point

(2).
■ Using object snap, select a point on the

object (3).
■ Click Select Objects (4) and select the

geometry you have created. Press ENTER
to return to the dialog box.

■ Click the Convert to Block option (5).
■ Select OK to exit the dialog box.
   

 

 
3.

  To check that the geometry was converted to a
block:
■ With the command line blank, select the

object.
■ The object should be highlighted with one

grip visible at the basepoint you selected
for the block.

   

 
 
4.

  To insert the block into the drawing:
■ On the Insert tab, click Block panel > Insert.
■ Select the block name from the list (1).
■ For the insertion point, place a check mark

in the box next to the Specify On-screen
option (2).

■ Clear Scale (3). X, Y, and Z should be 1.000.
■ Clear Rotation (4). The Rotation angle

should be 0.
■ Click OK.
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5.

  Specify the insertion point on the screen.
   

 
 
6.

  On the Insert tab, click Block panel > Insert.
Insert the block again, change the scale, and
rotate the angle.
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Exercise: Create and Insert Blocks
   
In this exercise, you create a block from individual
lines that represent a phone. You then insert another
instance of the phone in the drawing. You then save
the drawing file and insert it into a new drawing.
 

 
Warning!
 

 If completing the exercise with
AutoCAD LT®, in step 9 you will need to
use the acadltiso.dwt file.

   

  
The completed exercise

Completing the Exercise
To complete the exercise, follow the
steps in this book or in the onscreen
exercise. In the onscreen list of
chapters and exercises, click Chapter
10: Working with Reusable Content.
Click Exercise: Create and Insert
Blocks.

   
1.

  Open C_Workstation.dwg.

 
2.

  To view an object's information:
■ On the command line, enter list to start

the List command.
■ Select the bottom horizontal line on the

phone.
■ Press ENTER.
■ Notice that the object listed is a line

object.
   

 
■ Press F2 to close the AutoCAD® text

window.
 
3.

  On the Insert tab, click Block panel > Create.
 
4.

  To define the block using the Block Definition
dialog box:
■ For Name, enter Phone (1).
■ For the base point, click Pick Point (2).
■ Snap to the lower right endpoint of the

phone (3).
■ Under Objects, click Select Objects (4).
   

 
■ Select the phone geometry with a window

selection.
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■ Press ENTER to return to the dialog box.
■ Under Objects, click Convert to Block (5).
■ Verify the setting in the Block Definition

dialog box. Click OK.
 
5.

  To view the object information:
■ On the command line, enter list to start

the List command.
■ Select the line on the phone that you

previously selected.
■ Press ENTER.
■ Notice that the object is now listed as a

block reference with the name Phone.
   

 
■ Press F2 to close the AutoCAD text

window.
 
6.

  To insert the block into the drawing:
■ On the Insert tab, click Block panel > Insert.
■ In the Insert dialog box, select the phone

block from the list (1).
■ Specify the insertion point in the screen

(2). The default scale should be 1.0 and the
rotation angle should be 0.

■ Click OK.
   

 

 
7.

  Click to place the phone just below the original
phone.
   

 
 
8.

  Save this file. On the title bar, notice the path
where C_Workstation.dwg is saved.

 
9.

  To start a new file using a template:
■ On the ribbon, click Application Menu >

New.
■ In the Select Template dialog box, select

the acadiso.dwt file.
■ Click Open.

 
10.

  On the Insert tab, click Block panel > Insert.
 
11.

  To insert the file into the current drawing:
■ In the Insert dialog box, click Browse.
■ In the Select Drawing File dialog box,

navigate to and select C_Workstation.dwg.
■ Click Open.
■ With C_Workstation now listed in the

Insert dialog box, click OK to insert the
C_Workstation block into the drawing.
Insert the block anywhere in the drawing
window, or if you clear the option to
specify the insertion point on -screen, it
inserts the block at 0,0.
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12.

  To view the block in the drawing:
■ Zoom out to view the block.
■ On the Insert tab, click Block panel > Insert.
■ Select the list and notice that the

C_Workstation drawing is now inserted
as a block into the current drawing along
with all of the blocks that belonged to that
drawing. Each of these blocks is now part
of the current drawing database.

■ Click Cancel to close the Insert dialog box.
   

 
 
13.

  To view other properties in the drawing:
■ On the Home tab, click Layers panel >

Layer Control.
■ Notice that the layer A-EQPM-IDEN is now

part of the current drawing database. This
layer was brought into the drawing along
with the C_Workstation block.

   

 
 
14.

  Close all files. Do not save.
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Lesson: Working with DesignCenter
 

  
This lesson describes how to use DesignCenter to reuse data from another drawing in the active
drawing.  
Reusing data saves you valuable design time and helps ensure consistency across your designs and
among designers.  

 
Objectives

  
After completing this lesson, you will be able to:

■ Use DesignCenter to add data to a drawing.
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Using DesignCenter
   

You use DesignCenter to view existing content in other drawings and drag it into the current drawing.
You can drag an entire drawing file or any of the following named objects within a drawing file: blocks,
dimension styles, layers, layouts, linetypes, table styles, text styles, or xrefs. You can also drag drawing
files and blocks from DesignCenter onto a tool palette.   
The DesignCenter interface is split between a tree view and a content pane. The four tabs, Folders,
Open Drawings, History, and DC Online, determine what you see in the tree view. When you select
an item in the tree view, its contents are displayed in the content pane, and you can drag it into the
current drawing.

 
The following image shows an expanded tree view (1) of the Open Drawings tab (2). The Blocks
category is selected (3) and its contents are displayed in the upper right pane. You can turn the
Preview (4) and Description (5) options on so that you can view the details of a selected block (6) in
the lower right panes.

  

Since DesignCenter is a palette, you can adjust its display to match the way you work. For example,
you can resize it, dock it, anchor it, or set it to roll up into the title bar when you pass the cursor over
the title bar. 
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Use the following tabs in DesignCenter to locate content.

 
  
Tab

  
Description

  Folders
  Displays a standard Windows-like tree view so that you can navigate easily to content
files.

  Open Drawings
  Displays only drawings currently open in the software.

  History
  Displays drawing accessed during the current session of the application.

  DC Online
  Accesses content on manufacturers' web pages.

   
 The DesignCenter Online (DC Online tab) is disabled by default. You can enable it

from the CAD Manager Control utility. Information about how to use the utility
is available after you install the utility from the Installation Wizard. To access this
information, run the utility and click Help in the CAD Manager Control Utility window.

 
 

Command Access
    

 

  
DesignCenter
   

 
    Command Line: ADCENTER
    Ribbon: Insert tab > Content panel

   

 
    Ribbon: View tab > Palettes panel > DesignCenter
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Procedure: Reusing Content with DesignCenter
   

The following steps give an overview of using DesignCenter to insert content from another drawing
into the current drawing.

  
1.

  On the ribbon, click View tab > Palettes panel > DesignCenter.
 
2.

  Click the Folders, Open Drawings, or History tab to populate the tree view with a place to search for
content.

 
3.

  Navigate and expand the tree view to display the desired folder or drawing file and category.
 
4.

  In the tree view, click the folder or category to display its contents in the content pane.
   

 
 
5.

  In the content pane, insert the item into the current drawing in one of three ways:
■ Drop it in the drawing.
■ Double-click it.
■ Right-click it and select the appropriate option.
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Exercise: Use DesignCenter
   
In this exercise, you use DesignCenter to insert two
blocks that reside in another file into the current
drawing. You also insert a text style from that file.  

  
The completed exercise

Completing the Exercise
To complete the exercise, follow the
steps in this book or in the onscreen
exercise. In the onscreen list of
chapters and exercises, click Chapter
10: Working with Reusable Content.
Click Exercise: Use DesignCenter.

   
1.

  Open C_Content-To-Reuse.dwg and
C_Elevation-Presentation.dwg.

 
2.

  On the View tab, click Palettes panel >
DesignCenter.

 
3.

  In DesignCenter:
■ Click the Open Drawings tab.
■ In the tree view, expand and show the

categories under C_Content-To-Reuse.dwg
and C_Elevation-Presentation.dwg.

 
4.

  In the tree view under C_Content-To-
Reuse.dwg, click Blocks.
   

 
 
5.

  Drag and drop the block elev-conifer from the
content pane to the front right area of the
house as shown.
   

 
 
6.

  In the content pane of DesignCenter, double-
click elev-deciduous.

 
7.

  In the Insert dialog box:
■ Under Scale, enter 2 for the X scale factor.
■ Under Scale, enter 4 for the Y scale factor.
■ Under Insertion Point, select Specify-On-

Screen.
■ Click OK.
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8.

  Click to position the tree to the left and down
from the house as shown.
   

 
 
9.

  In the tree pane of DesignCenter, under
C_Elevation-Presentation.dwg, click the
Textstyles category. The only text styles currently in the drawing
are Annotative and Standard.

 
10.

  Under C_Content-To-Reuse.dwg, click the
Textstyles category.

 
11.

  In the content pane of DesignCenter, drag and
drop the Present-Text style into the drawing
area.
   

 
 
12.

  In the tree pane, under C_Elevation-
Presentation.dwg, click Textstyles. The Present-Text style now exists and is
available for use in this drawing file.

 
13.

  Close all files. Do not save.
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Lesson: Using Tool Palettes
 

  
This lesson describes how to access tool palettes and use the tools in your drawings.  
Using tool palettes, you can organize and access the tools you use most often, which helps you to work
more efficiently.   
The following illustration shows the Tool Palettes window and some of the tools on the Architectural
and Civil tool palettes.

  

 
Objectives

  
After completing this lesson, you will be able to:

■ Use a customized tool palette to add geometry to your drawing.
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Using Tool Palette Tools
   

The Tool Palettes window contains a tab for each tool palette. You use these tool palettes to organize
and share frequently used commands and objects, such as blocks and hatches, so that you can access
and use them more efficiently.

 
You can create, delete, and rename palettes using the shortcut menu. By right-clicking a tool, you
can change its properties to make the tool even more efficient. For example, you might have a block
automatically explode after insertion, create text with a specified text style, or create geometry on a
specific layer every time.

 
You can add tools to a palette in the following ways:
■ Drag blocks or drawing files from DesignCenter.
■ Right-click and drag a single piece of geometry from the drawing window to a palette.

 
When you add geometry to a palette in this manner, blocks create block instances when reinserted,
standard geometry adds the command, and hatches add the command plus the hatch settings.

 
You can adjust the display of the Tool Palettes window to match the way you work. You can resize it,
dock it, or set it to roll up into the title bar.  

  
The Mechanical Tool Palette 
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Command Access
    

 

  
Tool Palettes
   

 
    Command Line: TOOLPALETTES
    Ribbon: View tab > Palettes panel > Tool Palettes

   

 
   

 When you insert a block from a tool palette, if the block has defined units, it scales to
the defined insertion scale units of the target drawing.

 
 

Procedure: Adding Geometry to a Drawing Using the Tool Palettes
   

The following steps give an overview of using tool palette tools to add geometry to a drawing.
  

1.
  On the ribbon, click View tab > Palettes panel > Tool Palettes.

 
2.

  Click the tool palette tab that contains the desired item.
 
3.

  In the tool palette, click the icon of the desired item.
 
4.

  Click in the drawing area to create the item.
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Exercise: Add Content from Tool Palettes
   
In this exercise, you use tool palette tools to add a
block, a hatch, and text to a drawing.  

  
The completed exercise

Completing the Exercise
To complete the exercise, follow the
steps in this book or in the onscreen
exercise. In the onscreen list of
chapters and exercises, click Chapter
10: Working with Reusable Content.
Click Exercise: Add Content from Tool
Palettes.

   
1.

  Open M_Tool-Palettes.dwg.
 
2.

  On the View tab, click Palettes panel > Tool
Palettes.

 
3.

  On the Tool Palettes window, click the
Mechanical tab.

 
4.

  To insert a bolt into the drawing:
■ Click the icon for Hex Socket Bolt (Side) -

Metric.
■ Click the intersection of the top centerline

and the far left line.
 The drawing should look like the following
illustration.
   

 
 
5.

  In the Tool Palettes window, click the Hatches
and Fills tab.

 
6.

  Make layer 3 current.
 
7.

  To apply a steel hatch pattern to the cutaway
section:
■ Under ISO Hatches, click the icon for the

Steel hatch pattern.
   

 
■ Position the cursor in the open rectangular

area just above the recently placed bolt, as
shown.

■ Click to create the hatch.
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8.

  Insert the same hatch pattern in the area
below the bolt, as shown.
   

 
 
9.

  In the Tool Palettes window, click the Draw tab.
 
10.

  To add a text note to the drawing:
■ Make the text layer current.
■ Click the icon for MText.
■ Create the text window to the right of the

bolt and hatch, as shown.
■ Enter 12 for the text height in the Style

panel of the Text editor shown in the
ribbon.

■ Enter COUPLER.
■ Click Close Text Editor.
   

 
 
11.

  Close all files. Do not save.
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Challenge Exercise: Architectural
 

  
In this exercise, you use what you learned about reusable content to create a block definition and
reuse existing content.

 

 You have the option of completing this exercise using either imperial or metric units.
Select one version of the exercise to complete the steps.

Completing the Exercise
To complete the exercise, follow the steps in this book or in the onscreen exercise. In
the onscreen list of chapters and exercises, click Chapter 10: Working with Reusable
Content. Click Challenge Exercise: Architectural Metric.

 
 

Metric Units
  

1.
  Open the drawing you saved from the previous challenge exercise, or open M_ARCH-Challenge-
CHP10.dwg.

 
2.

  Define a block from the door geometry you created in Chapter 2. Name it Door-Typical.
   

 
 
3.

  Set the appropriate layer current before inserting each block.
 
4.

  Insert and position Door_Glass-915 for each of the locations labeled (1) as shown. Insert and position
Door-Typical in all the remaining door openings.
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5.

  Insert the block Elevation-Exterior from the file M_ARCH-Challenge-Supporting-Details.dwg.
   

 
 
6.

  Insert and position the two different-sized windows in the openings.
 
7.

  Insert and position plumbing fixtures in the floor plan.
 
8.

  Close and save all files.
   
 

Imperial Units
  

1.
  Open the drawing you saved from the previous challenge exercise, or open I_ARCH-Challenge-
CHP10.dwg.

 
2.

  Define a block from the door geometry you created in Chapter 2. Name it Door-Typical.
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3.

  Set the appropriate layer current before inserting each block.
 
4.

  Insert and position Door_Glass-3-0 for each of the locations labeled (1) as shown. Insert and position
Door-Typical in all the remaining door openings.
   

 
 
5.

  Insert the block Elevation-Exterior from the file I_ARCH-Challenge-Supporting-Details.dwg.
   

 
 
6.

  Insert and position the two different-sized windows in the openings.
 
7.

  Insert and position plumbing fixtures in the floor plan.
 
8.

  Close and save all files.
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Challenge Exercise: Mechanical
 

  
In this exercise, you use what you learned about reusable content to create a block and reuse content.

 

 
Warning!
 

 If completing this exercise with AutoCAD LT, in step 3, you will need to locate the block
at ...\Program Files\AutoCAD LT 2010\Sample\DesignCenter\Fasteners - Metric.dwg.

   

  
The completed exercise

Completing the Exercise
To complete the exercise, follow the steps in this book or in the onscreen exercise. In
the onscreen list of chapters and exercises, click Chapter 10: Working with Reusable
Content. Click Challenge Exercise: Mechanical.

   
1.

  Open the drawing you saved from the previous challenge exercise, or open M_MECH-Challenge-
CHP10.dwg.

 
2.

  In model space, draw the following border and title block (without the dimensions). Define it as a block
with the name Titleblock. Use the lower-left corner of the border as the base point. Note: You will use this block in a later challenge exercise.
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3.

  Insert the block Hex Flange Screw - 10 mm top from the file ...\Program Files\AutoCAD 2009\Sample
\DesignCenter\Fasteners - Metric.dwg. Scale it up (Uniform Scale) 1.6 times and position the screws in
the top view of the assembly as shown.
   

 
 
4.

  Insert, size, and position the block definition Hex Bolt Head (10mm) -side view that exists in this
drawing. Scale the block to 1.6 times its original size.
   

 
 
5.

  Save and close the drawing.
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Chapter Summary
 

  
Reusing the data in a drawing file helps you to work more efficiently and maintains consistency in the
design data. Making geometry into blocks that behave like a single object encourages the reuse of
design geometry. Using DesignCenter and tool palettes makes it easy to organize and locate frequently
used design data.  
Having completed this chapter, you can:

■ Create a block definition and insert a block definition or file into a drawing to place block
references.

■ Use DesignCenter to reuse the data in a drawing.
■ Access tool palettes and use their tools.
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Chapter

11

Creating Additional Drawing
Objects

 
  

Depending on your design requirements, you might need to have connected line and arc segments
defined as a single continuous object or you might need to create smooth curves in a free-form shape
or on a specific elliptical path. You might also need to add tabular information to your drawing. Each
one of these needs can be easily met using the right command.

 
Objectives

  
After completing this chapter, you will be able to:

■ Create and edit polylines with the Polyline command.
■ Create smooth curves with the Spline command.
■ Create ellipses and elliptical arcs with the Ellipse command.
■ Create and edit basic tables and use table styles to control their appearance.

 

Standard Object Snap and Status Bar Settings
 Before completing the exercises in this chapter, refer to the "Settings for the

Exercises" section in the Introduction in Volume 1.
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Lesson: Working with Polylines
 

  
This lesson describes how to create and edit polylines. The following illustration shows polyline
segments in a lot boundary line and an arrow created with a polyline.  
With polylines you can create geometry and return information much more quickly than with other
methods. When you use polylines, you can easily calculate a perimeter distance or the area of an
irregular shape. By offsetting polylines, you do not spend time trimming or extending geometry at the
corners. Sharp corners are maintained in the offset.  

 
Objectives

  
After completing this lesson, you will be able to:

■ Describe polylines and how they differ from standard objects.
■ Use the Polyline command to create polylines.
■ Use the Edit Polyline command to edit polylines.
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About Polylines
   

Polylines enable you to create more complex geometry while at the same time, in some cases,
simplifying the creation process. Object selection is also simplified because several objects can be
combined into a single editable object.   
In the following illustration, several objects are shown and each of them represents a single polyline
that was created using different methods.
 

 
Definition of Polylines

  
Polylines are special types of entities that incorporate segments of common entities such as lines and
arcs into a single object. Polylines also have special properties that are not available on other objects.
These properties include:

 
■ Global Width
■ Start Segment Width
■ End Segment Width  
In addition to the properties mentioned above, polylines also provide significantly more choices for
controlling their shape during object creation as well as specific tools and options for editing the
objects after you create them.
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In the following illustration, a polyline containing 6 segments is shown. Segments (1) and (6) have
varying start segment widths and end segment widths. Segments (2) and (5) are constant widths
segments. Segments (3) and (4) are varying width arc segments.
 

 
 

Example of Polylines Being Used in a Drawing
   

In the following illustration, polylines are used to represent the lot boundary and proposed building
footprint. Using the polyline objects enables the designer to quickly determine properties such as area
or perimeter and also to add a global width to emphasize the polylines.
 

 

Creating Polylines
   

You use the Polyline command to create line and arc segments as a continuous single object. Each
segment of a polyline is connected at its endpoint to the next segment in the object. When creating
polylines, you can switch back and forth between straight line segments and arc segments. You can
also set a single width for all segments of the polyline, or you can vary the width of a segment from its
beginning to its end.   
The following illustration shows examples of polylines. You can calculate the area of the lot with the
Area command when the boundary is one object. The footprint of the structure stands out in the
design when you add width to its polyline outline. You can create straight and arcing arrows from two
segments of a polyline by varying the width of the arrowhead segment from beginning to end.
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Command Access
    

 

  
Polyline
   

 
    Command Line: PLINE, PL
    Ribbon: Home tab > Draw panel > Polyline

   

 
   
 

Command Options
   

These command options are for creating or changing polylines.
 

  
Option

  
Description

  Arc
  Use this option to draw arc segments within the polyline.

  Close
  Use this option to automatically create an arc or line segment from the last point
entered to the first point of the polyline.

  Undo
  Use this option to remove the previous segment when you want to either exclude it
or create a new segment with a different appearance.

  Width
  Use this option to set the width of a polyline in drawing units from the first vertex to
the second vertex.

  Line
  Use this option to resume drawing straight line segments within the polyline after
creating arc segments.
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Procedure: Creating a Custom Arrowhead
   

The following is an overview of creating a custom arrowhead using the Pline command.
  

1.
  On the ribbon, click Home tab > Draw panel < Polyline.

 
2.

  Pick your start point.
 
3.

  Drag your cursor to the right at 0 degrees. Enter the length of the arrow.
 
4.

  Right-click. Click Width.
 
5.

  Enter the starting width which should be larger then the ending width.
 
6.

  Enter the ending width which is usually 0.
 
7.

  Drag your cursor to the right at 0 degrees. Enter a value or click a point to define the length of the
arrowhead.

 
8.

  Press ENTER.
   

 
  

 

Editing Polylines
   

You modify polylines using the same commands you use to modify a line or circle. Commands like
Copy, Erase, Move, Offset, and Array can all be used to modify a polyline. When you use the Fillet
or Chamfer command and at least one of the segments you select is a polyline, the other selected
segments become part of the polyline object. However, you cannot fillet or chamfer the first segment
of a polyline with the last segment of the same polyline. To create a fillet or chamfer in that situation,
you must first use the Explode command to break the polyline into individual line and arc objects.

 
Polyline Edit

  
You use the Pedit command to change certain characteristics of a polyline or to convert a line or arc
into a polyline. 



Lesson: Working with Polylines         ■        265

 

Command Access
     

 

  
Edit Polyline
   

 
    Command Line: PEDIT, PE
    Shortcut menu for selected polyline: Polyline Edit
    Ribbon: Home tab > Modify panel > Edit Polyline

   

 
   
 

Command Options
   

Use these command options when editing a polyline.
 

  
Option

  
Description

  Open
  This option is used to edit a closed polyline. Open either opens a closed polyline or
removes the last segment created by the Close option when the polyline was created.

  Close
  The Close option is used to edit an open polyline. Close connects the last segment
with the first by either joining the first and last vertex or by adding a closing segment
between the first and last vertex.

  Join
  This option is used to add polylines, lines, and arcs to the polyline being edited. The
endpoints of the segments must match perfectly in order to be joined, and only two
segments can be joined at the vertex.

  Reverse
  This reverses the order of the vertices for the selected polyline.

  Width
  This option sets the same width value for all segments in the polyline.
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Exploding Polylines

  
You use the Explode command to convert a polyline into its most basic shapes such as lines and arcs.
When you explode a polyline, all the attributes associated with polylines, such as width, are lost and a
separate object is created for each segment of the polyline. 

 

Command Access
     

 

  
Explode
   

 
    Command Line: EXPLODE, X
    Ribbon: Home tab > Modify panel > Explode

   

 
   
 

Procedure: Joining Lines and Arcs into a Polyline
   

The following is an overview of using the Join option of the Pedit command to combine a series of
lines and arcs into a single polyline.

  
1.

  On the ribbon, click Home tab > Modify panel > Edit Polyline.
 
2.

  Select any one of the lines or arcs that you are going to join into a polyline.
 
3.

  If the selected object is already a polyline, you will not be prompted for this step. If the selected object is not a polyline, press ENTER at the prompt asking you to make it one.
 
4.

  Click Join.
 
5.

  Select all the objects that you want to join into a polyline. Press ENTER. Note: Use a window or crossing selection for the best results. It does not matter if extra objects are
selected.

 
6.

  Press ENTER to complete the polyline edit. The object now highlights as a single object when selected
as shown in the following image.
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Procedure: Exploding a Polyline
   

The following is an overview of using the Explode command to break a polyline into individual lines
and arcs.

  
1.

  On the ribbon, click Home tab > Modify panel > Explode.
 
2.

  Select one or more polylines in your drawing.
   

 
 
3.

  Press ENTER to complete the explode. Your profile highlights as individual objects as shown in the
following image.
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Exercise: Create and Modify Polylines
   
In this exercise, you create a polyline that includes
lines and arcs of varying widths. You also change the
width for all segments of a polyline and then fillet the
polyline and list its properties.  

  
The completed exercise

Completing the Exercise
To complete the exercise, follow the
steps in this book or in the onscreen
exercise. In the onscreen list of
chapters and exercises, click Chapter
11: Creating Additional Drawing
Objects. Click Exercise: Create and
Modify Polylines.

   
1.

  Open M_Polylines.dwg.
 
2.

  In the next few steps, you create a custom
arrow:
■ On the Home tab, click Modify panel >

Polyline.
■ To set the start position, click anywhere to

the right of the existing geometry.
■ Move the cursor straight up.
■ Enter 6000. Press ENTER.
   

 
 
3.

  To create polyline arc segments:
■ Right-click. Click Arc.
■ Move the cursor directly to the right.
■ Enter 3000. Press ENTER.
■ Move the cursor farther to the right.
■ Enter 3000. Press ENTER.
   

 
 
4.

  To switch back to polyline line segments:
■ Right-click. Click Line.
■ Move the cursor straight up.
■ Enter 9000. Press ENTER.
   

 
 
5.

  To add width for the arrowhead:
■ Right-click. Click Width.
■ For starting width, enter 2000. Press

ENTER.
■ For ending width, enter 0. Press ENTER.
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6.

  To finish the polyline:
■ Move the cursor straight up.
■ Enter 3500. Press ENTER.
■ Press ENTER to complete the object .
   

 
 
7.

  To edit the polyline:
■ Select and right-click the blue outline of

the structure.
■ On the shortcut menu, click Properties.
■ On the Properties palette, for the Global

Width, enter 200.
   

 
■ Press ESC to clear the selection.

 
8.

  Click the arc in the dark green lot boundary. The grips are displayed, showing the arc as
part of a polyline. Notice that the far left green
line is not part of the polyline.
   

 
 
9.

  Press ESC.

 
10.

  To add a line to the polyline using the Fillet
command:
■ On the Home tab, click Modify panel >

Fillet.
■ Click the bottom polyline (1) as shown.
■ Press SHIFT and click the far left line (2) as

shown.
   

 
 
11.

  Click the far left line. Notice that it is now part of the original
polyline.
   

 
 
12.

  Grip edit the top left ends of the polyline to
form a corner as shown.
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13.

  To determine the area and perimeter of the
new polyline:
■ On the command line, enter list to start

the List command.
■ Click the top green line.
■ Press ENTER.

 
14.

  In the AutoCAD® Text Window, take note of
the area and perimeter values for this closed
polyline.

 
15.

  Close all files. Do not save.
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Lesson: Creating Splines
 

  
This lesson describes how to create splines with the Spline command.  
In many designs you need to show a smooth free-form line or edge that cannot be defined with
straight lines and arcs, such as the curved edge shown here. Creating smooth curves with splines
provides the look you want while creating an efficient object in the drawing file.  

 
Objectives

  
After completing this lesson, you will be able to:

■ Describe splines.
■ Describe the procedure for creating a spline.
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About Splines
   

Splines are smooth curves that pass through specified points. The curve elements of splines are not
true arcs nor polylines, therefore splines must be handled differently from arcs or polylines with arc
segments. The simplest way to modify the shape of a spline is to use its grips.  

 
Spline Definition

  
Splines are curves which fit through control points using nonuniform rational B-splines (NURBS).
Splines are specified in the drawing through fit points with a fit tolerance that permits a smooth
curvature. Splines can be edited using grips or using the spline edit options. Polylines edited with the
Spline option may resemble a spline, but will still be a polyline unless converted to a spline using the
Spline edit object option. While a splined polyline can be converted to a spline, a spline cannot be
converted to a polyline using basic AutoCAD commands.  

  
You create a spline similar to the way you draw a polyline, specifying each consecutive point or vertex
to determine the shape of the object. Below is an example of a polyline. Each grip highlights a vertex
point. 

 
 

   
When creating a spline, a smooth curve is fit through the control points instead of line segments and
the tangency of each endpoint must be specified. Below is an example of a spline passing through
exactly the same points as the polyline shown above. 
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Spline Examples

  
You can create a spline and close it using the spline edit command. Below is an example of a closed
spline. 

 
 

 
You can create a polyline and use the polyline edit command to create a splined polyline. Then you can
convert it to a spline using the spline edit command with the Object option. Both a splined polyline
and a splined polyline converted to a spline would appear identical, as shown below, however both
would behave differently because they are inherently different objects. It is the tangency of the
endpoints and the tolerances of the control points that keep the curvature smooth and makes a spline
behave a particular way. 

 
 

 
The following example shows the same polyline object splined, converted to a spline object, and
closed using the spline edit command. This object is a closed spline. 

 
 

   
A polyline splined using the Polyline edit option and closed produces a different result. The object
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below is a closed polyline. 
 
 

 
All of the objects in these examples were created using exactly the same control points. One was
created using the spline command the other was created using the polyline command.

 

Creating Splines
   

Using the Spline command, you create smooth curves that pass through or near the points you
specify. The spline passes through the points by default because the initial tolerance value for the
spline is zero.

 
Each spline is a single object in the drawing with all of the defining points, tolerances, and tangencies
stored as part of that spline. The software creates these smooth splines based on nonuniform rational
B-spline (NURBS) curves.   
The following image shows two spline objects. The lower half of the image shows the points that
define the spline.
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Command Access
    

 

  
Spline
   

 
    Command Line: SPLINE
    Ribbon: Home tab > Draw extended panel > Spline

   

 
       

 

  
Edit Spline
   

 
    Command Line: SPLINEDIT
    Ribbon: Home tab > Modify panel > Edit Spline

   

  Note: Grip editing is the easiest way to modify the shape of a spline.
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Spline Key Terms
■ Open Spline: A spline in which the first and last points are not joined together to create a single

continuous flowing spline.
■ Closed Spline: A spline that has the same first and last point and was created with the Close option

of the Spline command.
■ Fit Points: The points in the drawing that you specify when you create the spline.
■ Control Points:

Note: After you refine a spline through its control points, the fit point data is lost.
■ Fit Point Tolerance: A maximum value in drawing units for how closely you must draw the spline to

the fit points you specify. The default value of zero means that the spline must be drawn directly
through the fit point.

■ Start or End Tangencies: For open splines, you can define a vector direction through the first or
last fit point to which the spline must be tangent. For closed splines, the tangency controls the
transition between the first and last defined segments. 

 

Procedure: Creating a Spline
   

The following steps give an overview of creating a spline in a drawing.
  

1.
  On the ribbon, click Home tab > Draw panel > Spline.

 
2.

  Click in consecutive order the locations that the spline must be drawn through.
 
3.

  Right-click. Click Enter.
 
4.

  Do one of the following:
■ Right-click to accept the default tangency through the first point.
■ Move the cursor to define a direction to which the first part of the spline must be tangent. Click.
 The dashed magenta spline shows the path if you accept the default tangency.
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5.

  Do one of the following:
■ Right-click to accept the default tangency through the last point.
■ Move the cursor to define a direction to which the last part of the spline must be tangent. Click.
 The dashed magenta spline shows the path if you accept the default tangencies.
   

 
   
 

Procedure: Editing a Spline
   

The following steps give an overview of editing a spline in a drawing using grips.
  

1.
  With the Command line blank, select the spline.
   

 
 
2.

  Select a grip control point (1) and drag it to a new location (2) and click.
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3.

  When finished adjusting the spline using grips, press ESC.
   

 
   
 

Procedure: Convert Spline to Polyline
   

The following steps give an overview of converting a spline into a polyline.
  

1.
  With the command line blank, select the spline.
   

 
 
2.

  Right-click in an open area of the drawing and click Spline.
   

 
 
3.

  If Dynamic Input is turned off, right-click in an open area of the drawing and click Convert to Polyline. If
Dynamic Input is turned on, the menu automatically appears.
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4.

  On the command line, enter a precision value or press ENTER to accept the default value. The spline is
converted to a polyline.

 
5.

  Select the polyline to view or edit it.
   

 
  



280          ■         Chapter 11: Creating Additional Drawing Objects

 

Exercise: Create a Spline
   
In this exercise, you create a spline through given
points.  

  
The completed exercise

Completing the Exercise
To complete the exercise, follow the
steps in this book or in the onscreen
exercise. In the onscreen list of
chapters and exercises, click Chapter
11: Creating Additional Drawing
Objects. Click Exercise: Create a Spline.

   
1.

  Open C_Spline.dwg.
 
2.

  Set Node as the only running object snap.
 
3.

  Zoom into the area shown.
   

 

 
4.

  On the Home tab, click Draw panel > Spline.
 
5.

  To create the spline:
■ Click to start the spline at the bottom

magenta point.
■ Click each of the remaining seven points,

moving from the bottom to the top.
■ After selecting all the points, right-click.
■ Click Enter.
   

 
 
6.

  Right-click when prompted to specify the start
tangent.
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7.

  To specify the end tangent:
■ Move the cursor up and to the right to

set the tangency through the last point as
shown.

■ Click in the drawing area to complete the
spline.

   

 
 
8.

  Close all files. Do not save.
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Lesson: Creating Ellipses
 

  
This lesson describes how to create ellipses and elliptical arcs with the Ellipse command. The following
image shows examples of ellipses and elliptical arcs in drawings.  
When your design requires an elliptical shape, you can create ellipses and elliptical arcs as easily as
you can create geometry such as lines and circles.  

 
Objectives

  
After completing this lesson, you will be able to:

■ Describes ellipses.
■ Create an ellipse.
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About Ellipses
   

The Ellipse command creates a closed ellipse. The Ellipse Arc command creates a section of an ellipse.
Both objects can be modified in the same way as other drawing objects.  

 
Definition of Ellipse

  
An ellipse is a closed curve generated by four fixed points defining major and minor axes and crossing
at right angles through the center point. 

 
 

 
Each axes endpoint is recognized as a quadrant when using object snap. But notice that an ellipse
quadrant is relative to the axes endpoint, regardless of the angle. 
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Creating an Ellipse Arc
   

You can create an ellipse arc the same way you create an ellipse with parameters that define the
portion of the arc that displays. You could also create an ellipse arc by creating an ellipse and trimming
out a portion of it. You can create an ellipse arc with the Ellipse Arc command using the arc option,
or you can create an ellipse arc using the ellipse arc command. An ellipse arc is still recognized as an
ellipse.
 

  
An ellipse, or oval shape, is a circle tilted on a plane at a specified rotation angle.

 
Example of Ellipses

  
Ellipses and arcs are particularly useful when drawing an isometric view of an object. 

 
 

  
 

Creating Ellipses
   

You use the Ellipse command to create an ellipse object. An ellipse is a smooth curve shape defined
by a major axis and a minor axis thatintersect at their midpoints and are perpendicular to each other.
Youcancreate a full ellipse or an elliptical arc. To create an ellipse, you can either define the start point
and endpoint of one axis and then the endpoint of the other axis, or you can first define the center of
the ellipse and then define the location of the axis endpoints relative to the center.   
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The following image shows an ellipse at the top left and the same ellipse at the bottom left with lines
indicating the major axis and minor axis. The major axis is the longer of the two axes. The image also
shows an elliptical arc with half of the major and half of the minor axis lines.

  

  
There are three procedures you can follow to create an ellipse or elliptical arc. The procedure you use
depends on what you want to create and the data you haveavailable. 

 

Command Access
    

 

  
Ellipse/ Ellipse Arc
   

 
  

 
    Command Line: ELLIPSE
    Ribbon: Home tab > Draw panel > Center/Axis, End/Elliptical Arc  

 
   
 

Command Options
   

Use these Ellipse command options to create an ellipse or elliptical arc.
 

  
Option

  
Description

  Center
  Use this option to create an ellipse by defining the center point of the ellipse and
then one endpoint for each axis.
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Option

  
Description

  Arc
  Use this option to add additional prompts to the command sequence to create an
elliptical arc or a full continuous ellipse.

  Axis, End
  Use this option to create and ellipse or an elliptical arc. The first two points of the
ellipse determine the location and length of the first axis. The third point determins
the distance between the center of the ellipse and the end point of the second axis.

   
 

Procedure: Creating an Ellipse
   

The following steps give an overview of creating an ellipse by defining the axis endpoints.
  

1.
  On the ribbon, click Home tab > Draw panel > Ellipse.

 
2.

  Click to specify the first axis endpoint (1) and the other axis endpoint (2).
   

 
 
3.

  Click to specify the distance to the other axis endpoint (3).
   

  The completed ellipse.
   

  Note: To use the other Ellipse options, follow the command line prompts. Right-click to specify the
options from the shortcut menu or enter the capitalized letter on the command line.

   



Lesson: Creating Ellipses       ■       287

 

Procedure: Creating an Elliptical Arc
   

The following steps give an overview of creating an elliptical arc. The first few steps are identical to
creating a ellipse.

  
1.

  On the ribbon, click Home tab > Draw panel > Ellipse Arc.
 
2.

  Click to specify the first axis endpoint (1) and the other axis endpoint (2).
   

 
 
3.

  Click to specify the distance to the other axis endpoint (3).
   

 
 
4.

  Move the cursor to specify the start angle position (4).
   

 
 
5.

  Move the cursor to specify the end angle (5). Notice that the polar angle is set to 45 degrees.
   

  Note: The order in which the start and end angle are specified will determine which part of the ellipse is
removed.
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Exercise: Create Ellipses
   
In this exercise, you use the Ellipse command
to create two full ellipses using two different
techniques, trim one of the ellipses so that it
becomes an elliptical arc, and then create an elliptical
arc with the Ellipse command.  

  
The completed exercise

Completing the Exercise
To complete the exercise, follow the
steps in this book or in the onscreen
exercise. In the onscreen list of
chapters and exercises, click Chapter
11: Creating Additional Drawing
Objects. Click Exercise: Create Ellipses.

   
1.

  Open C_Ellipse.dwg.
   

 
 
2.

  Zoom into the unfinished area of the top view.

 
3.

  To create an ellipse to represent the top of a
hole from the inclined surface:
■ On the Home tab, click Draw panel >

Ellipse.
■ Click the first point at the bottom

intersection, as indicated by the bottom
arrow in the following image.

■ Click the second point at the top
intersection, as indicated by the top arrow
in the image.

■ Click the third point at the right
intersection, as indicated by the right
arrow in the image.

   

 
 
4.

  To create an ellipse to represent the bottom of
the hole from the inclined plane:
■ On the Home tab, click Draw panel >

Ellipse.
■ Right-click. Click Center.
■ Click the intersection on the left of the

previous ellipse, as shown.
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5.

  Move the cursor straight up and click at the
intersection.
   

 
 
6.

  Click at the center of the first ellipse.
   

 
 
7.

  To trim part of the second ellipse:
■ Start the Trim command.
■ Click the first ellipse as the cutting edge.
■ Click the far left side of the second ellipse

as the object to trim.
 The left ellipse is trimmed to an elliptical arc,
as shown.
   

 
 
8.

  To create an ellipse in the top view to
represent the outer edge of the inclined
surface:
■ On the Home tab, click Draw panel >

Ellipse.
■ Right-click. Click Arc.
■ Right-click. Click Center.

 
9.

  Click the center of the first ellipse.
   

 

 
10.

  To define the endpoint of the first axis, snap to
the end of the horizontal line.
   

 
 
11.

  To define the endpoint of the second axis, snap
to the intersection on the right.
   

 
 
12.

  To specify the start angle, snap to the end of
the horizontal line.
   

 
 
13.

  To specify the end angle position, snap to the
end of the horizontal line on the top.
   

 
 
14.

  Freeze layer construction. Zoom to display
your completed drawing.

 
15.

  Close all files. Do not save.
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Lesson: Using Tables
 

  
This lesson describes how to create and modify table styles, and how to create tables using the
Tablestyle and Table commands.  
You can use tables in your drawings to meet a number of needs. For example, you might use them to
show revisions in the drawing, or to create tabulated dimensions, as shown.   
The following illustration represents a tabular dimension table.

  

 
Objectives

  
After completing this lesson, you will be able to:

■ Describe tables.
■ Use the Tablestyle command to create table styles.
■ Create tables and enter values in the table cells.
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About Tables
   

You can use tables to organize data into columns and rows. Data can be entered in the table or
extracted from objects including blocks that contain special attributes. When you place information
into tables, you can format rows and columns and apply formulas.  

 
Definition of a Table

  
Tables contain rows and columns which create an array of individual cells that are designated by the
row number and column letter in which the cell resides.  

  
A table is a database that exists within the AutoCAD program.
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Example of Using Tables

  
You use the Table command to insert a table into your drawing. You specify the number of rows and
columns, the heading style, and other parameters. You can create a variety of table styles to use
within your drawing. The Table and Table Style commands insert and create a database that is unique
to this program. 

 
 

  
This is not the same as inserting an external database from another program using OLE Objects
(Object Linking and Embedding), which is not covered in this course. 
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Creating Table Styles
   

Table styles are similar to the concept of dimension styles because they set the format for tables in the
drawing. You create and manage them with the Tablestyle command.

 
You can have more than one table style, but each new drawing you create contains only one table style
called Standard. If you create additional table styles, use the Table Styles list on the Styles toolbar to
set the current table style.

 
Like dimension styles, if you make a change to a table style, any table using that style in the drawing
updates to reflect the changes.   
The following illustration demonstrates the effect of modifying a table style.
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Command Access
    

 

  
Table Styles
   

 
    Command Line: TABLESTYLE
    Ribbon: Home tab > Annotation extended panel > Table Style

   

 
    Ribbon: Annotate tab > Tables panel > Table Style
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Table Style Dialog Box
   

You use the Table Style dialog box to create, modify, and manage table styles.
  

      

 

  Select the table style to set it as current, to base a new style on, or to modify.

   

 

  Click to make the selected style current.

   

 

  Click to create a new style based on the selected style.

   

 

  Click to edit the selected style.
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New Table Style Dialog Box
   

Use the New Table Style dialog box to set the properties for a new table style.
  

      

 

  Use the default table style or one of your own as the basis for the new style.

   

 

  Select the table direction: up or down.

   

 

  Refer to the preview as you make modifications to the style.

   

 

  Create and save your styles for the Data, Header, and Title cells.

   

 

  Set the properties for Data, Header, and Title cell styles.

   

 

  Set your margins for the chosen cell style. Different margins can be set for the Data, Header, and Title
cells.
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Procedure: Creating Table Styles
   

The following steps give an overview of creating table styles.
  

1.
  Start the Tablestyle command.

 
2.

  In the Table Style dialog box, click New.
 
3.

  Enter a name for the new table style. Select an existing style in the Start With list. Click Continue.
 
4.

  In the New Table Style dialog box, adjust the general, text, and borders properties in the Cell styles area
for the Data, Header, and Title cells. Click OK.

 
5.

  In the Table Style dialog box, double-click the new table style to make it the current style.
  
 

Table Style Key Points
■ Table styles control the appearance of tables.
■ You can have more than one table style, but only one table style can be current.
■ Each new drawing contains a table style called Standard.
■ If you make a change to a table style, existing tables using that style update to reflect the changes.

 

Creating Tables and Entering Table Data
   

There are three main steps to inserting a table. First, select the table style; second, place the table
in the drawing; and third, enter data in the appropriate cells. When you select the style in the Insert
Table dialog box, you can also set the number and size of the columns and data rows.

 
You double-click a cell to enter data using the In-Place Text Editor, similar to the way you edit multiline
text. To navigate the cells, use standard keyboard navigation techniques such as the TAB or ARROW
keys. 

 
 

 
Single-click a cell to access the table formatting options. 
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Command Access
    

 

  
Table
   

 
    Command Line: TABLE
    Ribbon: Home tab > Annotation panel > Table

   

 
    Ribbon: Annotate tab > Tables panel > Table

   

 
   
 

Insert Table Dialog Box
   

To insert a table, you first select the table style to use for the new table and then select whether the
table should be inserted at a specific point or by using a window. Under Column & Row Settings, you
adjust the options for the number of columns, column width, number of data rows, and row height.
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  Select your desired table style or click to create a new style.

   

 

  Select your insert option.
■ Start from an empty table.
■ From a data link. Use this option to select an existing spreadsheet to link to as a table.
■ From object data in the drawing. Use this option to extract data from an existing object in your

drawing.
   

 

  Choose to insert your table by a corner point or by selecting a windowed area to fit into.

   

 

  Choose the number of columns and rows, the column width, and the row spacing.

   

 

  Select a cell style for the first row cell, the second row cell, and all remaining cells.

   

 

  Observe your preview window to verify your settings.

   
 Using the Specify Window option, you can dynamically adjust the number of cells

in the table based on the size of the table window you specify. When you select this
option, the options for the number of columns and the row height are set to Auto
and you can specify the column width and number of rows.
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Warning!
 

In the Insert Options area, the From Object Data In The Drawing (Data Extraction)
option is not available in AutoCAD LT®.

  
 

Procedure: Inserting a Table
   

The following steps give an overview of inserting a table.
  

1.
  Start the Table command.

 
2.

  In the Insert Table dialog box, select the table style. Set the Insert Behavior and Column and Row
Settings options. Click OK.

 
3.

  Specify an insertion point for the table. If you used the Specify Window option, click two points to
define the table size.
   

  The first cell in the table is automatically activated for editing.
   
 

Procedure: Navigating and Entering Table Data
   

The following steps give an overview of navigating and entering data in a table.
  

1.
  Double-click a cell in the table to start the In-Place Text Editor. Enter the required values in the cell.

 
2.

  To navigate to other cells, you can use the TAB key to move to the right, SHIFT+TAB to move to the left,
or the ARROW keys to navigate in any direction.

 
3.

  You can enter standard spreadsheet-style formulas in the cells to reference other cells in the table.
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4.

  You can copy a formula or value from one cell to multiple cells using the Auto-Fill grip. Click the cell to
be copied and then click the cell's Auto-Fill grip (1). Drag your mouse up or down over the cells to copy
and click in the last cell to complete the copy (2).
   

 
 
5.

  To finish editing the table, press ESC.
   

 
  
 

Table Data Guidelines
■ You can enter formulas in table cells.
■ Cell formulas can range from simple math formulas to formulas referencing other cells, even cells

in other tables in the drawing.
■ Use fields to extract data from objects in your drawing. For example, you can place the area of a

closed polygon into a cell.
■ Use the Auto-Fill grip to copy a formula or value from one cell to multiple cells.
■ Use standard Windows Cut, Copy, and Paste commands to efficiently populate your cells.
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Exercise: Create a Dimension Table
   
In this exercise, you create a new table style using the Tablestyle command. You create a new table containing
tabulated dimensions for the design. You enter static values in the table as well as a formula that you copy to
other cells.  

  
The completed exercise

Completing the Exercise
To complete the exercise, follow the
steps in this book or in the onscreen
exercise. In the onscreen list of
chapters and exercises, click Chapter
11: Creating Additional Drawing
Objects. Click Exercise: Create a
Dimension Table.

   
1.

  Open M_Create-Table.dwg.
 
2.

  To create a new table style and make it
current:
■ On the Annotation panel (or Annotate tab

> Tables panel), click Table Style.
■ In the Table Style dialog box, click New.
■ In the Create New Table Style dialog box,

enter NT-2.5.
■ Click Continue.
  

 

 
 
3.

  To specify text height for data cells:
■ Click the Data Cell style.
■ Click the Text tab.
■ For Text Height, enter 2.5.
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4.

  To specify the text height for column cells:
■ Click the Header cell style.
■ Click the Text tab.
■ For Text Height, enter 3.5.
■ Click OK.
   

 
 
5.

  To make the new table style current:
■ In the Table Style dialog box, double-click

the new style.
■ Click Close.
   

 

 
6.

  To place a table in the drawing:
■ Start the Table command.
■ In the Insert Table dialog box, under

Insertion Behavior, click Specify Insertion
Point.

■ Under Column & Row Settings, adjust the
options as shown.

■ Under Set Cell Styles, adjust the options as
shown to create a table with no title row.

■ Click OK.
   

 
 
7.

  Specify an insertion point for the table as
shown.
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8.

  The In-Place Text Editor appears with the first
cell in the table ready for editing:
■ Enter PART NAME and press TAB.
 Tip: Press ALT+ENTER to create a second line in
the cell.
■ Enter A and press TAB.
■ Enter B and press TAB.
■ Enter C and press TAB. Your table should

appear as shown.
   

  Note: If you need to move the table, select the
table, and then move it by selecting the top
corner grip.

 
9.

  Zoom in to the table.
 
10.

  To add additional data to the table cells:
■ Double-click the empty cell under PART

NAME.
■ Enter B762, and then press DOWN ARROW.
■ Continue entering values in the cells as

shown, pressing DOWN ARROW to move
to the cell below.

   

 

 
11.

  Continue entering values in the table:
■ After entering the data in the last row,

press TAB to move to the next column.
■ Press UP ARROW to move to the top of the

table.
■ Enter the values as shown for Column A.
 Tip: The numbers are the same as the PART
NAME column without the B prefix.
   

 
 
12.

  Enter a formula in a cell:
■ Press TAB to move to the last row in the

next column.
■ Enter =B6-76. This subtracts 76 from the

value of cell B:6.
 Note: Do not confuse the labels in the table
with the actual cell letter or number. Functions
must reference the actual cell location.
■ Click OK to close the In-Place Text Editor.
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13.

  To copy the contents of one cell to others:
■ Click the cell containing the formula to

highlight it.
■ Click the Auto-Fill grip (1).
■ Move your cursor upward (2).
■ Click anywhere in the top cell (3).
 The copied formula is pasted into the other
cells, maintaining reference to relative cell
numbers.
■ Press ESC to clear the selection.
   

 
 
14.

  To add the remaining data to column C:
■ Double-click the first cell in the last

column.
■ Enter the values as shown.
   

 

 
15.

  Compare the values in your table to the values
shown.
   

 
 
16.

  Zoom to the drawing extents.
 
17.

  Close all files without saving.
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Challenge Exercise: Architectural
 

  
In this exercise, you use what you learned about creating drawing objects to create a table, a closed
polyline for calculating an area, and spline topographic lines.

 

 You have the option of completing this exercise using either imperial or metric units.
Select one version of the exercise to complete the steps.

  

  
The completed exercise

Completing the Exercise
To complete the exercise, follow the steps in this book or in the onscreen exercise.
In the onscreen list of chapters and exercises, click Chapter 11: Creating Additional
Drawing Objects. Click Challenge Exercise: Architectural Metric.
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Metric Units
  

1.
  Open the drawing you saved from the previous challenge exercise, or open M_ARCH-Challenge-
CHP11.dwg.

 
2.

  Set layers and create contours.
■ Thaw and set current the existing layer, Topo.
■ Draw smooth curved contours from node to node as shown.
   

 
 
3.

  Calculate the square area of the lot this fire station sits on. The lot is shown with the blue grips active in
the following image.
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4.

  Place a title block on the layout.
■ Activate the Plan View layout.
■ Insert the block Titleblock centered on the layout.
■ Add text to the title block as shown.
   

 
 
5.

  Add and configure two viewports.
■ A view of the elevation detail at a scale of 1:100.
■ The key plan in the upper-right corner of the title block, zoomed to fit.
 For each of the viewport configurations, adjust the layer display to achieve the results shown.
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6.

  Create a table showing the following Room Schedule data:
■ NUMBER - NAME - AREA
■ 221 - SLEEPING QUARTERS - 21 m2
■ 201 - READY ROOM - 36 m2
■ 202 - LOCKER ROOM - 14 m2
■ 203 - EXERCISE ROOM - 23 m2
■ 205 - DINING ROOM - 24 m2
■ 206 - KITCHEN - 6 m2
■ 207 - MEN'S TOILET ROOM - 11 m2
■ 208 - WOMEN'S TOILET ROOM - 14 m2
   

 
 
7.

  Save and close the drawing.
   
 

Imperial Units
  

1.
  Open the drawing you saved from the previous challenge exercise, or open I_ARCH-Challenge-
CHP11.dwg.

 
2.

  Set layers and create contours.
■ Thaw and set current the existing layer, Topo.
■ Thaw the layer, Site - Concrete.
■ Draw smooth curved contours from node to node as shown.
   

 
 
3.

  Calculate the square area of the lot this fire station sits on. The lot is shown with the blue grips active in
the following image.
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4.

  Place a title block on the layout.
■ Activate the Plan View layout.
■ Insert the block Titleblock centered on the layout.
■ Add text to the title block as shown.
   

 
 
5.

  Add and configure two viewports.
■ A view of the elevation detail at a scale of 1/8" = 1'.
■ The key plan in the upper-right corner of the title block, zoomed to fit.
 For each of the viewport configurations, adjust the layer display to achieve the results shown.
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6.

  Create a table showing the following Room Schedule data:
■ NUMBER - NAME - AREA
■ 221 - SLEEPING QUARTERS - 236 SQ/FT
■ 201 - READY ROOM - 386 SQ/FT
■ 202 - LOCKER ROOM - 150 SQ/FT
■ 203 - EXERCISE ROOM - 383 SQ/FT
■ 205 - DINING ROOM - 134 SQ/FT
■ 206 - KITCHEN - 200 SQ/FT
■ 207 - MEN'S TOILET ROOM - 114 SQ/FT
■ 208 - WOMEN'S TOILET ROOM - 149 SQ/FT
   

 
 
7.

  Save and close the drawing.
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Challenge Exercise: Mechanical
 

  
In this exercise, you use what you learned about creating drawing objects to represent an edge on a
part, create a border around a view, and create a closed loop to calculate area. You will also update
your layout including a titleblock.  

  
The completed exercise

Completing the Exercise
To complete the exercise, follow the steps in this book or in the onscreen exercise.
In the onscreen list of chapters and exercises, click Chapter 11: Creating Additional
Drawing Objects. Click Challenge Exercise: Mechanical.

   
1.

  Open the drawing you saved from the previous challenge exercise, or open M_MECH-Challenge-
CHP11.dwg.

 
2.

  In the side views for both the base part and assembly, the cut for the hole is too high with an arc. Draw
the representation correctly using an ellipse.
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3.

  Change the border around the detail view from a circle to a spline shape.
   

 
 
4.

  Calculate the square millimeter area of the two flat surfaces in the front view of the base part.
   

  (Value Check: The area of the lower face = 17185.9487)
 
5.

  Update the Parts layout.
■ Switch to the Parts layout.
■ Insert the Titleblock block.

 
6.

  Save and close the drawing.
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Chapter Summary
 

  
To meet your design needs, you can create multiple segments of lines and arcs as a single polyline,
you can create smooth curved geometry as splines or ellipses, and you can add tables to your
drawings.  
Having completed this chapter, you can:

■ Create and edit polylines with the Polyline command.
■ Create smooth curves with the Spline command.
■ Create ellipses and elliptical arcs with the Ellipse command.
■ Create and edit basic tables and use table styles to control their appearance.
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Chapter

12

Plotting Your Drawings
 
  

The final step of the drawing process is to communicate the design to others through both paper and
electronic media.

 
Objectives

  
After completing this chapter, you will be able to:

■ Create and activate page setups.
■ Plot design geometry from model space or from a layout.

 

Standard Object Snap and Status Bar Settings
 Before completing the exercises in this chapter, refer to the "Settings for the

Exercises" section in the Introduction in Volume 1.
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Lesson: Using Page Setups
 

  
This lesson describes how to activate and save page setups in the layout environment.  
Since you may need to output data to a variety of devices and in different forms at different times,
using saved page setups can save you valuable time. You can also save time by selecting saved page
setups when outputting multiple sheets from a number of files at once with the Publish command.
However, the Publish command is not covered in this lesson.  

 
Objectives

  
After completing this lesson, you will be able to:

■ Apply a page setup to an existing layout.
■ Create and modify a page setup.
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Applying Page Setups to Layouts
   

Named page setups are useful for easily plotting a layout in different ways and for quickly configuring a
layout. Each time you create a layout or execute the Plot command, you can set various configuration
options and save these settings as a named page setup. Using Page Setup Manager, you can then
activate a page setup for a layout or modify your page setups. When you create a page setup in the
layout environment, you can only make that page setup current for layouts, not for model space.
However, you can also create page setups for your model space plotting needs. 

 

Command Access
    

 

  
Page Setup
   

 
    Command Line: PAGESETUP
    Application Menu: Print > Page Setup
    Shortcut menu: Right-click the Model or Layout tab, click Page Setup Manager

   

 
    Ribbon: Output tab > Plot panel > Page Setup Manager
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Page Setup Manager Dialog Box
   

In the Page Setup Manager, you can make an existing page setup current, modify page setups, create
new page setups, and import a page setup from a different drawing file. The current page setup is the
one that takes effect when you execute the Plot command.

  

 
Page Setup Manager Access Options

  
When you click the Page Setup Manager from the ribbon you will be creating settings for the current
drawing layout or model space. To access the Page Setup Manager from a selected layout or model
space, there are two options.   

 

 

Option #1: Make the Layout and Model Space tabs visible:
■ Right-click in the drawing window or Command line area and select Options.   

 
■ In the Options dialog box, select the Display tab.
■ Click to place a checkmark before Display Layout and Model Tabs.   



Lesson: Using Page Setups         ■        319

 

■ Select Apply and Close the Options dialog box.
■ Select the desired layout or model tab.
■ Right-click to access Page Setup Manager.

 
■   
Option #2: Activate Page Setup from the Quick View Layouts or Quick view Drawings button on the
status bar:
■ Double-click the Quick View Layouts, or click Drawings.
■ Select the desired Layout (2) and right-click.
■ Select the Page Setup Manager (3)
 

 
 

Procedure: Applying a Saved Page Setup to a Layout
   

The following is an overview of making a saved page setup current in an existing layout.
  

1.
  Select the layout tab.

 
2.

  Right-click the tab. Click Page Setup Manager.



320          ■         Chapter 12: Plotting Your Drawings

 
3.

  In the list of saved page setups in Page Setup Manager, double-click the name of the page setup.
   

 
 
4.

  Click Close.
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Practice Exercise: Applying Page Setups to Layouts  
In this practice exercise, you create a simple Page
Setup based on some very simple settings in the Page
Setup Manager, then you apply that new setup to
your drawing. In the next section, you learn more
about creating and modifying page setups using the
Page Setup Manager.   
1.

  Open a new drawing using the acad.dwt
template.

 
2.

  Create some simple geometry.
   

 
 
3.

  To Access the Page Setup Manager for the
Model tab:
■ Select the Model tab and right-click (1).
■ Click Page Setup Manager.
   

  Note: If the Model tab is not visible, right-click
in the Command line area. Click Options. In the
Options dialog box on the Display tab, under
Layout elements, select the Display Layout and
Model tabs check box.

 
4.

  To Create a New Page Setup:
■ In the Page Setup Manager, select New (1).
■ For the New page setup name, enter

TEST_PRINT (2).
■ Click OK.
   

 
 
5.

  To create some simple settings in the Page
Setup dialog box:
■ Under Printer/Plotter, select a printer from

the Name list.
■ Select a common paper size from the Paper

Size list.
■ Under Plot area, select Extents from the

What to Plot list.
■ Under Plot Offset, select Center the Plot.
■ Under Plot Scale, select Fit to Paper.
■ Select Landscape for the Drawing

Orientation.
■ Click Preview. Confirm that the drawing is

displayed in the preview window. Press to
exit the preview window.

■ Click OK to exit the Page Setup dialog box.
 
6.

  To make the New Page Setup current:
■ In the Page Setup Manager, select

TEST_PRINT.
■ Click Set Current.
■ Close the dialog box.
 Now when you print from the Model tab, the
drawing prints according to the current page
setup.
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Creating Page Setups
   

Once your layouts are created, you should assign a page setup to them. You can import page setups
from your template files or other drawings. If necessary, either modify an existing setup or create a
new one. When creating a new page setup, you need to knowthe printer/plotter device, paper size,
plot scale, and many other plotproperties. 

 
New Page Setup

   
In Page Setup Manager, click New. The New Page Setup dialog box opens. Here, you can start with an
existing setup or create a new one from the default <None>.
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Page Setup Dialog Box
   

The Page Setup dialog box is displayed when you are creating a new page setup or when you click
Modify in the Page Setup Manager.

  

The Page Setup dialog box is almost identical to the Plot dialog box. Use the Page Setup dialog box to
select and define the following items:      

 

  Select the plotter or plotter configuration file to use.

   

 

  Select the paper size to output to.

   

 

  Select the area of the file that should be plotted. You can select to plot the current display, drawing
extents, or specify a window. When you create a page setup on the model tab, you can also specify to
plot the limits of the drawing. When you create a page setup on the layout tab, you can specify to plot
the entire layout.

   

 

  Select where the geometry is positioned on the paper relative to the paper's origin point.

   

 

  Select the scale factor to use when outputting the geometry.
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  Select the plot style table to use to further control the appearance of the geometry on the paper or in
the output file.

   

 

  Determine whether a viewport should be shaded and, if so, the quality of that shading.

   

 

  Select additional plot options, such as whether to plot using plot styles, and the order for calculation
when outputting the geometry.

   

 

  Select the orientation of the geometry on the paper.

   
 

Procedure: Creating and Saving a Page Setup
   

The following steps give an overview of creating and saving a page setup.
  

1.
  Select the model space or a layout.

 
2.

  On the Application Menu, click Print > Page Setup Manager.
 
3.

  In the Page Setup Manager dialog box, click New.
 
4.

  In the New Page Setup dialog box, enter a name for the new page setup. Click OK.
   

 
 
5.

  Set the options in the Page Setup dialog box as required. Click OK. You can now make the page setup current in any layout.
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Exercise: Create and Activate Page Setups
   
In this exercise, you activate a saved page setup for an
existing layout, then create another page setup that
you can use in any layout.  

  
The completed exercise

Completing the Exercise
To complete the exercise, follow the
steps in this book or in the onscreen
exercise. In the onscreen list of
chapters and exercises, click Chapter
12: Plotting Your Drawings. Click
Exercise: Create and Activate Page
Setups.

   
1.

  Open M_Page-Setup.dwg.
 
2.

  To access the Page Setup Manager:
■ Right-click the Layout2 tab.
■ Click Page Setup Manager.
 In the Page Setup Manager, under Selected
Page Setup Details, notice that the layout has
no plotter selected and has a plot paper size of
420 x 594 mm.

 
3.

  To make a page setup current:
■ Double-click For Book of Examples.
 This page setup is set to current and
specifies to use the DWF6 ePlot.pc3 plotter
configuration and a paper size of 297 x 210
mm. The paper size is reflected in the layout
display.
■ Click Close.
   

 
 
4.

  Click the Layout1 tab to make that layout
active.

 
5.

  On the ribbon, click Output tab > Plot panel >
Page Setup Manager.

 
6.

  To start creating a new layout:
■ In the Page Setup Manager, click New.
■ For the New Page Setup Name, enter A4

(Portrait) - Check Plot.
■ Click OK.

 
7.

  To specify a paper size:
■ Select ISO A4 (210.00 x 297.00 MM) from

the Paper Size list.
■ Click OK.
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8.

  To set a current page setup:
■ In the list of page setups, double-click A4

(Portrait) - Check Plot.
■ Click Close.
   

 
 
9.

  Zoom to the extents of the drawing to see all
the geometry in the layout. This layout was originally set to plot at 1:1 on
an A1 size sheet of paper. It will not fit on A4
paper at 1:1. Therefore, you need to change
the scale factor for this page setup.
   

 
 
10.

  To access the Page Setup Manager:
■ Right-click Layout1.
■ Click Page Setup Manager.

 
11.

  To modify an existing page setup:
■ Select A4 (Portrait) - Check Plot from the

Page Setups list.
■ Click Modify.

 
12.

  To specify plot options:
■ Under Plot Area, select Extents from the

What To Plot list.
■ Under Plot Scale, select the Fit to Paper

option.
■ Click OK.
■ Click Yes, when prompted to update the

page setup.
   

 
 
13.

  Click Close.
   

 
 
14.

  Close all files without saving.
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Lesson: Plotting Drawings
 

 

 

In this lesson, you learn how to plot from a layout or model space to paper or to an electronic file.  
Outputting your drawings is a crucial step in communicating your design ideas to others.  

 
Objectives

  
After completing this lesson, you will be able to:

■ Identify the environments from which you can output data.
■ Explain the reason for and characteristics of plotting from model space.
■ State the characteristics of plotting from layouts.
■ Plot drawings from model space or from a layout.
■ Use the Preview command to view what you plot.
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About Plotting Environments
   

You create drawings to store design data and to communicate it to others. The communication
occurs when you output the data on paper or to an electronic file. The terms print or plot are used
interchangeably to describe the process of outputting the data stored in a drawing file. Design Web
Format (DWF) is the most common and versatile electronic file format you can use to output and
distribute your drawings.

 
There are two methods for outputting data. One is to plot from model space and the other is to plot
from layouts. Each method has its own list of items to configure and control to achieve the desired
output. No matter which method you use, your design data is created in model space and remains at
full scale, also referred to as real world size.

 
Plotting from the drawing Layout or from the drawing Model

  
The following illustration shows the drawing Layout. You select a layout tab (1) to activate the drawing
layout. The Layout displays the paper (2), the plot area designated by the a dashed line (3), the
drawing viewports (4) and the scaled view of the drawings in those viewports. The paperspace icon is
visible in the left corner (5).  
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The illustration below shows the drawing model. You select the Model tab (1) to activate model space.
This is the environment where you create your drawing. If the UCS icon is on, it is displayed, typically in
the left corner (2).

  

 
Plot or Publish

  
When you output data from a single layout in a drawing file, you usually use the Plot command. When
you need to output data from multiple layouts within one or more drawings, you can use the Publish
command. Publishing gives you the ability to create a list of drawings to plot, select what to plotfrom
multiple files, and save that selected information as a Drawing Set Descriptions (DSD) file. Using a DSD
file, you can easily open and plot the data from the drawing list without having to reiterate what and
how to plot. 

 

Key Terms Defined
   

Below are some key terms associated with plotting.
 

  
Term

  
Description

  Plot
  The act of outputting the active drawing file to a plotter, printer, or file.

  Model Space
  The area of the file where you draw your model at full scale after you decide what
one unit in the drawing represents in the real world (millimeters, centimeters, inches,
feet, and so on).

  Layout
  An environment used to set up your data for output. You can specify the paper size,
add a title block, display multiple views of the drawing at multiple scales, and add
notes specific to that plotted sheet.

  DWF
  A highly compressed file that contains the output data for others to view
electronically.
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Example of When to Plot

  
While the design industry is migrating toward a paperless process, westill require design output to
paper and compressed image files. You use the Plot command to create this output. As you work on
your design, you may need to send a check plot to the laser printer in your work area. You can use this
printed output to discuss the design with others or fax it to a colleague to review. You may want to
post the same data to your Web site for others to view electronically. In this case,you would plot the
file to DWF format for posting to your Web site.

 

Plotting from Model Space
   

The main reason to plot from model space is to have a paper printout of a specific area of your design
so that you can review it. The following image is an example of geometry in model space that can be
plotted. 

 
 

 
When you plot from model space, all the geometry that resides in the model space environment can
be printed. If you want to print a specific part of your drawing, you have to specify the area to plot.
If you want to print your drawing at a specific scale, you have to specify the plot scale. If you want to
have a border and title block around the geometry in model space, you have to scale it up or down
based on the plot scale you are using.

 
For example, a drawing that will plot at a scale of 1:20 requires a border and title block that are
created scaled up 20 times. When you plot your drawing at a scale of 1:20, the border, title block and
drawing will be scaled down to fit the paper.
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To plot text and dimension objects at a specific size from model space, choose the annotative property
for each style and set the Annotative scale for the drawing. The images below show the details of the
Text Style and Dimension Style dialog box (Fit tab) where you can choose the Annotative property. 

 
 

   
The following image shows where you can access the Annotative Scale list on the status bar.

  

 
Plotting Annotations

  
When you plot from model space, all objects appear with the same relative scale as they appear
on screen. Objects that have the annotative property assigned to them display and plot using the
annotative scale that is currently set on the status bar. So, for annotative objects, you need to adjust
the annotation scale to a value that provides a legible annotation size on screen before plotting your
drawing.

 
If you do not assign the annotative property to objects such as Text Style and Dimension Style, you
have to create the text and dimension at a height and fit that are proportionate to the plot scale in
order for them to be legible.

  
 

Procedure: Plotting from Model Space
   

The following steps give an overview of plotting a windowed area of your drawing from model space.
  

1.
  Start the Plot command. In the Plot dialog box under Plot Area, select Window from the What to Plot
list.
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2.

  When prompted to specify a window for printing, drag a window around an area to be plotted, as
shown.
   

 
 
3.

  Adjust Paper size, Plot scale, and other parameters as needed in the Plot - Model dialog box.
 
4.

  Click Preview to view and plot your selected area.
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Guidelines for Plotting from Model Space
■ Use the annotative property for text and dimension styles and choose the annotation scale for

your plot. Annotations automatically scale themselves in the drawing according to the annotation
scale you select.

■ When creating a text style using the Annotative property, you can specify the paper text height.
This height is multiplied by a scale factor that is determined by the annotation scale.

■ You can create different text styles with different text heights and fonts for your annotations; for
example, you could create one style for notes and dimensions and another style for titles.

■ The most common plot areas you use when plotting from Model space are Extents and Window.
■ Use the Center plot option to keep uniform white space around your plotted output.
■ The plot area varies according to the printer/plotter selected.
■ Choose the Fit to Paper plot scale option to check your drawing when creating a plot from model

space.
■ If your title block or border is drawn full scale, and your plot scale is not 1:1, you must scale the

title block according to the plot scale. For example, if the annotation scale is 1:10 your scale factor
is 10. If the annotation scale is & #188;” – 1’0”, your scale factor is 48 (4 x 12”).

■ You can retain the Plot settings in the Page Setup Manager. Right-click the Model tab to access the
Page Setup Manager.

 

Plotting from Layouts
   

Use layouts to set up the information you want to output. For each layout, you select the size of paper
you want and set the plot scale to 1:1. In the paper layout, one unit represents the paper distance on a
plotted sheet and the units are either millimeters or inches.

 
Since the geometry is not scaled during the plot process, you can add the border and any textual notes
on the layout at the desired output size. For example, if drawing notes are supposed to be 1/8" tall,
you set the text height to 1/8".

 
Another advantage of layouts is that you can create multiple views of model geometry on the same
sheet and display them at different scales or create multiple layouts to display different views of the
model space geometry. Additionally, one instance of annotative objects, such as text or dimensions,
can be displayed at the same size in several views of different scales.
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Procedure: Plotting from a Layout
   

The following steps give an overview of plotting a layout.
  

1.
  Start the Plot command and verify that the Plot area is set to Layout. Also, verify that your plot scale is
set to 1:1. Your paper size was also set while creating the layout so it should not need to be changed.
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2.

  Your layout should have a page setup, and the plotter should already be assigned using the Page Setup
Manager from the Layout tab. Verify that these settings are as you want them. Click Preview to review
your output. If your preview looks correct, right-click, and click Plot. If you need to make a change,
right-click, click Exit to return to the plot dialog box and make your changes.
   

 
  
 

Guidelines for Plotting from a Layout
■ Create the design geometry in the model environment at full scale.
■ Set the paper size for the layout and a plot scale of 1:1 for the paper using the Page Setup

Manager.
■ The scale factor of the model geometry on the layout is determined by the scale factor that you set

for each viewport.
■ For text and dimensions created in model space, you should use Annotative styles. The Annotative

styles scale according to the selected viewport scale. Annotations plot at the text size you choose
when you set up your Annotative styles.

■ You can create multiple viewports to display different sections of the model geometry or show it at
different scales.

■ On a layout with multiple viewports, you can freeze layers in selected viewports independently to
create different displays of the same geometry.

■ Insert the border and title block on the layout at full scale.
■ When plotting from the Layout, make sure the Paper space is active and not the Model in the

viewport.
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Plot Command
   

The Plot command prints data from the active drawing to a plotter, printer, or file using the settings in
the Plot dialog box. 

 

Command Access
    

 

  
Plot
   

 
    Command Line: PLOT, PRINT
    Application Menu: Print or Print > Plot
    Quick Access Toolbar: Plot

   

 
    Ribbon: Output tab > Plot panel > Plot
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Plot Dialog Box
   

Click the Expand button at the bottom-right of the Plot dialog box to access more options.
  

      

 

  Use this option to select a saved page setup with plot options already set or to add the current
configuration as a saved page setup.

   

 

  Select a printer from this list to specify where to send the plot. You can select system printers or
application-specific plotter configuration (PC3) files.

   

 

  Select a paper size from the list available for the selected plotting device.

   

 

  Specifies where the plot geometry will come from. When plotting from a layout, area options include
Display, Extents, Window, View, and Layout. When plotting from model space, you can choose the Limits
option.

   

 

  Use this to set the ratio of printed units to geometry units. By plotting at a specific scale, you can use a
scale to measure distances on the printed copy. If your drawings do not need to be at a set scale, select
Fit To Paper.

   

 

  The selected table controls the appearance of the plotted geometry. Based on settings in the table,
the output of geometry could be different than what is displayed in the software. For example, the
geometry could be plotted in a different color, it could be plotted wider than it shows, or it could have a
different line type.

   

 

  Specifies how shaded and rendered viewports are plotted including their resolution level and the dpi
(dots per inch).
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Use this area to specify options for line weights, plot styles, plot stamp, and the order in which objects
are plotted.

   

 

  Use to specify how the geometry is oriented on the sheet.

   

 
Warning!
 

 The Plot Options shown in area 8 are not all available in AutoCAD LT®.

  
 

Plotter Configurations
   

All of the settings you specify in the Plot dialog box can be saved and imported to use with other
drawings or on different workstations. A saved plot configuration is a PC3 file. Earlier versions of
AutoCAD® plotter configurations are PCP or PC2 files. Click Properties (1) in the Plot dialog box to
access the Plot Configuration Editor to access the Save (2) and Import (3) options.
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You can also add or edit a plotter configuration using the Plotter Manager.
 

 
 

Command Access
    

 

  
Plotter Manager
   

 
    Command Line: PLOTTERMANAGER
    Application Menu: Print > Manager Plotters
    Ribbon: Output tab > Plot panel > Plot

   

       
The Plot Style Manager command opens the folder of existing plot styles where you can choose a plot
style to edit or add a new plot style.
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Command Access
    

 

  
Plot Styles Manager
   

 
    Command Line: STYLESMANAGER
    Application Menu: Print > Manager Plot Styles

  
 

Guidelines for the Plot Command
■ Plot and Print are the same command. There is not a separate Print command. To print a drawing,

use the Plot command.
■ Plot settings can be saved in the Page Setup Manager for the Model tab or for each Layout.
■ You can override the settings in the Page Setup Manager from the Plot dialog box.
■ You can save a Plot setup from the Plot dialog box by clicking Add and naming the page setup.

Named plot setups appear in the list for later reuse.
■ To save changes to a plot setup, click Add and enter the original name for the new page setup.

This redefines the previously named setup.
■ You must select a printer or plotter in order to Preview the plot settings.
■ You can use CTRL+P to initiate the Plot dialog box.
■ You can save a plotter configuration and import it into another drawing. A saved plot configuration

is a PC3 file. Earlier versions of AutoCAD plotter configurations are PCP or PC2 files. Click
Properties in the Plot dialog box to access the Save and Import options.

■ Save Plotter configurations and Plot Style Tables for later reuse when plotting your drawings or
when using other computer workstations to plot your drawings.

■ If you do not specify a plot style table, the drawing plots according to the default printer settings.
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Preview Command
   

Previewing gives you an opportunity to review a full-page version of how the final plot will appear
on the printed sheet or in the electronic file. Within the Preview window, you can pan and zoom the
display to assist you in your review. You can click the Plot button to directly plot what is displayed, or
you can close the Preview window. If you initiated the preview from within the Plot dialog box, closing
the Preview window returns you to the Plot dialog box.  
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Command Access
    

 

  
Preview
   

 
    Command Line: PREVIEW
    Application Menu: Print > Plot Preview
    Plot Dialog Box: Preview     Ribbon: Output tab > Plot panel > Preview  

 
  
 

Preview Command Guidelines
■ Preview enables you to view your drawing before plotting it, which is a good idea.
■ Start the preview from the Plot dialog box or by using the Plot Preview button on the Plot panel.
■ You can plot from the Preview window, without returning to the Plot dialog box.
■ Closing the Preview window does not close the drawing.
■ If there is no plotter assigned to the layout, you cannot preview the drawing.
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Exercise: Plot a Drawing
   
In this exercise, you preview what you are going to
plot, then you plot to a DWF file and to the default
Windows system printer.  

  
The completed exercise

Completing the Exercise
To complete the exercise, follow the
steps in this book or in the onscreen
exercise. In the onscreen list of
chapters and exercises, click Chapter
12: Plotting Your Drawings. Click
Exercise: Plot a Drawing.

   
1.

  Open M_Plotting.dwg.
 
2.

  To preview the plot, click Output tab > Plot
panel > Preview. Notice that the green rectangular viewport
shown on the layout is not shown in the
preview. This is because the layer on which the
viewport resides has its layer property set to
No Plot.
   

 
 
3.

  Click Close Preview Window or press ESC to
close the preview window.

 
4.

  On the Plot panel, click Plot.
 
5.

  To create the DWF plot:
■ In the Plot dialog box, click OK.
■ In the Browse for Plot File dialog box, click

Save.
 This accepts the default file name and location,
and plots the layout to the file as a DWF file.

 
6.

  To specify a page setup when plotting:
■ Click Plot.
■ In the Plot dialog box, under Page Setup,

select Check Plot - Monochrome from the
Name list.
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7. To preview the plot, click Preview in the Plot
dialog box. Notice that this plot outputs the geometry in
shades of black on a smaller sheet of paper.
   

 
 
8.

  To create the plot:
■ In the Preview window, click Plot.
■ When prompted, add -B to the file name

to create a DWF file called M_Plotting-
Layout1-B.dwf.

■ Click Save.
 
9.

  Click the Model tab.
 
10.

  Click Plot.
 
11.

  To specify the printer/plotter, select DWF6
ePlot.pc3 from the Name list.

 
12.

  To define the plot area:
■ Select Window from the What To Plot list.
■ Specify a window that encompasses the

kitchen area as shown.
   

 
 
13.

  Click OK.
   

14. Click Save to create a DWF file called
M_Plotting-Model.dwf. Take note of the
location in which the file is being created in.

 
15.

  Close all files without saving. Note: You can now view the plots you created
in the DWF Viewer by navigating to the
location the files were created, and then
double-clicking on them.
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Chapter Summary
 

 

 

Depending on your business environment, you will produce a variety of completed design
specifications. In this chapter you learned how to output your design data from both Model and
Layout views. Saving layout configurations as page setups makes it easier and more efficient to set the
configuration values for a layout and to quickly plot the information in different ways including output
to paper and electronically.  
Having completed this chapter, you can:

■ Create and activate page setups.
■ Plot design geometry from model space or from a layout.
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Chapter

13

Creating Drawing Templates
 
  

Most companies have some kind of standard or guidelines for their drawings to ensure a consistent
look and functionality. You can create drawing templates to store these standards or guidelines in the
form of drawing properties and other settings. When you use the templates to create new drawings,
you ensure consistency with these standards.

 
Objectives

  
After completing this chapter, you will be able to:

■ Create drawing templates.
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Lesson: Creating Drawing Templates
 

  
This lesson describes how to create drawing templates.  
By creating drawing templates, you save time with every new drawing that you create. The settings in
the drawing template are carried over to each new drawing that is created by using the template.   
The following illustration shows the Template Options dialog box with measurement units,
description, and new layer notification.
 

 
Objectives

  
After completing this lesson, you will be able to:

■ Describe drawing templates.
■ Identify various options of drawing templates.
■ Create drawing templates.
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About Drawing Templates
   

Drawing templates are extremely helpful in situations where you need to create your drawings with
predefined drawing standards, such as layers and text styles. Using drawing templates enables you to
save the time that you would have to otherwise spend in setting the required standards every time
you begin a drawing. Many organizations have CAD Managers who create template drawings and make
them available for their team.

 
The software provides various drawing templates for creating new drawings. Most of the predefined
drawing templates are suitable for creating basic drawings. However, you can use these predefined
drawing templates to create your own set of templates specific to your drawing requirements.

 
Definition of Drawing Templates

  
A drawing template is a collection of standard predefined settings, such as units, title blocks, layers,
text styles, and dimension styles, which can be used for creating many drawings. Drawing template
files have a .dwt file extension.

 
Definition of Drawing Templates

  
A drawing template is a collection of standard predefined settings, such as units, title blocks, layers,
text styles, and dimension styles, which can be used for creating many drawings. Drawing template
files have a .dwt file extension.

 
Drawing Templates and CAD Standards

  
When you work in a project where many people are involved in creating a design, there is a possibility
that all team members do not consistently follow the same drawing settings. Therefore, to maintain
consistency across drawings, you can establish CAD standards by sharing and using DWT files.

 
To create a DWT file, you define the required drawing settings and save the file as a drawing template.
You can also save a DWT file as a drawing standard (DWS) file. You can then use a DWS file to check
and map a drawing with a drawing template for any violation of the set standards.

 

 After creating a drawing which is based on a DWT file, if you modify the new drawing,
the changes do not affect the DWT file.
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Example of Drawing Templates

  
The following illustrations show various examples of drawing templates.  

An architectural template title block  

A drawing template with D-size title block settings

 

Drawing Template Options
   

When creating drawing templates, you can save all or some of the template properties and settings,
based on the type of drawings that can be created with a new template. You can modify these
properties later, if required.
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Template Properties and Settings

  
You use drawing templates to provide a starting point for all the new drawings that you create. In most
design environments, your drawings share some common properties and settings. When you save
a drawing template, you can save all the drawing commonalities, eliminating the need to create or
adjust properties and settings each time you create a new drawing.  
The following are some of the properties and settings that you can save in a drawing template:

 
■ Unit settings
■ Layers
■ Snap, grid, and ortho mode settings
■ Limits
■ Dimension styles
■ Text styles
■ Linetypes
■ Table styles
■ Layouts
■ Page setups for all layouts and model space
■ Title blocks and borders
■ Blocks, such as symbols or other objects, that you commonly use in your drawings 

 
Template File Location

   
Before you create your drawing templates, you need to specify their storage location.

 
You specify where template files are stored on the Files tab of the Options dialog box. By default,
this path is set to a subfolder of the current user folder. This path might work if you are working in a
single user environment, but if you are working as part of a design team, you should set the path to a
network location where all project drawing templates can be consolidated.

 
The path that you select controls the default location that appears when you select the Drawing
Template (*.dwt) format in the Files of Type list in the Save Drawing As, Select Template, and Select File
dialog boxes.
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Template Options Dialog Box

  
By using the Template Options dialog box, you can set the drawing units to either imperial or metric,
provide a description for the template, and control new layer notification.

 
To access the Template Options dialog box, you select the AutoCAD Drawing Template (*.dwt) option
from the Files of Type list in the Save As dialog box. 

 

Command Access
    

 

  
Save As

    Command Line: SAVEAS
    Application Menu: Save As > AutoCAD Drawing Template

     
The following illustration shows the Template Options dialog box.
 

    
Option

  
Description

    

 

  Description
  Specifies a description for the DWT file. This description is displayed in the Create
New Drawing dialog box.

   

 

  Measurement
  Determines whether drawings based on this template use English or Metric units.

   

 

  New Layer
Notification

  : All the layers in a DWT file are saved as unreconciled by default. Saves all layers as unreconciled or reconciled. When you save a DWT file with
unreconciled layers, the layer baseline is not created; therefore the new layer
notification is not displayed. When you save a template with reconciled layers,
layer baseline is created; therefore the software notifies you of any new layers in
the drawing. Note
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Creating Drawing Templates
   

Creating drawing templates saves time. It enables you to start a drawing with the required predefined
settings of layers, linetypes, and dimension styles. You can also import settings from other templates
into the current drawing to create a new template.   

 

Procedure: Creating Drawing Templates
   

The following steps describe how to create a drawing template:
  

1.
  Create a new drawing by using an existing template, or by using the no template options.

 
2.

  Modify the drawing to include the required layers, styles, layout settings, and title blocks.
 
3.

  Adjust the Drawing Template File Location path in the Options dialog box, if required.
   

 
 
4.

  Save the drawing.
 
5.

  In the Template Description dialog box, enter a description, specify the measurement unit, and specify
the new layer notification.

 
6.

  Open the newly created template and verify that the resulting drawing contains the settings that you
created.

   
 Store the DWT files that you create at the location that is specified under Template

Settings in the Options dialog box. Storing the DWT files at this location helps you easily
access the templates you create.
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Exercise: Create a Drawing Template
   
In this exercise, you create a drawing template that
contains text styles, dimension styles, drawing units,
layers, layouts, and a title block.
 

Scenario
 

 
You are creating architectural drawings and need
to have the layer settings that correspond to AIA
standards. You decide to specify the required layer
settings in a template that you can use for all the
typical architectural drawings.  

You do the following:
 
■ Set units, styles, layer properties, and page setup.
■ Create a drawing template.
■ Open a drawing based on a new template file.  

  
The completed exercise

Completing the Exercise
To complete the exercise, follow the
steps in this book or in the onscreen
exercise. In the onscreen list of
chapters and exercises, click Chapter
13: Template Drawing Creation. Click
Exercise: Create a Drawing Template.

 
 

Set Units, Styles, Layer Properties, and Page
Setup
  
1.

  Open c_create_drawing_template.dwg.
 
2.

  On the Annotate tab, Text panel, click Text
Style.
   

 
 
3.

  In the Text Style dialog box:
■ Select Arial from the Font Name list.
■ Click Apply to save the changes.

 
4.

  In the Text Style dialog box, click New.
■ In the New Text Style dialog box:
■ For Style Name, enter 3.5 Gen Notes.
■ Click OK.

 
5.

  In the Text Style dialog box:
■ Select Tahoma from the Font Name list.
■ For Height, enter 3.5.
■ Click Apply to save the changes.
■ Click Close.

 
6.

  On the Annotate tab, Text panel, select
Standard in the Text Styles list.

 
7.

  On the Annotate tab, Dimension panel, click
Dimension Style.
   

   
8.

  In the Dimension Style Manager dialog box,
click Modify.
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9. In the Modify Dimension Style dialog box:
■ On the Primary Units tab, select '.' (Period)

from the Decimal Separator list.
■ On the Text tab, under Text Alignment,

click the ISO standard.
■ Click OK.

 
10.

  Click Close to exit the Dimension Style
Manager.

 
11.

  On the Home tab, Layers panel, click Layer
Properties to display the Layer Properties
Manager.
   

 
 
12.

  In the Layer Properties Manager:
■ Create new layers and assign layer

properties, as shown.
■ Set the Objects layer current.
■ Close the Layer Properties Manager.
 Note: Color assignments are not critical. Use
your own color preferences.
   

 
 
13.

  On the status bar, click Layout1 to activate
Layout1.
■ Select the predefined viewport.
■ Right-click anywhere in the drawing. Click

Display Viewport Objects > No.
■ On the application menu, click Print > Page

Setup.

 
14.

  In the Page Setup Manager, click New.
■ In the New Page Setup dialog box:
■ For New page setup name, enter A2-ePlot.
■ Click OK.

 
15.

  In the Page Setup - Layout1 dialog box:
■ Select DWF6 ePlot.pc3 from the Name list

as the printer/plotter device.
■ Select ISO A2 (594.00 x 420.00 MM) from

the Paper size list.
■ Ensure that 1:1 is selected from the Scale

list.
■ Click OK.

 
16.

  In the Page Setup Manager dialog box, double-
click the A2-ePlot page setup to assign it to
Layout1 and click Close.
   

 
 
17.

  Continue to the next exercise or close all files
without saving.

   
 

Create a Drawing Template
  
1.

  On the Home tab, Layers panel, select
TitleBlock in the Layers list.

 
2.

  On the Insert tab, Block panel, click Insert.
■ In the Insert dialog box, click Browse.
■ In the Select Drawing File dialog box,

navigate to A2-Title.dwg.
■ Click Open.
■ Make sure Specify On-screen is not

checked, enter 0,0,0 for the insertion
point, and complete the block insertion
procedure.

■ Click OK
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3.

  To delete the extra layout:
■ On the status bar, click Quick View Layouts.
   

 
■ Right-click the Layout2 preview, and click

Delete.
■ In the AutoCAD dialog box, click OK.

 
4.

  Click the Model tab to activate model space.
 
5.

  On the Home tab, Layers panel, select Objects
in the Layer list.

 
6.

  Right-click anywhere in the drawing. Click
Options.
■ In the Options dialog box, Files tab, expand

Template Settings > Drawing Template File
Location.

■ Double-click the existing path.
■ In the Browse for Folder dialog box,

navigate to the location where the exercise
datasets are installed and click OK.

■ Click OK to close the Options dialog box.
 Note: In a real world situation, these .dwt files
would probably be stored on a network where
all users would have access to them.  

 

 
7.

  On the Application Menu, click Save As >
AutoCAD Drawing Template.
■ In the Save Drawing As dialog box:
■ Verify AutoCAD Drawing Template (*.dwt)

is selected from the Files of Type list.
■ Verify that the Save In folder switches to

the location specified in the Options dialog
box.

■ For File name, enter A2-Template.
■ Click Save.

 
8.

  In the Template Options dialog box, enter the
description as shown and click OK.
   

 
 
9.

  Close all drawings. Do not save.
   
 

Open a Drawing Based on New Template File
  
1.

  To start a new drawing using the new
template:
■ In the Application Menu, click New >

Drawing.
■ In the Select Template dialog box, select

the template and click Open.
   

 
 
2.

  Check the units, layers, text styles, dimension
styles, Layout1 settings, and title block of the
new drawing.
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3.

  Right-click anywhere in the drawing. Click
Options.

 
4.

  Return the configuration settings to their
default settings. In the Options dialog box,
Files tab:
■ Expand Template Settings > Drawing

Template File Location.
■ Double-click the existing path.
■ Navigate to the default location

for the template file C:Users<user
name>AppDataLocalAutodeskAutoCAD
2010R18enuTemplate.

 Note: For AutoCAD LT® users,
navigate to C:Users<user
name>AppDataLocalAutodeskAutoCAD LT
2010R15enuTemplate
■ Click OK in the Browse for Folder dialog

box.
■ Click OK to close the Options dialog box.

 
5.

  Close all files without saving.
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Chapter Summary
 

  
Because drawing templates serve as the basis for all new drawings you create, you should spend
time creating and maintaining the required templates. If you are working in a multi-user design
environment, this process becomes even more critical, as the time saved by using templates can be
multiplied by the number of people creating new drawings.  
Having completed this chapter, you can:

■ Create drawing templates.
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Appendix

A

Additional Resources
 
  

A variety of resources are available to help you get the most from your Autodesk® software. Whether
you prefer instructor-led, self-paced, or online training, Autodesk has you covered.  
For additional information please refer to the disc that accompanies this training guide.

 
■ Learning Tools from Autodesk
■ Autodesk Certification
■ Autodesk Authorized Training Centers (ATC®)
■ Autodesk Subscription
■ Autodesk Communities

 
Learning Tools from Autodesk

  
Use your Autodesk software to its full potential. Whether you are a novice or advanced user, Autodesk
offers a robust portfolio of learning tools to help you perform ahead of the curve.

 
■ Get hands-on experience with job-related exercises based on industry scenarios from Autodesk

Official Training Guides, e-books, self-paced learning, and training videos.
■ All materials are developed by Autodesk subject-matter experts.
■ Get exactly the training you need with learning tools designed to fit a wide range of skill levels and

subject matter—from basic essentials to specialized, in-depth training on the capabilities of the
latest Autodesk products.

■ Access the most comprehensive set of Autodesk learning tools available anywhere: from your
authorized partner, online, or at your local bookstore.

■ To find out more, visit http://www.autodesk.com/learningtools.
 

Autodesk Certification
  

Demonstrate your experience with Autodesk software. Autodesk certifications are a reliable validation
of your skills and knowledge. Demonstrate your software skills to prospective employers, accelerate
your professional development, and enhance your reputation in your field.
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Certification Benefits
■ Rapid diagnostic feedback to assess your strengths, and identify areas for improvement.
■ An electronic certificate with a unique serial number.
■ The right to use an official Autodesk Certification logo.
■ The option to display your certification status in the Autodesk Certified Professionals database.

 
For more information:

  
Visit www.autodesk.com/certification to learn more and to take the next steps to get certified.

 
Autodesk Authorized Training Centers

  
Enhance your productivity and learn how to realize your ideas faster with Autodesk software. Get
trained at an Autodesk Authorized Training Center (ATC) with hands-on, instructor-led classes to help
you get the most from your Autodesk products. Autodesk has a global network of Authorized Training
Centers which are carefully selected and monitored to ensure you receive high-quality, results-
oriented learning. ATCs provide the best way for beginners and experts alike to get up to speed. The
training helps you get the greatest return on your investment, faster; by building your knowledge
in the areas you need the most. Many organizations provide training on our software, but only the
educational institutions and private training providers recognized as ATC sites have met Autodesk's
rigorous standards of excellence.

 
Find an Authorized Training Center

  
With over 2000 ATCs in more than 90 countries around the world, there is probably one close to you.
Visit the ATC locator at www.autodesk.com/atc to find an Autodesk Authorized Training Center near
you. Look for ATC courses offered at www.autodesk.com/atcevents.

 
Many ATCs also offer end-user Certification testing. Locate a testing center near you at
www.autodesk.starttest.com.

 
Autodesk Subscription

  
Autodesk® Subscription is a maintenance and support program that helps you minimize costs,
increase productivity, and make the most of your Autodesk software investment. For an attractive
annual fee, you receive any upgrades released during your Subscription term, as well as early access
to product enhancements. Subscription also gives you flexible license terms, so you can run both
current and previous versions (under certain conditions) and use the software on both home and
office computers. In addition, Subscription gives you access to a variety of tools and information that
save time and increase productivity, including web support direct from Autodesk, self-paced learning,
and online license management.

 
■ Autodesk Subscription offers a way to make software costs predictable. Whether a customer opts

for a one-year subscription or a multiyear contract, the costs are known for the entire term of the
contract.

■ A complete library of interactive learning tools and high-quality, self-paced lessons help users
increase their productivity and master new skills. These short lessons are available on-demand
and complement more in-depth training provided through Autodesk Authorized Training Centers.

■ Autodesk Subscription makes managing software licenses easier. Customers have added flexibility
to allow their employees to use their Subscription software—in the office or at home. Better yet,
designers are entitled to run previous versions of the software concurrently with the latest release
under certain conditions.
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■ Get what you need to stay productive. With web support Autodesk support technicians provide
answers to your installation, configuration, and troubleshooting questions. Web and email
communications deliver support straight to your desktop.

■ For more information visit www.autodesk.com/subscription.
 

Autodesk User Communities
  

Autodesk customers can take advantage of free Autodesk software, self-paced tutorials, worldwide
discussion groups and forums, job postings, and more. Become a member of an Autodesk Community
today!

 

 Free products are subject to the terms and conditions of the end-user license
agreement that accompanies download of the software.

 
Feedback

  
Autodesk understands the importance of offering you the best learning experience possible. If you
have comments, suggestions, or general inquiries about Autodesk Learning, please contact us at
learningtools@autodesk.com.

 
As a result of the feedback we receive from you, we hope to validate and append to our current
research on how to create a better learning experience for our customers. 

 

Useful Links
   Learning Tools

www.autodesk.com/learningtools

    Communities
www.autodesk.com/community

  Certification
www.autodesk.com/certification

    Student Community
www.students.autodesk.com

  Find an Authorized Training Center
www.autodesk.com/atc

    Blogs
www.autodesk.com/blogs

  Find an Authorized Training Center Course
www.autodesk.com/atcevents

    Discussion Groups
www.discussion.autodesk.com

  Autodesk Store
www.store.autodesk.com
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